Tiết 1

BÀI 1: CHƯƠNG TRÌNH BẢNG TÍNH LÀ GÌ?

I - MỤC TIÊU

1. Kiến thức 

- Hiểu được khái niệm bảng tính điện tử và vai trò của bảng tính điện tử trong cuộc sống và học tập.

- Biết cấu trúc của một bảng tính điện tử: dòng, cột, địa chỉ ô...

2.Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.
3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, bảng phụ.

2. Học sinh: Kiến thức cũ, sách, vở.

III. TIẾN TRÌNH BÀI DẠY
A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện:

- GV Chiếu bảng biểu “ Bảng điểm”cho Hs quan sát. Làm thế nào để sắp xếp danh sách theo điểm trung bình từ cao đến thấp của các bạn trong lớp? Chương trình bảng tính sẽ có những công cụ giúp em thực hiện những việc đó dễ dàng. Ta sẽ cùng tìm hiểu về chương trình này.
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: Bảng tính và nhu cầu xử lí thông tin dạng bảng
a) Mục tiêu: 

- Hiểu được khái niệm bảng tính điện tử và vai trò của bảng tính điện tử trong cuộc sống và học tập.

- Biết cấu trúc của một bảng tính điện tử: dòng, cột, địa chỉ ô...

b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: Hiểu về thông tin là gì, và biết được nhiều dạng thông tin khác nhau
d) Tổ chức thực hiện:
	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	- Bước 1: Chuyển giao nhiệm vụ

GV: Trong thực tế em thấy những dữ liệu nào được trình bày dưới dạng bảng?

? Theo em tại sao một số trường hợp thông tin lại được thể hiện dưới dạng bảng?

GV: Đưa ra ví dụ: Hình 1 SGK – Em thấy gì?

GV: Yêu cầu học sinh quan sát hình 2 – 4. Em thấy cách trình bày như thế nào?

GV: Đưa ra kết luận cũng là khái niệm về Chương trình bảng tính.

GV: Trong chương trình lớp 6 chúng ta đã học Word, các em nhớ lại xem màn hình của Word gồn những thành phần gì?

GV: Giới thiệu màn hình làm việc của Excel và các thành phần có trên đó.

GV: Giới thiệu về dữ liệu.

GV: Giới thiệu về khả năng tính toán và sử dụng hàm hàm có sẵn.

GV: Giới thiệu về khả năng sắp xếp và lọc dữ liệu của chương trình.

GV: Ngoài ra chương trình bảng tính còn có khả năng tạo các biểu đồ.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	1. Bảng tính và nhu cầu xử lí thông tin dạng bảng

- Thông tin thể hiện dưới dạng bảng để tiện cho việc theo dõi, sắp xếp, tính toán, so sánh…

- Chương trình bảng tính là phần mềm được thiết kế giúp ghi lại và trình bày thông tin dưới dạng bảng, thực hiện các tính toán cũng như xây dựng các biểu đồ biểu diễn một cách trực quan các số liệu có trong bảng.

 


Hoạt động 2: Chương trình bảng tính
a) Mục tiêu: Tìm hiểu về các thành phần chương trình bảng tính.
b) Nội dung: HS vận dụng sgk, trao đổi, giải quyết vấn đề.
c) Sản phẩm: Phiếu học tập
d) Tổ chức thực hiện:
	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	- Bước 1: Chuyển giao nhiệm vụ

+ GV: Trong chương trình lớp 6 chúng ta đã học Word, các em nhớ lại xem màn hình của Word gồm những thành phần gì? 

+ Hãy nêu cụ thể từng thành phần đó?

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	2. Chương trình bảng tính
a) Màn hình làm việc

- Các bảng chọn.

- Các thanh công cụ.

- Các nút lệnh.

- Cửa sổ làm việc chính.

b) Dữ liệu

- Dữ liệu số và dữ liệu văn bản.

c) Khả năng tính toán và sử dụng hàm có sẵn

- Tính toán tự động.

- Tự động cập nhật kết quả.

- Các hàm có sẵn.

d) Sắp xếp và lọc dữ liệu

- Sắp xếp theo các tiêu chuẩn khác nhau.

- Lọc riêng được các nhóm dữ liệu theo ý muốn.

e) Tạo biểu đồ

- Chương trình bảng tính có các công cụ tạo biểu đồ phong phú.


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 1: Chương trình bảng tính có tính năng đặc biệt là:

A. xử lý những văn bản lớn.

B. chứa nhiều thông tin.

C. chuyên thực hiện các tính toán.

D. chuyên lưu trữ hình ảnh.

Hiển thị đáp án
Chương trình bảng tính là phần mềm giúp ghi lại và trình bày thông tin dưới dạng bảng, có thể thực hiện các tính toán phức tạp hoặc biểu diễn các dữ liệu bằng biểu đồ.

Đáp án: C

Câu 2: Nhu cầu xử lí thông tin dạng bảng là:

A. Dễ so sánh    B. Dễ in ra giấy

C. Dễ học hỏi    D. Dễ di chuyển

Hiển thị đáp án
Thông tin được trình bày dưới dạng bảng dễ dàng cho việc theo dõi, so sánh, sắp xếp, tính toán…

Đáp án: A

Câu 3: Chương trình bảng tính, ngoài chức năng tính toán còn có chức năng:

A. tạo biểu đồ.    B. tạo trò chơi.

C. tạo video    D. tạo nhạc.

Hiển thị đáp án
Chương trình bảng tính là phần mềm giúp ghi lại và trình bày thông tin dưới dạng bảng, có thể thực hiện các tính toán phức tạp hoặc biểu diễn các dữ liệu bằng biểu đồ.

Đáp án: A

Câu 4: Đâu là biểu tượng dùng để khởi động chương trình bảng tính Excel?
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Hiển thị đáp án
Biểu tượng chương trình bảng tính Excel là có chữ X.

Đáp án: B

Câu 5: Để khởi động chương trình bảng tính excel, ta thực hiện:

A. nháy chuột lên biểu tượng Excel.

B. Nháy chuột phải lên biểu tượng Excel.

C. Nháy đúp chuột lên biểu tượng Excel.

D. nháy đúp chuột phải lên biểu tượng Excel.

Hiển thị đáp án
Để khởi động chương trình bảng tính excel cũng giống như phần mềm khác ta thực hiện nháy đúp chuột lên biểu tượng Excel hoặc chuột phải rồi chọn Open.

Đáp án: C
D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  Mở bảng chọn File, quan sát và đoán nhận tác dụng của các lệnh trên bảng chọn File. So sánh với các lệnh trên bảng chọn File của phần mềm soạn thảo văn bản Word.
- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

- Nhắc lại một số đặc trưng của chương trình bảng tính.

- Học lý thuyết, đọc trước phần 3, 4.

Tiết 

BÀI 1: CHƯƠNG TRÌNH BẢNG TÍNH LÀ GÌ? ( T2)
I – MỤC TIÊU

1. Kiến thức 

- Nhận biết được các thành phần cơ bản của màn hình trang tính.

- Hiểu rõ các khái niệm hàng, cột, địa chỉ ô tính.

- Biết cách nhập, sửa, xoá dữ liệu.

- Biết cách di chuyển trên trang tính.

2. Năng lực:
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU
1. Giáo viên: Giáo trình, bảng phụ, máy tính.

2. Học sinh: Kiến thức, sách, vở.

III. TIẾN TRÌNH BÀI DẠY
A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện: 
Tiết trước các em đã tìm hiểu sơ lược về bảng tính, hôm nay các em sẽ tiếp tục tìm hiểu về bảng tính điện tử và các tính năng của chúng.
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: Màn hình làm việc của chương trình bảng tính

a) Mục tiêu: 

- Nhận biết được các thành phần cơ bản của màn hình trang tính.

- Hiểu rõ các khái niệm hàng, cột, địa chỉ ô tính.

b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: Hiểu màn hình làm việc của chương trình bảng tính
d) Tổ chức thực hiện:
	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	- Bước 1: Chuyển giao nhiệm vụ

GV: Sử dụng tranh vẽ giới thiệu màn hình làm việc của chương trình bảng tính.

Chỉ ra các thành phần chình trên màn hình làm việc: thanh công thức, các bảng chọn, trang tính, ô tính…

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	3. Màn hình làm việc của chương trình bảng tính

- Thanh công thức: Nhập, hiển thị dữ liệu hoặc công thức trong ô tính.

- Bảng chọn Data: Các lệnh để xử lí dữ liệu.

- Trang tính: Các cột và hàng làm nhiệm vụ chính của bảng tính.

+ Ô tính: Vùng giao nhau giữa cột và hàng.




Hoạt động 2: Nhập dữ liệu vào trang tính

a) Mục tiêu: 

- Biết cách nhập, sửa, xoá dữ liệu.

- Biết cách di chuyển trên trang tính.

b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS biết cách nhập dữ liệu vào trang tính 
d) Tổ chức thực hiện:
	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	- Bước 1: Chuyển giao nhiệm vụ

GV: Giới thiệu và hướng dẫn học sinh các cách nhập và sửa sữ liệu trên trang tính.

GV: Giới thiệu 2 cách di chuyển trên trang tính.

- Hướng dẫn học sinh thực hành các thao tác trên máy tính.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	4. Nhập dữ liệu vào trang tính

a) Nhập và sửa dữ liệu

- Nhập: Nháy chuột chọn ô và nhập dữ liệu vào từ bàn phím.

- Sửa: Nháy đúp chuột vào ô cần sửa và thực hiện thao tác sửa như với Word.

b) Di chuyển trên trang tính

- Sử dụng các phím mũi tên trên bàn phím.

- Sử dụng chuột và các thanh cuốn.


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:
GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 5: Để khởi động chương trình bảng tính excel, ta thực hiện:

A. nháy chuột lên biểu tượng Excel.

B. Nháy chuột phải lên biểu tượng Excel.

C. Nháy đúp chuột lên biểu tượng Excel.

D. nháy đúp chuột phải lên biểu tượng Excel.

Hiển thị đáp án
Để khởi động chương trình bảng tính excel cũng giống như phần mềm khác ta thực hiện nháy đúp chuột lên biểu tượng Excel hoặc chuột phải rồi chọn Open.

Đáp án: C

Câu 6: Trong màn hình Excel, ngoài bảng chọn File và các dải lệnh giống Word thì màn hình Excel còn có:

A. trang tính, thanh công thức.

B. thanh công thức, các dải lệnh Formulas.

C. các dải lệnh Formulas và bảng chọn Data.

D. trang tính, thanh công thức, các dải lệnh Formulas và bảng chọn Data.

Hiển thị đáp án
Trong màn hình Excel, ngoài bảng chọn File và các dải lệnh giống Word thì màn hình Excel còn có: trang tính, thanh công thức, các dải lệnh Formulas và bảng chọn Data.

Đáp án: D

Câu 7: Trên trang tính, muốn nhập dữ liệu vào ô tính, đầu tiên ta thực hiện thao tác:

A. nháy chuột chọn hàng cần nhập.

B. nháy chuột chọn cột cần nhập.

C. nháy chuột chọn khối ô cần nhập.

D. nháy chuột chọn ô cần nhập.

Hiển thị đáp án
Các bước nhập dữ liệu

- B1: nháy chuột chọn ô cần nhập

- B2: nhập dữ liệu từ bàn phím

- B3: ấn phím Enter để kết thúc

Đáp án: D

Câu 8: Trên trang tính, sau khi gõ dữ liệu từ bàn phím xong, ta nhấn phím:

A. Enter    B. Shift

C. Alt    D. Capslock

Hiển thị đáp án
Trên trang tính, sau khi gõ dữ liệu từ bàn phím xong, ta nhấn phím Enter hoặc sử dụng chuột chọn ô tính khác.

Đáp án: A

Câu 9: Trên trang tính, các ký tự chữ cái A,B,C,….được gọi là:

A. tên hàng.    B. tên ô.

C. tên cột.    D. tên khối

Hiển thị đáp án
Trên trang tính, các ký tự chữ cái A,B,C,….được gọi là tên cột, trang tính được đánh thứ tự liên tiếp trên đầu mỗi cột, từ trái qua phải.

Đáp án: C

Câu 10: Trên trang tính, dãy số thứ tự 1,2,3,…..được gọi là:

A. tên khối.    B. tên ô.

C. tên cột.    D. tên hàng.

Hiển thị đáp án
Trên trang tính, dãy số thứ tự 1,2,3,…..được đánh thứ tự liên tiếp từ trên xuống dưới được gọi là tên hàng.

Đáp án: D
D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:
GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

 1/ Thông tin được trình bày dưới dạng bảng có lợi ích gì?

2/ Nêu các tính năng chung của các chương trình bảng tính.

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
* HƯỚNG DẪN VỀ NHÀ

- Nhắc lại các thành phần trên màn hình làm việc của Excel.

- Học lý thuyết, chuẩn bị trước cho bài thực hành.

Tiết  
Bài thực hành 1:

LÀM QUEN VỚI CHƯƠNG TRÌNH BẢNG TÍNH EXCEL

I - MỤC TIÊU

1. Kiến thức 

- Biết khởi động và thoạt khỏi Excel.

- Nhận biết các ô, hàng, cột trên trang tính Excel.

2.Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy tính.

2. Học sinh: Kiến thức, sách giáo khoa.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện:

? Các thành phần trên màn hình làm việc của Excel.

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: Khởi động, lưu kết quả và thoát khỏi Excel
a) Mục tiêu: HS biết cách khởi động, lưu kết quả và thoát khỏi Excel

b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: Hiểu được và nắm được kiến thức bài học 
d) Tổ chức thực hiện:
	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	- Bước 1: Chuyển giao nhiệm vụ

GV: Yêu cầu học sinh khởi động máy, mở chương trình Excel.

- Hướng dẫn học sinh các cách khởi động Excel.

GV: Để lưu kết quả trên Word ta làm ntn? -> Cách lưu kết quả trên Excel tương tự.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	1. Khởi động, lưu kết quả và thoát khỏi Excel

a) Khởi động

- C1: Start -> Program -> Microsoft Excel.

- C2: Nháy đúp vào biểu tượng của Excel trên màn hình nền.

b) Lưu kết quả

- C1: File -> Save

- C2: Nháy chuột vào biểu tượng Save trên thanh công cụ.

c) Thoát khỏi Excel

- C1: Nháy chuột vào nút ô vuông (gạch chéo ở giữa).

- C2: File -> Exit

 


Hoạt động 2: Bài tập
a) Mục tiêu: HS hoàn thành bài tập được giao 
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: Hiểu được và nắm được kiến thức bài học 
d) Tổ chức thực hiện:

	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	- Bước 1: Chuyển giao nhiệm vụ

GV: Ra bài tập yêu cầu học sinh làm trên máy.

* Chú ý: Trong quá trình học sinh làm bài, giáo viên đi vòng quanh, quan sát và hướng dẫn nếu học sinh gặp vướng mắc.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	2. Bài tập 

a) Bài tập 1:  Khởi động Excel

-  Liệt kê các điểm giống và khác nhau giữa màn hình Word và Excel.

-  Mở các bảng chọn và quan sát các lệnh trong các bảng chọn đó.

-  Kích hoạt một ô tính và thực hiện di chuyển trên trang tính bằng chuột và bàn phím. Quan sát sự thay đổi các nút tên hàng và tên cột.

b) Bài tập 2

SGK trang 11

c) Bài tập 3

SGK trang 11


- Nhận xét giờ thực hành theo từng nhóm, cho điểm một số nhóm.

* HƯỚNG DẪN VỀ NHÀ
- Đọc trước chuẩn bị cho bài 2.

Tiết 
BÀI 2: CÁC THÀNH PHẦN CHÍNH

VÀ DỮ LIỆU TRÊN TRANG TÍNH

I - MỤC TIÊU

1. Kiến thức 

- Biết các thành phần chính của trang tính.

- Hiểu được vai trò của thanh công thức.

-  Biết được các đối tượng trên trang tính.

- Hiểu được dữ liệu số và dữ liệu kí tự.

2.Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy tính.

2. Học sinh: Kiến thức, sách giáo khoa.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện:

Trình chiếu bảng ví dụ?Thông tin trên trang tính được trình bày như thế nào? Môn nào là môn em có điểm tổng kết cao nhất, thấp nhất? Điểm cao nhất của môn Toán là mấy điểm?Mỗi hàng, cột cho em thông tin có cùng loại hay không?

Mỗi ô trên trang tính đều cho ta thông tin hoàn toàn xác định tùy theo ô đó nằm ở hàng nào, cột nào. Để hiểu rõ hơn về bảng tính, ta cùng tìm hiều qua bài 2: Các thành phần chính và dữ liệu trên trang tính.
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

TIẾT 1

Hoạt động 1: Bảng tính
a) Mục tiêu: HS hiểu Bảng tính
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: Hiểu về bảng tính, các trang tính trong bảng tính và khi nào thì một trang tính là đang được kích hoạt.
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Giới thiệu về bảng tính, các trang tính trong bảng tính và khi nào thì một trang tính là đang được kích hoạt.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	1. Bảng tính

-  Một bảng tính gồm nhiều trang tính.

-  Trang tính được kích hoạt có nhãn màu trắng, tên viết bằng chữ đậm.

-  Để kích hoạt một trang tính ta nháy chuột vào tên trang tương ứng.




Hoạt động 2: Các thành phần chính trên trang tính
a) Mục tiêu: HS biết các thành phần chính trên trang tính
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm rõ kiến thức bài học

d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Giới thiệu các thành phần chính trên một trang tính: Ô, khối, cột, hàng, thanh công thức…

-  Giải thích chức năng của từng thành phần.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	2. Các thành phần chính trên trang tính

-  Một trang tính gồm có các hàng, các cột, các ô tính ngoài ra còn có Hộp tên, Khối ô, Thanh công thức…

+ Hộp tên: Ô ở góc trên, bên trái trang tính, hiển thị địa chỉ ô được chọn.

+ Khối: Các ô liền kề nhau tạo thành hình chữ nhật.

+ Thanh công thức: Cho biết nội dung ô đang được chọn.




TIẾT 2

Hoạt động 1: Chọn các đối tượng trên trang tính
a) Mục tiêu: HS biết các thao tác để chọn các đối tượng trên một trang tính.
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm rõ kiến thức bài học 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Giới thiệu và hướng dẫn học sinh các thao tác để chọn các đối tượng trên một trang tính.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	3. Chọn các đối tượng trên trang tính

- Chọn một ô: Đưa chuột tới ô đó và nháy chuột.

- Chọn một hàng: Nháy chuột tại nút tên hàng.

- Chọn một cột: Nháy chuột tại nút tên cột.

- Chọn một khối: Kéo thả chuột từ một ô góc đến ô góc đối diện.




Hoạt động 2: Dữ liệu trên trang tính
a) Mục tiêu: HS tìm hiểu dữ liệu trên trang tính
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm rõ kiến thức bài học

d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Trình bày về các dữ liệu mà chương trình bảng tính có thể xử lí được.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	4. Dữ liệu trên trang tính

a) Dữ liệu số

- Các số : 0, 1, 2, 3..., 9, +1, -6...

- Ngầm định : Dữ liệu số được căn thẳng lề phải trong ô tính.

b) Dữ liệu kí tự

-  Các chữ cái.

-  Các chữ số.

-  Các kí hiệu.

- Ngầm định: Dữ liệu số được căn thẳng lề phải trong ô tính.


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 1: Trong chương trình bảng tính, khi mở một bảng tính mới thường có:

A. hai trang tính trống.

B. một trang tính trống.

C. ba trang tính trống.

D. bốn trang tính trống.

Hiển thị đáp án
Một bảng tính là 1 tập tin bao gồm nhiều trang tính, một bảng tính mới sẽ bao gồm ba trang tính trống (sheet1, sheet2, sheet3).

Đáp án: C

Câu 2: Các thành phần chính trên trang tính gồm có:

A. Hộp tên, Khối, các ô tính.

B. Hộp tên, Khối, các hàng.

C. Hộp tên, thanh công thức, các cột.

D. Hộp tên, Khối, Thanh công thức.

Hiển thị đáp án
Các thành phần chính trên trang tính gồm có:

- Hộp tên: ô bên trái thanh công thức, hiển thị địa chỉ ô đang được trỏ tới

- Khối: là một nhóm các ô liền kề nhau tạo thành hình chữ nhật. Khối có thể là 1 ô, 1 hàng, 1 cột và mỗi khối có địa chỉ của riêng mình.

Ký hiệu: ″ô trên cùng bên trái : ô dưới cùng bên phải″

Ví dụ: C2:D3, A1:B3, ..

- Thanh công thức: cho biết nội dung của dữ liệu đang được chọn, ngoài ra còn có thể nhập, sửa nội dung của dữ liệu đó.

Đáp án: D

Câu 3: Trên trang tính, hộp tên hiển thị D6 cho ta biết:

A. địa chỉ của ô tại cột 6 hàng D.

B. địa chỉ của ô tại cột D hàng 6.

C. địa chỉ của ô tại hàng D đến hàng 6.

D. địa chỉ của ô từ cột D đến cột 6.

Hiển thị đáp án
Hộp tên: ô bên trái thanh công thức, hiển thị địa chỉ ô đang được trỏ tới. Vì vậy hộp tên hiển thị D6 cho ta biết địa chỉ của ô tại cột D hàng 6.

Đáp án: B

Câu 4: Trên trang tính, một nhóm các ô liền kề nhau tạo thành hình chữ nhật gọi là:

A. ô liên kết.

B. các ô cùng hàng.

C. khối ô.

D. các ô cùng cột.

Hiển thị đáp án
Khối ô là một nhóm các ô liền kề nhau tạo thành hình chữ nhật. Khối có thể là 1 ô, 1 hàng, 1 cột và mỗi khối có địa chỉ của riêng mình. Ví dụ: A1:B3, ..

Đáp án: C

Câu 5: Trong chương trình bảng tính, người ta viết C3:D5 có nghĩa là:

A. các ô từ ô C1 đến ô C3.

B. các ô từ ô D1 đến ô D5.

C. các ô từ hàng C3 đến hàng D5.

D. các ô từ ô C3 đến ô D5.

Hiển thị đáp án
Khối: là một nhóm các ô liền kề nhau tạo thành hình chữ nhật. Khối có thể là 1 ô, 1 hàng, 1 cột và mỗi khối có địa chỉ của riêng mình. Ký hiệu: ″ô trên cùng bên trái : ô dưới cùng bên phải″. Trong chương trình bảng tính, người ta viết C3:D5 có nghĩa là ô trên cùng bên trái là C3, ô dưới cùng bên phải là D5.

Đáp án: D
D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  Đổi tên trang tính: Thực hiện các bước chỉ dẫn trên hình 1.15 để đổi tên trang tính
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Hình 1.15.Đổi tên trang tính
Nháy đúp vào tên trang tính

Gõ tên mới và nhấn phím Enter

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

- Trả lời câu hỏi trong SGK.

-  Chuẩn bị cho bài thực hành số 2.

Tiết 

Bài thực hành số 2

LÀM QUEN VỚI CÁC KIỂU DỮ LIỆU TRÊN T RANG TÍNH

I - MỤC TIÊU

1. Kiến thức 

- Phân biệt được bảng tính, trang tính và các thành phần trên trang tính.

- Chọn các đối tượng trênt rang tính.

-  Mở và lưu bảng tính trên máy tính.

2.Năng lực 

- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy tính.

2. Học sinh: Kiến thức, sách giáo khoa.

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện:

? Thế nào được gọi là một trang tính được kích hoạt.

? Các thành phần chính của một trang tính.

TL: - Trang tính được kích hoạt có nhãn màu trắng, tên viết = chữ đậm.

-  Một trang tính gồm: Các hàng, cột, các ô tính, ngoài ra còn có hộp tên, khối ô, thanh công thức…

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: Mở và lưu bảng tính với một tên khác
a) Mục tiêu: HS hiểu được và nắm Mở và lưu bảng tính với một tên khác
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm được kiến thức bài học 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Yêu cầu học sinh nhắc lại các thao tác để mở một bảng tính.

GV: Em có thể mở một bảng tính mới hoặc bảng tính đã lưu trên máy.

-  Hướng dẫn học sinh thao tác trên máy tính.

GV: Giới thiệu cách lưu lại trang tính với một tên khác mà vẫn còn trang tíhn ban đầu.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	1. Mở và lưu bảng tính với một tên khác

a) Mở một bảng tính

-  Mở bảng tính mới:

Nháy nút lệnh New trên thanh công cụ trong chương trình bảng tính.

-  Mở bảng tính đã lưu:

Mở thư mục chứa tệp và nháy đúp chuột trên biểu tượng của tệp.

b) Lưu bảng tính với một tên khác

Ta có thể lưu một bảng tính đã được lưu trước đó với một tên khác mà không mất đi bảng tính ban đầu:

-  File - > Save as




Hoạt động 2: Bài tập 
a) Mục tiêu: HS hoàn thành bài tập được giao
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm rõ kiến thức bài học

d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Củng cố lại một số thao tác và giao bài tập cho học sinh.

BT1. Tìm hiểu các thành phần chính của trang tính.

GV: Hướng dẫn học sinh cách thực hành với các bài tập còn lại trong SGK.
- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	2. Bài tập

a) Bài tập 1

-  Khởi động Excel, nhận biết các thànhphần chính.

-  Kích hoạt các ô khác nhau, quan sát sự thay đổi nội dung trong ô.

-  Nhập dữ liệu vào ô, quan sát sự thay đổi nội dung trên thanh công thức.

-  Gõ = 5 + 7 và 1 ô và nhấn Enter. Chọn lại ô đó và so sánh nọi dung dữ liệu trong ô đó và trên thanh công thức.

b) Bài tập 2

Chọn các đối tượng trên trang tính.

SGK trang 20.

c) Bài tập 3

Mở bảng tính

SGK trang 21

d) Bài tập 4

Nhập dữ liệu vào trang tính

SGK trang 21.


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung:  Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

GV: Củng cố lại một số thao tác và giao bài tập cho học sinh.

BT1. Tìm hiểu các thành phần chính của trang tính.

GV: Hướng dẫn học sinh cách thực hành với các bài tập còn lại trong SGK.

D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: GV yêu cầu học sinh 

- Nhắc lại các thao tác đã học.
*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

- Thực hành lại các thao tác nếu có điều kiện.

Tiết  
BÀI 3: THỰC HIỆN TÍNH TOÁN TRÊN TRANG TÍNH 
I - MỤC TIÊU

1. Kiến thức 

- Cung cấp cho HS cách đặt các phép tính đơn giản trên bảng tính.

-  HS hiểu khái niệm ô, khối ô, địa chỉ ô.

2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện:

Chiếu slide. Để tính trung bình tiền điện, tiền nước hằng tháng em phải làm gì?
Học sinh: Thực hiện tình toán.

Chúng ta sẽ tìm hiểu về cách thực hiện tính toán trên trang tính. Giới thiệu nội dung chung của bài.
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1:Sử dụng công thức để tính toán.
a) Mục tiêu: Cung cấp cho HS cách đặt các phép tính đơn giản trên bảng tính.
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Chương trình bảng tính có khả năng rất ưu việt đó là tính toán.

- Trong bảng tính ta có thể dùng các công thức để thực hiện các phép tính.

GV: Lấy VD: 3 + 5

GV: Giới thiệu các phép toán. Mỗi phép toán GV lấy 1 VD vàlưu ý cho HS các ký hiệu phép toán.

+ Vị trí của các phép toán trên bàn phím.

? Trong toán học, ta có thứ tự thực hiện các phép tính như thế nào?

GV: Lấy VD: {(12 + 5)-8}*2

GV: Yêu cầu HS quan sát H22 trong SGK.

GV vẽ hình minh hoạ lên bảng. 

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	1. Sử dụng công thức để tính toán.

- Trong bảng tính có thể sử dụng các phép tính +, - , *, /, ^, % để tính toán.

- Trong bảng tính cũng cần phải thực hiện thứ tự phép tính:

+ Với biểu thức có dấu ngoặc: Ngoặc ( ) ( { }( ngoặc nhọn.

+ Các phép toán luỹ thừa -> phép nhân, phép chia ( phép cộng, phép trừ.




Hoạt động 2: Nhập công thức
a) Mục tiêu: HS biết Nhập công thức
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm rõ kiến thức bài học

d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Lấy VD: {(12 + 5)-8}*2

GV: Yêu cầu HS quan sát H22 trong SGK.

GV vẽ hình minh hoạ lên bảng. 

- Yêu cầu HS thực hành:

+ Mở máy

+ Chạy chương trình EXCEL

+ Mở 1 File mới

+ Gõ Công thức sau:

(40 – 12)/7+ ( 58+24)*6

GV: Kiểm tra các bước thực hiện trên máy của HS

GV: Đưa ra chú ý cho HS:

Nếu chọn 1 ô không có công thức và quan sát Thanh công thức, em sẽ thấy nội dung trên thanh công thức giống với dữ liệu trong ô. Tuy nhiên, nếu trong ô đó có công thức, các nội dung này sẽ khác nhau. VD các em quan sát H23 SGK
- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	2. Nhập công thức

- Để nhập công thức vào 1 ô cần làm như sau:

+ Chọn ô cần nhập công thức

+ Gõ dấu =

+ Nhập công thức

+ Nhấn Enter chấp nhận




C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 1: Trong Excel, Các kí hiệu dùng để kí hiệu các phép toán

A. + - . :

B. + - * /

C. ^ / : x

D. + - ^ \

Hiển thị đáp án
Các phép toán +, - , x, :, trong toán học được kí hiệu trong Excel là +, -, *, /.

Đáp án: B

Câu 2: Thông thường trong Excel, dấu phẩy (,) được dùng để phân cách hàng nghìn, hàng triệu…, dấu chấm (.) để phân cách phần nguyên và phần thập phân.

A. Đúng

B. Sai

Hiển thị đáp án
Thông thường trong Excel, dấu phẩy (,) được dùng để phân cách hàng nghìn, hàng triệu…, dấu chấm (.) để phân cách phần nguyên và phần thập phân.

Đáp án: A

Câu 3: Khi gõ công thức vào một ô, kí tự đầu tiên phải là:

A. Ô đầu tiên tham chiếu tới

B. Dấu ngoặc đơn

C. Dấu nháy

D. Dấu bằng

Hiển thị đáp án
Khi gõ công thức vào một ô, kí tự đầu tiên phải là dấu bằng (=).

Đáp án: D

Câu 4: Giả sử cần tính tổng giá trị của các ô B2 và E4, sau đó nhân với giá trị trong ô C2. Công thức nào trong số các công thức sau đây là đúng:

A. =(E4+B2)*C2

B. (E4+B2)*C2

C. =C2(E4+B2)

D. (E4+B2)C2

Hiển thị đáp án
Để nhập công thức trước tiên nhập dấu bằng và sau đó nhập công thức. và các phép toán +, - , x, :, trong toán học được kí hiệu trong Excel là +, -, *, /.

Đáp án: A

Câu 5: Ở một ô tính có công thức sau: =((E5+F7)/C2)*A1 với E5 = 2, F7 = 8 , C2 = 2, A1 = 20 thì kết quả trong ô tính đó sẽ là:

A. 10

B. 100

C. 200

D. 120

D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

? Để nhập một công thức vào 1 ô ta phải chú ý đến điều gì đầu tiên?


(Đánh dấu = trước công thức)

? Hãy nhập một công thức gồm các biểu thức có chứa phép toán cộng, trừ, nhân chia vào 1 ô. sau đó nhấn Enter để hoàn tất. Sau đó quan sát trên thanh công thức và so với dữ liệu trong ô vùa nhập.

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.

*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

- Đọc thông tin hướng dẫn  SGK

- Chú ý các bước GV đã hướng dẫn.

- Luyện tập ở nhà nếu có điều kiện

Tiết  
BÀI 3: THỰC HIỆN TÍNH TOÁN TRÊN TRANG TÍNH ( TT)
I - MỤC TIÊU

1. Kiến thức
- HS hiểu được thế nào là địa chỉ công thức, địa chỉ ô.

2. Năng lực 

- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Chuẩn bị bài ở nhà.

II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện: Chiếu Slide. Các em đã làm quen việc dùng công thức để thực hiện những phép tính đơn giản nhưng làm thế nào ta có thể tính nhanh, chính xác và đạt hiệu quả cao, các em sẽ tìm hiểu trong bài học hôm nay.

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: Học sinh tìm hiểu địa chỉ công thức, địa chỉ ô.

a) Mục tiêu: HS biết cách sử dụng địa chỉ công thức 
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Trên thanh công thức hiển thị A1, em hiểu công thức đó có nghĩa gì?

GV: Yêu cầu thực hành:

Nhập các dữ liệu: A2=20; B3=18; Tính trung bình cộng tại ô C3 = (20+18)

? Nếu thay đổi dữ liệu ô A2, thì kết quả tại ô C3 như thế nào?

( Như vậy, nếu dữ liệu trong ô A2 thay đổi thì ta phải nhập lại công thức tính ở ô C3.

- Có 1 cách thay cho công thức = ( 20+18)/2 em chỉ cần nhập công thức = ( A2+B3)/2 vào ô C3, nội dung của ô C3 sẽ được 

cập nhật mỗi khi nội dung các ô A2 và B3 thay đổi.

- Yêu cầu HS thực hành theo nội dung trên.

- Bước 2: Thực hiện nhiệm vụ

HS: Trả lời - Đó là Cột A, hàng 1.

HS: Thực hành theo cặp trên máy tính.

HS: Trả lời - Kết quả không thay đổi.

- Nghe và ghi chép.

HS:Thực hành tại chỗ trên máy tính của mình.

+ HS tiếp nhận nhiệm vụ, suy nghĩ và 

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	3. Sử dụng địa chỉ công thức

Ví dụ:

     A2 = 20

     B3 = 18

Trung bình cộng tại C3:

Công thức: = ( A2+ C3)/2

* Chú ý

- Nếu giá trị ở các ô A2 hoặc B3 thay đổi thì kết quả ở ô C3 cũng thay đổi theo.


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 6: Sắp xếp theo đúng thứ tự các bước nhập công thức vào ô tính:

1. Nhấn Enter

2. Nhập công thức

3. Gõ dấu =

4. Chọn ô tính

A. 4; 3; 2; 1

B. 1; 3; 2; 4

C. 2; 4; 1; 3

D. 3; 4; 2; 1

Hiển thị đáp án
Các bước nhập công thức vào ô tính:

+ B1: chọn ô tính cần thao tác

+ B2: gõ dấu =

+ B3: nhập công thức

+ B4: ấn phím Enter để kết thúc

Đáp án: A

Câu 7: Trong các công thức sau, công thức nào thực hiện được khi nhập vào bảng tính?

A. = (12+8)/2^2 + 5 * 6

B. = (12+8):22 + 5 x 6

C. = (12+8):2^2 + 5 * 6

D. (12+8)/22 + 5 * 6

Hiển thị đáp án
Để nhập công thức trước tiên nhập dấu bằng và sau đó nhập công thức. và các phép toán +, - , x, :, số mũ, % trong toán học được kí hiệu trong Excel là +, -, *, /, ^, %.

Đáp án: A

Câu 8: Cho phép tính sau: (25+7) : (56−25)× ( 8 : 3) :2+64 ×3%

Phép tính nào thực hiện được trong chương trình bảng tính?

A. =(25+7)/(56-25)x(8/3)/2+6^4x3%

B. =(25+7)/(56-2^5)x(8/3):2+6^4x3%

C. =(25+7)/(56-2^5)*(8/3)/2+6^4* 3%

D. =(25+7)/(56-2/5)x(8/3)/2+6^4x3%

Hiển thị đáp án
Các phép toán +, - , x, :, số mũ, % trong toán học được kí hiệu trong Excel là +, -, *, /, ^, %.

Đáp án: C

Câu 9: Trong các công thức nhập vào ô tính để tính biểu thức (9+7)/2 thì công thức nào toán học sau đây là đúng?

A. (7 + 9)/2

B. = (7 + 9):2

C. = (7 +9 )/2

D. = 9+7/2

Hiển thị đáp án
Các phép toán +, - , x, :, số mũ, % trong toán học được kí hiệu trong Excel là +, -, *, /, ^, %.

Đáp án: B

Câu 10: Để kết thúc việc nhập công thức ta sử dụng thao tác:

A. Nhấn Enter

B. Nháy chuột vào nút

C. Cả A và B đều đúng

D. Cả A và B đều sai

Hiển thị đáp án
Để kết thúc việc nhập công thức ta sử dụng thao tác nhấn Enter trên bàn phím.

Đáp án: A
D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  Giả sử cần tính tổng giá trị trong các ô C2 và D4 sau đó nhân với giá trị trong ô B2. Công thức nào sau đây là đúng?
(A) (D4+C2)*B2    (B) D4+C2*B2    (C) = (D4+C2)*b2

   (D) = (B2*(D4+C2)    (E) = (D4+C2)B2    (F) = (D4+C2)*B2

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

4. Hướng dẫn về nhà:

- Sử dụng địa chỉ ô trong công thức.

- Luyện tập ở nhà nếu có điều kiện

Tiết 
Bài thực hành 3

BẢNG ĐIỂM CỦA EM

I - MỤC TIÊU

1. Kiến thức

- Học sinh sử dụng công thức trên trang tính.

2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Phòng máy, giáo trình.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện: Yêu cầu 2 – 3 HS mở máy ( Mở bảng tính Excel và nhập một vài công thức.

GV: Quan sát, nhận xét và cho điểm.

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: HS làm bài tập thực hành 
a) Mục tiêu: HS làm bài tập thực thành thuần thục 
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS thực hành trên máy 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN


S

	T

	Môn học

	KT 15’

	KT 1 tiết lần 1

	KT 1 tiết lần 2

	KT HK

	DTK

	
	3

	1

	Toán

	8

	7

	9

	10

	
	4

	2

	V.Lý

	8

	8

	9

	9

	
	5

	3

	L.Sử

	8

	8

	9

	7

	
	6

	4

	Sinh

	9

	10

	9

	10

	
	7

	5

	C.N

	8

	6

	8

	8

	
	8

	6

	Tin

	8

	9

	9

	9

	
	9

	7

	Văn

	7

	6

	8

	8

	
	10

	8

	GDCD

	8

	9

	9

	9

	

	
	


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

- Cách nhập công thức?

- Cách tính điểm TB môn học.

D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: GV giao bài tập cho học sinh 

*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

- Xem lại cách nhập các bảng tính.

- Thực hành (nếu có điều kiện)

- Xem trước bài mới.

Tiết 
BÀI 4: SỬ DỤNG CÁC HÀM ĐỂ TÍNH TOÁN
I - MỤC TIÊU

1. Kiến thức

- HS hiểu được hàm là công thức được định nghĩa từ trước, đồng thời hiểu được tác dụng của hàm trong quá trình tính toán.

2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Phòng máy, giáo trình.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện: Giới thiệu nội dung cần tìm hiểu, chiếu bảng tính phân tích nhu cầucần sử dụng hàm (ví dụ hàm Max). Giới thiệu nội dung tổng quan toàn bài.
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: HS tìm hiểu hàm trong chương trình bảng tính
a) Mục tiêu: HS hiểu được và nắm được hàm là công thức được định nghĩa từ trước, đồng thời hiểu được tác dụng của hàm trong quá trình tính toán.

b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Giới thiệu về chức năng của Hàm cho HS hiểu.

GV: Sử dụng tranh vẽ sẵn làm mẫu cho HS quan sát.

GV: Lấy VD thực tế.

GV: Lấy VD nhập số trực tiếp từ bàn phím.

GV: Lấy VD nhập theo địa chỉ ô.

- Yêu cầu HS làm thử trên máy của mình.

GV: Chú ý cho HS cách nhập hàm như nhập công thức trên bảng tính.

(Dấu – là ký tự bắt buộc)

GV: Thao tác trên máy chiếu cho HS quan sát.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	1. Hàm trong chương trình bảng tính

- Hàm là công thức được định nghĩa từ trước.

- Hàm được sử dụng để thực hiện tính toán theo công thức.

 Ví dụ1: Tính trung bình cộng của: 3 ,4, 5.

C1: Tính theo công thức thông thường:  =(3+4+5)/3

C2: Dùng hàm  để tính:  =AVERAGE(3,4,5)

VD2: Tính trung bình cộng của 3 số trong các ô A1, A5, A6:

=AVERAGE(A1,A5,A6)





Hoạt động 2: Cách sử dụng hàm
a) Mục tiêu: HS biết cách sử dụng hàm
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm rõ kiến thức bài học

d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Chú ý cho HS cách nhập hàm như nhập công thức trên bảng tính.

(Dấu – là ký tự bắt buộc)

GV: Thao tác trên máy chiếu cho HS quan sát.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	2. Cách sử dụng hàm

- Chọn ô cần nhập

- Gõ dấu =

- Gõ hàm theo đúng cú pháp 

- Gõ Enter.
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C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 1: Nếu trong 1 ô tính có các ký hiệu ########, điều đó có nghĩa là?

A. Công thức nhập sai và bảng tính thông báo lỗi

B. Dòng chứa ô đó có độ cao thấp nên không hiển thị hết chữ số

C. Ô tính đó có độ rộng hẹp nên không hiển thị hết chữ số

D. Nhập sai dữ liệu.

Hiển thị đáp án
Nếu trong 1 ô tính có các ký hiệu ########, điều đó có nghĩa là Ô tính đó có độ rộng hẹp nên không hiển thị hết chữ số

Đáp án: C

Câu 2: Hàm AVERAGE là hàm dùng để:

A. Tính tổng

B. Tìm số nhỏ nhất

C. Tìm số trung bình cộng

D. Tìm số lớn nhất

Hiển thị đáp án
Hàm AVERAGE là hàm dùng để tìm số trung bình cộng của các số trong dãy.

Đáp án: C

Đáp án: C
D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 
? Trong cách sử dụng hàm có gì giống với nhập công thức trên trang tính?

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.

*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

- Xem trước bài mới.


Tiết 
BÀI 4: SỬ DỤNG CÁC HÀM ĐỂ TÍNH TOÁN ( TT)
I - MỤC TIÊU
1. Kiến thức

- HS hiểu được hàm là công thức được định nghĩa từ trước, đồng thời hiểu được tác dụng của hàm trong quá trình tính toán.

2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Phòng máy, giáo trình.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện:
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Làm thế nào để có các giá trị như bảng tính?Tiết học hôm nay chúng ta tiếp tục tìm hiểu công dụng và cú pháp của một số hàm trong Excel: Sum, Average, Max, Min.
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: HS tìm hiểu một số hàm trong chương trình bảng tính
a) Mục tiêu: HS hiểu được và nắm được hàm là công thức được định nghĩa từ trước, đồng thời hiểu được tác dụng của hàm trong quá trình tính toán.
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Giới thiệu một số hàm có trong bảng tính.

GV: Vừa nói vừa thao tác trên màn chiếu cho HS quan sát.

GV: Lưu ý cho HS: Có thể tính tổng của các số hoặc tính theo địa chỉ ô hoặc có thể kết hợp cả số và địa chỉ ô.

- Đặc biệt: Có thể sử dụng các khối ô trong công thức.

(Các khối ô  viết ngăn cách nhau bởi dấu “:”).

? Tự lấy VD tính tổng theo cách của 3 VD trên.

GV: Quan sát HS thực hành và giải đáp thắc mắc nếu có.

GV: Giới thiệu tên hàm và cách thức nhập hàm

- Giới thiệu về các biến a,b,c trong các trường hợp.

- Yêu cầu HS tự lấy VD để thực hành.

- Lấy VD minh hoạ và thực hành trên màn chiếu cho HS quan sát.

- Yêu cầu HS tự lấy VD để thực hành.

GV Giới thiệu tên hàm và cách thức nhập hàm tính trung bình cộng, hàm xác định giá trị lớn nhất, hàm xác định giá trị nhỏ nhất

- Giới thiệu về các biến a,b,c trong các trường hợp.

- Lấy VD minh hoạ và thực hành trên màn chiếu cho HS quan sát.

- Yêu cầu HS tự lấy VD để thực hành.
- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	3. Một số hàm trong chương trình bảng tính

a. Hàm tính tổng

- Tên hàm:   SUM 

- Cách nhập:

=SUM(a,b,c,...)

Trong đó a,b,c,.. là các biến có thể là các số, có thể là địa chỉ ô tính. (số lượng các biến không hạn chế).

VD1: =SUM(5,7,8) cho kết quả là: 20.

VD2: Giả sử ô A2 chứa số 5, ô B8 chứa số 27, khi đó:

=SUM(A2,B8) được KQ: 32

=SUM(A2,B8,5) được KQ: 37

VD3: Có thể sử dụng các khối ô trong công thức tính.

=SUM(B1,B3,C6:C12)=  B1+B3+C6+C7+...+C12

b. Hàm tính trung bình cộng

- Tên hàm: AVERAGE

- Cách nhập:

=AVERAGE(a,b,c,...)

Trong đó a,b,c,.. là các biến có thể là các số, có thể là địa chỉ ô tính. ( số lượng các biến không hạn chế ).

VD1: =AVERGE(15,23,45) cho kết quả là: ( 15 + 23+ 45)/3.

VD2: Có thể tính trung bình cộng theo địa chỉ ô. =AVERAGE(B1,B4,C3)

VD3: Có thể kết hợp

=AVERAGE(B2,5,C3)

VD4: Có thể tính theo khối ô:

=AVERAGE(A1:A5,B6)= (A1+A2+A3+A4+A5+B6)/6

c. Hàm xác định giá trị lớn nhất

- Mục đích: Tìm giá trị lớn nhất trong một dãy số.

- Tên hàm: MAX

- Cách nhập:

=MAX(a,b,c,...)

d. Hàm xác định giá trị nhỏ nhất:

- Mục đích: Tìm giá trị nhỏ nhất trong một dãy số.

- Tên hàm: MIN

- Cách nhập: 

=MIN(a,b,c,…)


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 5: Kết quả của hàm sau : =MAX(A1,A5), trong đó: A1=5, A2=8; A3=9; A4=10; A5=2

A. 2

B. 10

C. 5

D. 34

Hiển thị đáp án
Hàm Max là hàm tìm giá trị lớn nhất. Kết quả của hàm: =MAX(A1,A5)= MAX ( 5, 2) =5

Đáp án: C

Câu 6: Nếu khối A1:A5 lần lượt chứa các số 10, 7, 9, 27, 2 kết quả phép tính nào sau đây đúng:

A. =MAX(A1,B5,15) cho kết quả là 15

B. =MAX(A1:B5, 15) cho kết quả là 27

C. =MAX(A1:B5) cho kết quả là 27

D. Tất cả đều đúng.

Hiển thị đáp án
Hàm Max là hàm tìm giá trị lớn nhất trong dãy các số. Ô tính B5 không có giá trị thì sẽ được bỏ qua vì vậy hàm MAX(A1,B5,15) chính là tìm giá trị lớn nhất của 10 và 15 là 15. Hàm MAX(A1:B5, 15) là tìm giá trị lớn nhất của 10, 7, 9, 27, 2, 15 -> 27 (B1, B2, B3, B4, B5 bỏ qua). MAX(A1:B5) cho kết quả là 27.

Đáp án: D

Câu 7: Kết quả của hàm =Average(3,8,10) là:

A. 21

B. 7

C. 10

D. 3

Hiển thị đáp án
Kết quả của hàm =Average(3,8,10) là (3 + 8 + 10) / 3= 7.

Đáp án: B

Câu 8: Để tính giá trị trung bình của ô A1, B1, C1 các cách tính nào sau đâu là đúng:

A. =Sum ( A1+B1+C1)

B. =Average(A1,B1,C1)

C. =Average (A1,B1,C1)

D. Cả A, B, C đều đúng

Hiển thị đáp án
hàm AVERAGE là hàm tính trung bình cộng của 1 dãy các số. Vậy để tính giá trị trung bình của ô A1, B1, C1 trong Excel ta gõ =Average(A1,B1,C1).

Đáp án: B

Câu 9: Cho hàm =Sum(A5:A10) để thực hiện?

A. Tính tổng của ô A5 và ô A10

B. Tìm giá trị lớn nhất của ô A5 và ô A10

C. Tính tổng từ ô A5 đến ô A10

D. Tìm giá trị nhỏ nhất từ ô A5 đến ô A10

Hiển thị đáp án
hàm =Sum(A5:A10) để thực hiện tính tổng từ ô A5 đến ô A10 gồm A5, A6, A7, A8, A9 VÀ A10.

Đáp án: C

Câu 10: Trong Excel, giả sử một ô tính được nhập nội dung:

=SUM(1,2)+MAX(3,4)+MIN(5,6) Vậy kết quả của ô tính là bao nhiêu sau khi ấn phím Enter?

A. 11

B. 12

C. 13

D. Một kết quả khác

Hiển thị đáp án
Hàm SUM, MAX, MIN là hàm tính tổng, giá trị lớn nhất, giả trị nhỏ nhất của một dãy các số. Nên SUM(1,2)+MAX(3,4)+MIN(5,6)= 3 + 4 + 5 =12

Đáp án: B
D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  Giả sử trong các ô A1, B1 lần lượt chứa các số -4,3. Em hãy cho biết kết quả các công thức tính sau:

a) =SUM(A1, B1);    b) =SUM(A1,B1,B1);    c) =SUM(A1,B1,-5);

  d) =SUM(A1, B1, 2);    e) =AVERAGE(A1,B1,4);    f) =AVERAGE(A1,B1,5,0);

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

- Yêu cầu HS trả lời các câu hỏi từ 1-3 ( SGK/Tr31)

Tiết 
Bài thực hành 4

BẢNG ĐIỂM LỚP EM

I - MỤC TIÊU

1. Kiến thức

- Dùng các hàm SUM, AVERAGE,MAX,MIN để tính toán

2. Năng lực
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy, bảng phụ.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện:GV cho học sinh làm bài tập thực hành 
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: HS thực hành trên máy tính 
a) Mục tiêu: HS hiểu được và nắm được  thao tác thực hành trên máy tính 
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ 

GV: Đưa nội dung yêu cầu trên bảng màn phụ.

 a) Nhập điểm thi các môn của lớp tương tự như hình trên bảng phụ.

b) Sử dụng công thức thích hợp để tính điểm trung bình của các bạn lớp em trong cột điểm trung bình.

c) Tính điểm trung bình của cả lớp và ghi vào ô dưới cùng của cột điểm trung bình.

d) Lưu bảng tính với tên bảng điểm của lớp em.

GV: Yêu cầu học sinh mở bảng tính Sổ theo dõi thể lực  đã được lưu trong bài tập 4 của bài thực hành 2 và tính chiều cao trung bình, cân nặng trung bình của các bạn trong lớp em.

a) Hãy sử dụng hàm thích hợp để tính lạo các kết quả đã tính trong bài tập 1 và so sánh với cách tính bằng công thức.

b) Sử dụng hàm AVERAGE để tính điểm trung bình tong môn học của cả lớp trong dòng điểm trung bình

c. Sử dụng hàm MAX, MIN để xác định điểm trung bình cao nhất và điểm trung bình thấp nhất.

GV: Sử dụng hàm thích hợp để tính tổng giá trị sản xuất của từng vùng đó theo năm vào cột bên phảI và tính giá trị sản xuất trung bình theo sáu năm theo từng ngành sản xuất.

- Lưu bảng tính vơí tên Gia tri san xuat
- Bước 2: Thực hiện nhiệm vụ

HS: Quan sát trên bảng phụ.

HS: Mở lại bài thực hành số 2 đã lưu trong máy.

HS thực hành trên máy

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	1. Bài 1

Lập trang tính và sử dụng công thức
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2. Bài 2

SỔ THEO DÕI THỂ LỰC

(SGK)

3. Bài 3

Sử dụng hàm AVERAGE, MAX, MIN

= AVERAGE(a,b,c,...)

= MAX( a,b,c,...)

= MIN( a,b,c,..)

Bài 4. Lập trang tính và sử dụng hàm SUM
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C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: 

? Để tính giá trị trung bình ta có những cách nào để tính?  Viết bằng công thức cụ thể?

? Nêu công thức tìm giá trị lớn nhất, nhỏ nhất của một dãy số?

D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

? Nêu công thức tính tổng?

*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

- Về ôn lại 4 hàm đã học, và thực hành trên máy nếu có điều kiện

- Xem trước bài mới (Bài 5)

Tiết 
BÀI TẬP

I - MỤC TIÊU

1. Kiến thức

- Dùng các hàm SUM, AVERAGE,MAX,MIN để tính toán

2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Bài tập thực hành, Phòng máy.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện: Thực hành  theo nhóm trên máy
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: HS thực hành trên máy tính 
a) Mục tiêu: HS hiểu được và nắm tháo tác thực hành trên máy tính
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Đưa nội dung yêu cầu trên bảng màn chiếu.

a) Nhập điểm thi các môn của lớp tương tự như hình trên màn chiếu ( Lập danh sách 15 HS ).

? Sử dụng công thức tính trực tiếp để tính cột điểm trung bình

? Sử dụng hàm AVERAGE để tính cột điểm trung bình

? So sánh kết quả của hai cách tính

 Lưu bảng tính với tên bảng điểm của lớp em.

GV: Yêu cầu học sinh sử dụng bảng tính trong bài tập 1.

a) (Thay cột Điểm trung bình = cột tổng điểm)

+ Tính tổng điểm 3 môn toán + Lý + Ngữ văn của từng học sinh

b) Thêm cột điểm lớn nhất và cột điểm nhỏ nhất:

Sử dụng hàm MAX, MIN để tìm điểm lớn nhất và điểm nhỏ nhất

GV: Lần lượt kiểm tra các nhóm thực hành trên máy và sửa chữa chỗ sai nếu có.
- Bước 2: Thực hiện nhiệm vụ

HS quan sát trên màn chiếu.

HS làm bài tập theo nhóm bàn và trả lời kết quả.

HS mở lại bài 1 và thực hành theo yêu cầu của GV

HS thực hành trên máy

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	1. Bài 1

 Lập trang tính và sử dụng công thức
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2. Bài 2
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3. Bài 3

Tìm điểm trung bình của cả lớp của cả 3 môn (Toán, Lý, Văn)


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

? Để tính giá trị trung bình ta có những cách nào để tính? Viết bằng công thức cụ thể?

? Nêu công thức tìm giá trị lớn nhất, nhỏ nhất của một dãy số?

D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: ? Nêu công thức tính tổng?
*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

- Về ôn lại 4 hàm đã học, và thực hành trên máy nếu có điều kiện

- Tiết sau Kiểm tra 1 tiết

Tiết 
KIỂM TRA MỘT TIẾT

I - MỤC TIÊU

1. Kiến thức
- Đánh giá sự nắm bắt kiến thức lý thuyết và cách dùng các hàm SUM, AVERAGE, MAX, MIN trong  tính toán với bảng tính.
2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, bài kiểm tra.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III -  PHƯƠNG PHÁP

Kiểm tra viết trên giấy.

IV -  TIẾN TRÌNH BÀI DẠY

1. Ổn định tổ chức ( 1’ )

B -  KIỂM TRA BÀI CŨ

C -  BÀI MỚI

Đề bài

I. Phần trắc nghiệm: (6 điểm)

Hãy chọn câu trả lời đúng nhất trong các câu sau:

1. Chọn câu đúng 

A. Thanh công thức sử dụng để nhập dữ liệu

          B. Thanh công thức sử dụng để hiển thị dữ liệu

C. Thanh công thức sử dụng để nhập công thức trong ô tính        D. Cả ba đều  đúng

2. Chọn câu sai:  Chương trình bảng tính là phần mềm được thiết kế để giúp:

A. Soạn thảo văn bản.




     B. Ghi lại và trình bày thông tin dưới dạng bảng 

C. Thực hiện tính toán, xây dựng các biểu đồ

     D. Cả B và C đều đúng

3. Chọn câu đúng: Khi dữ liệu ban đầu thay đổi thì kết quả tính toán sẽ:

A. Không thay đổi




A. Cần phải tính toán lại


C. Tự động cập nhật




D. Cả 3 câu trên đều sai

4. Chọn câu đúng: Khối dữ liệu có dữ liệu nằm các ô E10 và B5 thì địa chỉ của khối đó là:

    A. E10 : B10

B.  B5 : E10

C. B10 : E5

D. B5 : E5

5. Hãy nối cột A và B dưới đây để được phương án đúng:

	A
	B

	Chọn một ô

Chọn một hàng

Chọn một cột
	 Nháy chuột tại nút tên hàng

b) Nháy chuột tại nút tên cột

c) Đưa trỏ chuột tới ô đó và nháy


6. Thanh công thức cho ta biết nội dung của ô đang được chọn.


A. Đúng
B. Sai

7. Ở chế độ ngầm định, dữ liệu kiểu số được căn thẳng lề nào trong ô tính:


A. Phải
B. Trái

8. Nếu chọn đồng thời nhiều khối ô khác nhau, ta chọn khối đầu tiên và nhấn giữ phím nào để lần lượt chọn các khối ô tiếp theo


A. Alt
B. Ctrl
C. Shift

D. Phím nào cũng được

9. Muốn lưu giữ trang tính ta nhấn vào nút lệnh nào trên thanh công cụ:


A) [image: image9.png]





B) [image: image10.png]





C) [image: image11.png]


          

D) [image: image12.png]



10. Hãy chỉ ra công thức tính đúng


A. = ( 7+5)/3
B. = ‘( 7+3)/13
C. 7^5 + 3^ 2 =

D. Tất cả đều đúng

11. Cho giá trị ô A1 = 5, B1= 8. Hãy cho biết  kết quả của công thức A1*2 + B1*3

A. 13


B. 18

C. 34


D. 24

12. Nếu muốn tính giá trị trung bình của các ô A1 , B1, C1 thì  các cách tính nào sau đâu là đúng: 

A. = Sum ( A1+B1+C1)


B. = (A1+ B1+ C1)/3


C. = Average ( A1,B1,C1)


D. Cả A, B, C đều đúng

II. Phần tự luận: (4 điểm)

Câu 1: Nêu tên và tác dụng của các hàm mà em đã được học?  (1 điểm)

Câu 2: Nêu các bước nhập công thức vào ô tính và thao tác sao chép công thức (3 điểm)

D - HƯỚNG DẪN VỀ NHÀ

- Ôn lại 4 hàm đã học, và thực hành trên máy nếu có điều kiện.
- Đọc và tìm hiểu trước bài 5: Thao tác với bảng tính.

Tiết 

BÀI 5: THAO TÁC VỚI BẢNG TÍNH

I -  MỤC TIÊU
 1. Kiến thức

-  Hướng dẫn cho HS cách điều chỉnh độ rộng của cột và chiều cao của hàng, đồng thời giới thiệu khi nào thì  thêm cột, thêm hàng hoặc xoá cột, xoá hàng.

  2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy, bảng phụ.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện: Làm thế nào để điều chỉnh độ rộng của cột và chiều cao của hàng, đồng thời giới thiệu khi nào thì  thêm cột, thêm hàng hoặc xoá cột, xoá hàng. Chúng ta cùng nghiên cứu qua bài học hôm nay.
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: HS tìm hiểu cách điều chỉnh độ rộng của cột và chiều cao của hàng, 

a) Mục tiêu: Hướng dẫn cho HS cách điều chỉnh độ rộng của cột và chiều cao của hàng.
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Đưa tình huống: khi nhập vào trang tính xuất hiện các trường hợp như hình minh hoạ. (GV treo bảng phụ).

+ Cột Họ Tên và cột điểm trung bình quá hẹp.

+ Dòng quá hẹp

- GV thao tác các tình huống vừa đưa ra và cách giải quyết.

- Yêu cầu HS tự tạo ra tình huống và thao tác nhiều lần.

- Bước 2: Thực hiện nhiệm vụ

- HS quan sát trên bảng phụ.

- HS quan sát, ghi chép và thực hành trên máy.

HS ghi chép và thao tác trên máy tính của mình

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	1. Điều chỉnh độ rộng của cột và độ cao của hàng
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- Đưa con trỏ vào vạch ngăn cách 2 cột hoặc hai dòng.

- Kéo thả sang phải, trái/lên, xuống để mở rộng hoặc thu hẹp độ rộng hoặc chiều cao theo ý muốn.

* Chú ý: Nháy đúp chuột trên vạch phân cách cột hoặc hàng sẽ điều chỉnh độ rộng cột, độ cao hàng vừa khít với dữ liệu có trong cột và hàng đó.




Hoạt động 2: Chèn thêm hoặc xoá cột và hàng
a) Mục tiêu: HS biết chèn thêm hoặc xoá cột và hàng
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm rõ kiến thức bài học

d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

- GV đưa ra tình huống cần phải chèn thêm cột hoặc hàng trên màn chiếu. (Chèn thêm cột Giới tính bên cạnh cột Họ tên)

- Chèn thêm một hành để tạo khoảng cách như hình minh hoạ.

- GV giới thiệu cách làm bằng menu lệnh hoặc dùng chuột, hoặc dùng bàn phím.

- Chú ý: Khi xoá cột hoặc xoá hàng, các cột bên phải được đẩy sang trái, các hàng phía dưới được đẩy lên trên.
- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	2. Chèn thêm hoặc xoá cột và hàng

a) Chèn thêm cột hoặc hàng
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+ Để chèn thêm cột:

- Chọn một cột

- Insert(Columns
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+ Để chèn thêm hàng:

- Chọn một hàng

- Insert( Rows

b) Xoá cột hoặc hàng

- Chọn cột hoặc hàng cần xoá

- Chuột phải ( Delete


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 1: Trên trang tính, muốn thực hiện thao tác điều chỉnh độ rộng của cột khi:

A. cột chứa đủ dữ liệu.

B. cột không chứa hết dữ liệu hoặc dữ liệu quá ít.

C. cột chứa dữ liệu số.

D. cột chứa dữ liệu kí tự.

Hiển thị đáp án
Trên trang tính, ngầm định các cột có độ rộng bằng nhau và các hàng có độ cao bằng nhau. Nhưng khi dữ liệu quá nhiều hoặc quá ít cần điiểu chỉnh độ rộng của cột cho thích hợp.

Đáp án: B

Câu 2: Trên trang tính, để điều chỉnh độ rộng của cột, trước tiên ta phải

A. đưa chuột đến đường biên bên dưới của tên cột.

B. đưa chuột đến đường biên bên trái của tên cột.

C. đưa chuột đến đường biên bên phải của tên cột.

D. đưa chuột đến đường biên bên trên của tên cột.

Hiển thị đáp án
Trên trang tính, để điều chỉnh độ rộng của cột, trước tiên ta phải đưa chuột đến đường biên bên phải của tên cột và sau đó kéo thả chuột sang trái hoặc phải để điều chỉnh độ rộng.

Đáp án: C

Câu 3: Trên trang tính, muốn thực hiện thao tác điều chỉnh độ cao của hàng khi

A. hàng chứa đủ dữ liệu.

B. hàng không chứa hết dữ liệu hoặc dữ liệu quá ít.

C. hàng chứa dữ liệu số.

D. hàng chứa dữ liệu kí tự.

Hiển thị đáp án
Trên trang tính, muốn thực hiện thao tác điều chỉnh độ cao của hàng khi hàng không chứa hết dữ liệu hoặc dữ liệu quá ít. Các bước thực hiện:

- B1: đưa con trỏ chuột vào biên dưới tên hàng

- B2: kéo thả chuột để tăng độ cao

Đáp án: B

Câu 4: Trên trang tính, để điều chỉnh độ rộng của cột vừa khít với dữ liệu, ta thực hiện:

A. đưa chuột đến đường biên bên dưới của tên cột và nháy đúp chuột.

B. đưa chuột đến đường biên bên phải của tên cột và nháy đúp chuột.

C. đưa chuột đến đường biên bên trái của tên cột và nháy đúp chuột.

D. đưa chuột đến đường biên bên trên của tên cột và nháy đúp chuột.

Hiển thị đáp án
Trên trang tính, để điều chỉnh độ rộng của cột vừa khít với dữ liệu, ta thực hiện đưa chuột đến đường biên bên phải của tên cột và nháy đúp chuột trên vạch phân cách cột.

Đáp án: B

Câu 5: Trên trang tính, để điều chỉnh độ cao của hàng vừa khít với dữ liệu, ta thực hiện:

A. đưa chuột đến đường biên bên trái của tên hàng và nháy đúp chuột.

B. đưa chuột đến đường biên bên phải của tên hàng và nháy đúp chuột.

C. đưa chuột đến đường biên bên dưới của tên hàng và nháy đúp chuột.

D. đưa chuột đến đường biên bên trên của tên hàng và nháy đúp chuột.

Hiển thị đáp án
Trên trang tính, để điều chỉnh độ cao của hàng vừa khít với dữ liệu, ta thực hiện đưa chuột đến đường biên bên dưới của tên hàng và nháy đúp chuột trên vạch phân cách hàng.

Đáp án: C
D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  
Khởi động Excel, nhập dữ liệu để có trang tính mới tương tự như hình 1.51a.
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a) Điều chỉnh độ rộng các cột, chèn thêm các hàng trống để có trang tính được trình bày như hình 1.51b.

   b) Nhập công thức hoặc hàm thích hợp để tính tổng tiền bán máy tính để bàn trong ô D5.

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.

*HƯỚNG DẪN BÀI TẬP VỀ NHÀ III -  PHƯƠNG PHÁP

- Làm bài tập 1, 2 SGK/Tr.44

Tiết 
Bài  5: THAO TÁC VỚI BẢNG TÍNH (T2)
I - MỤC TIÊU

1. Kiến thức

-  Hướng dẫn cho HS cách sao chép và di chuyển dữ liệu, sao chép công thức.

2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

      1. Giáo viên: Phòng máy, giáo trình.

      2. Học sinh: Học và chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện:
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Làm cách nào để sao chép công thức trong ô D5 vào các ô D6:D9 để tính được tiền thu được cho các mặt hàng khác. Chúng ta cùng tìm hiểu bài học.
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: HS tìm hiểu cách sao chép và di chuyển dữ liệu
a) Mục tiêu: Hướng dẫn cho HS cách sao chép và di chuyển dữ liệu
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Đưa tình huống cần sao chép dữ liệu trong một ô hoặc một khối ô. 
- Chèn thêm một hành để tạo khoảng cách như hình minh hoạ.

- GV thao tác cụ thể cách sao chép nhiều lần cho HS quan sát.

- GV giới thiệu cách làm bằng menu lệnh hoặc dùng chuột, hoặc dùng bàn phím.

- Di chuyển nội dung của ô tính khác với sao chép nội dung của ô tính ( GV lấy VD cho HS quan sát sự khác nhau) ( Khi di chuyển nội dung thì đến ô tính khác thì nội dung ở ô ban đầu sẽ bị xoá

GV yêu cầu HS thao tác nhiều lần việc sao chép và di chuyển trên bảng tính.

- Chú ý: Khi xoá cột hoặc xoá hàng, các cột bên phải được đẩy sang trái, các hàng phía dưới được đẩy lên trên.

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	3. Sao chép và di chuyển dữ liệu

a) Sao chép nội dung ô tính

(Sử dụng các nút lệnh: Copy, Cut, Paste)

- Chọn ô hoặc khối ô có thông tin cần sao chép.

- Nháy nút Copy trên thanh công cụ.

- Chọn ô cần đưa thông tin được sao chép vào.

- Nháy nút Paste trên thanh công cụ.

b) Di chuyển nội dung ô tính

- Chọn ô hoặc các ô thông tin cần chuyển.

- Nháy nút Cut trên thanh công cụ

- Chọn ô cần đưa thông tin di chuyển đến.

- Nháy nút Paste trên thanh công cụ.




Hoạt động 2: Sao chép công thức
a) Mục tiêu: HS biết cách sao chép công thức
b) Nội dung: Hỏi và trả lời, trao đổi nhóm.
c) Sản phẩm: HS nắm rõ kiến thức bài học

d) Tổ chức thực hiện:

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

- Bước 2: Thực hiện nhiệm vụ

+ HS tiếp nhận nhiệm vụ, suy nghĩ và thảo luận

+ GV quan sát, hướng dẫn HS khi cần

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	4. Sao chép công thức

a) sao chép nội dung các ô có công thức
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- Khi sao chép một ô có nội dung là công thức chứa địa chỉ, các địa chỉ được điều chỉnh để giữ nguyên quan hệ tương đối về vị trí so với ô đích.

b) Di chuyển nội dung các ô có công thức

- Ta có thể di chuyển bằng các nút lệnh Cut và Paste và các địa chỉ trong công thức không bị điều chỉnh (công thức được sao chép y nguyên).


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 6: Trên trang tính, muốn chèn thêm một cột trống trước cột E, ta thực hiện:

A. nháy chuột chọn cột D và chọn lệnh Insert/Cells/Home.

B. nháy chuột chọn cột D và chọn lệnh Deletetrong nhóm Cells trên dải lệnh Home.

C. nháy chuột chọn cột E và chọn lệnh Deletetrong nhóm Cells trên dải lệnh. Home.

D. nháy chuột chọn cột E và chọn lệnh Insert trong nhóm Cells trên dải lệnh Home.

Hiển thị đáp án
Trên trang tính, muốn chèn thêm một cột trống trước một cột , ta thực hiện nháy chuột chọn cột E và chọn lệnh Insert trong nhóm Cells trên dải lệnh Home. Cột trống sẽ được chèn bên trái cột được chọn.

Câu 7: Trên trang tính, muốn xóa một cột trước cột E, ta thực hiện:

A. nháy chuột chọn cột D và chọn lệnh Insert/Cells/Home.

B. nháy chuột chọn cột D và chọn lệnh Delete trong nhóm Cells trên dải lệnh Home.

C.nháy chuột chọn cột E và chọn lệnh Delete trong nhóm Cells trên dải lệnh. Home.

D. nháy chuột chọn cột E và chọn lệnh Insert trong nhóm Cells trên dải lệnh Home.

Hiển thị đáp án
Trên trang tính, muốn xóa một cột trước cột E, ta thực hiện nháy chuột chọn cột E và chọn lệnh Delete trong nhóm Cells trên dải lệnh Home. Nếu chỉ muốn xóa dữ liệu trong ô chỉ cần chọn và bấm phím Delete trên bàn phím.

Đáp án: C

Câu 8: Trên trang tính, thao tác sao chép và di chuyển nội dung ô tính có mục đích

A. khó thực hiện tính toán.

B. tốn thời gian và công sức.

C. dể mất dữ liệu và khó thực hiện.

D. giúp tiết kiệm thời gian và công sức.

Hiển thị đáp án
Trên trang tính, thao tác sao chép và di chuyển nội dung ô tính có mục đích giúp tiết kiệm thời gian và công sức. Các bước thực hiện:

- B1: chọn ô hoặc các ô có dữ liệu em muốn sao chép

- B2: chọn lệnh copy [image: image20.png]


 hoặc dùng tổ hợp phím Ctrl + C

- B3: chọn ô muốn lưu dữ liệu đó

- B4: chọn lệnh paste [image: image21.png]


 hoặc dùng tổ hợp phím Ctrl + V

Đáp án: D

Câu 9: Trên trang tính, để sao chép hay di chuyển dữ liệu em sử dụng các lệnh:

A. Copy hoặc Cut và Paste trong nhóm lệnh Clipboard trên dải lệnh Home.

B. Copy hoặc Cut và Paste trong nhóm lệnh Cells trên dải lệnhHome.

C. Copy hoặc Cut và Paste trong nhóm lệnh Clipboard trên dải lệnh Insert.

D. Copy hoặc Cut và Paste trong nhóm lệnh Cells trên dải lệnh Insert.

Hiển thị đáp án
Các bước thực hiện để sao chép hay di chuyển dữ liệu:

- B1: chọn ô hoặc các ô có dữ liệu em muốn sao chép hoặc di chuyển

- B2: chọn lệnh copy hoặc cut

- B3: chọn ô muốn lưu dữ liệu đó

- B4: chọn lệnh paste hoặc dùng tổ hợp phím Ctrl + V

Đáp án: A

Câu 10: Trên trang tính, tại ô A1=5;B1=10; tại C1=A1+B1, sao chép công thức tại ô C1 sang ô D1, thì công thức tại ô D1 là:

A. A1+B1

B. B1+C1

C. A1+C1

D. C1+D1

Hiển thị đáp án
 B1+C1).( D1) và ô địa chỉ trong công thức ( A1+B1 (Trên trang tính, khi sao chép một ô có nội dung là công thức chứa địa chỉ, các địa chỉ sẽ được điều chỉnh để giữ nguyên vị trí tương đối giữa các ô chứa công thức ( C1 

Đáp án: B
D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  Yêu cầu HS thực hành để giải đáp bài tập 3/SGK.tr 44

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

- Làm bài tập 1, 2,3 SGK/Tr.44

Tiết 
Bài thực hành 5
CHỈNH SỬA TRANG TÍNH CỦA EM

I -  MỤC TIÊU

1. Kiến thức

-  Học sinh được thao tác để điểu chỉnh độ rộng của cột và chiều cao của hàng; các thao tác về hàng và cột trên một trang tính; Thực hiện các thao tác sao chép và di chuyển dữ liệu.

2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU 
1. Giáo viên: Giáo trình, phòng máy, bảng phụ.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện: 

? HS1: Nêu cách điều chỉnh độ rộng của cột và chiều cao của hàng? Thao tác cụ thể trên máy tính.

? HS2: Nêu cách thêm, bớt 1 cột hoặc 1 hàng? Thao tác cụ thể trên máy tính.

? HS3: Nêu các thao tác chính để sao chép và thao tác để di chuyển dữ liệu trong bảng tính?

Cả 3 HS lần lượt thực hiện( GV quan sát ( nhận xét và cho điểm.

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: HS thực hành trên máy tính 

a) Mục tiêu: HS thực hiện theo đúng  yêu cầu của giáo viên 
b) Nội dung: HS thực hành theo hướng dẫn của GV.

c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện: 

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN

	- Bước 1: Chuyển giao nhiệm vụ

GV: Yêu cầu học sinh khởi động chương trình bảng tính Excel và mở bảng tính Bang diem lop em đã được lưu trong bài thực hành 4.

a) Chèn thêm cột trống vào trước cột D (Vật Lý) để nhập điểm môn Tin học như minh hoạ bảng phụ.

b) Chèn thêm các hàng trống và thực hiện các thao tác điều chỉnh độ rộng của cột, độ cao của hàng để có trang tính tương tự như hình 48a (Bảng phụ).

c) Trong các ô của cột G (Diem trung binh) có công thức tính điểm trung bình của học sinh. Hãy kiểm tra công thức trong các ô đó để biết sau khi chèn thêm một cột, công thức có còn đúng không? điều chỉnh lại công thức cho đúng.

d) Di chuyển dữ liệu trong các ô cột thích hợp để có trang tính như hình 48b. Lưu bảng tính của em.

- Tiếp tục sử dụng bảng tính Bang diem lop em
a) Di chuển dữ liệu trong cột D (Tin hoc) tạm thời sang cột khác và xoá cột D. 

- Sử dụng hàm thích hợp để tính điểm trung bình ba môn học (toán, Vật lý, Ngữ Văn) của bạn đầu tiên trong ô F5 và sao sao chép công thức để tính điểm trung bình của các bạn còn lại.

b) Chèn thêm cột mới vào cột E (Ngữ văn) và sao chép dữ liệu từ cột lưu tạm thời (điểm Tin hoc) vào cột mới được chèn thêm. 

Kiểm tra công thức trong cột Điểm trung bình có còn đúng không? Từ đó rút ra kết luận thêm về ưu điểm của việc sử dụng hàm thay vì sử dụng công thức.

c) Chèn thêm cột mới vào cột Điểm trung bình và nhập dữ liệu để có trang tính như hình 49. 

Kiểm tra tính đúng đắn của công thức trong cột điểm trung bình và sửa công thức cho phù hợp.

Hãy rút ra kết luận khi nào chèn thêm cột mới, công thức vẫn đúng.

a) Tạo trang tính mới với nội dung như hình 50.

b) Sử dụng hàmh hoặc công thức thích hợp trong ô D1 để tính tổng các số trong các ô A1, B1 và C1

c) Sao chép công thức trong ô D1 vào các ô: D2; E1; E2 và E3.

- Quan sát các kết quả nhận được và giải thích?

- Di chuyển công thức trong ô D1 vào ô G1 và công thức trong ô D2 vào ô G2 ( Quan sát kết quả nhận được và rút ra nhận xét của em.

d) Ta nói rằng sao chép nội dung của một ô (Hay một khối ô) vào một khối có nghĩa rằng sau khi chọn các ô và nháy nút copy, ta chọn khối đích trước khi nháy nút Paste.

- Sao chép nội dung ô A1 vào khối H1:J4

- Sao chép khối A1:A2 vào các khối sau: A5:A7; B5:B8; C5:C9.

? Quan sát các kết quả nhận được và rút ra nhận xét của em.
- Bước 2: Thực hiện nhiệm vụ

HS: Thực hiện theo yêu cầu.

HS quan sát, ghi chép và thực hành trên máy.

HS ghi chép và thao tác trên máy tính của mình.

HS: Thực hành theo cặp.

HS thực hành theo hướng dẫn của GV.

HS: Thực hành theo cặp.

- Bước 3: Báo cáo, thảo luận

+ HS đứng dậy trình bày kết quả

+ GV gọi HS đứng dậy nhận xét, bổ sung đáp án cho bạn.

- Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá và chuẩn kiến thức.
	1. Bài 1

Điều chỉnh độ rộng của cột, độ cao hàng, chèn thêm hàng và cột, sao chép và di chuyển dữ liệu.

[image: image63.png]fx}

Mi

E) Fle Edt Vew Iwsert Fomat

Tooks Data Window Hel Type  queston for help v _ 8 X
DEESR EGRAY 2R - - QE = -EH L W -0,
MnTime. -1 - B ZIU =B $ %, @3 “2-A-.

B1 - ~

A B © [ E F G 1 J K |
1 i E
2
3 [STTHo va Tén Tosn 'Vt Ly Ngif Van Tin hoc  Diém trung binh
4| 1TeHoiAn 7 8 8 7
5 | 2 Nauyén Thai Anh 8 7 7 8
6 | 3 TeénVanBa 7 9 8 7
7 | 4 Nguyén Thanh Hai 9 8 8 8
6 | 5 Phgm My Hanh 8 7 8 8
9 | 6 Trong Van Himg 7 8 7 8
10| 7 Hoang Thi Hoa [ 7 [ 7
11| 8 Luong Van Hoang 7 [ 7 [
12| 9 Cao Vier Himg [ 9 7 7
13| 10 Mguyén Mai Ngoc 9 7 6 9
14
15
16
17

10 < » n\sheet1(sheet2

D~ Iy Autoshepes~ N\ (1O
Ready

Sheeta

Thihac ky Tin




a)

b)

[image: image64.png]B3 Microsoft Excel - Book1

e Edt Type 3 question for

Vew Insert Fomat Toos Data Window el

WERAGE(C7. 67)
c D E F [ R | J K

1

2 |Bing dim Jop 74

3

4 st Hocvaten Toin  TmHoc VatLy  Ngiivan Comgnghe Diém trung bin | G
5 1 BInh Van Hoang An 8 8 7| 8 8 Oniine:

51 2ILe T HonrAn s s s s s + Gt the st rens stk sy
8| 4 Pham Nuw Ann 0 0 O] 10 from the web

9| svavieram 5 5 6 5 5 e

10] 6 Phas Thanh Bunh 5 5 0 0 s Search for:

11| 7 Tran Quoc Binh 5 0 s o o

12| 8 Nguyén Linh Chi 7 0 6 s o Examples "Print more then one copy
13 9 Vi Xuan Cuong 5 0 5 7 0 . >

m Open NN
15 5 open.

15

o ) Create anew werkbook.

18

19

2

21

2

3

2

%

%

7

3

9

W 4 » wh\Sheet1 {Sheet2 [ Shest3 1< my J

Readh UM,







[image: image65.png]B3 Microsoft Excel - Book1

e Edt Vew Insert

Fomat  Tooks

Data Window

Help

F)

Bang diém Jop 7A

St Hocva ten
1 DInh Van Hoang An
2Le ThiHoaiAn

4 Phana N Anh
5 Va Viet Anh

6 Phan Thanh Binh
7 Tran Quoc Bink

& Nguyén Linh Chy
9 Vi Xuan Cuong

Toin

TinHoe

VarLy

Ngi van Diém trung binh

5
5
7

10

Readh

9
144 » i\ sheet1 {Sheet2 { Shesta

1<

775
5
775
015
75
s
s
75
5

Type 3 question for

* Connect o Microsoft Office
Online

* Get the latest news sbout using
Excel

* Automatically update this st
from the web

ere
search

Exanple: "t o than e co

| Open
5 open

3 Creste s new werkbook:

UM,





2. Bài 2

Tìm hiểu các trường hợp tự điều chỉnh của công thức khi chèn, thêm cột mới
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Đóng bảng tính nhưng không lưu.

3. Bài 3

Thực hành sao chép và di chuyển công thức và dữ liệu

Tạo trang tính
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4. Bài 4 

Thực hành chèn và điều chỉnh độ rộng của cột, chiều cao của hàng.
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C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: Nêu cách điều chỉnh độ rộng của cột và chiều cao của hàng? Thao tác cụ thể trên máy tính.

D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: Nêu cách thêm, bớt 1 cột hoặc 1 hàng? Thao tác cụ thể trên máy tính.

*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

Nêu cách thêm, bớt 1 cột hoặc 1 hàng? Thao tác cụ thể trên máy tính.

BÀI 6: ĐỊNH DẠNG TRANG TÍNH
I -  MỤC TIÊU

1. Kiến thức

-  Học sinh hiểu thế nào là định dạng một trang tính: Thay đổi phông chữ, cỡ chữ và kiểu chữ; căn lề ô tính, tô màu nền, tô màu văn bản...

2. Năng lực

   - NL sử dụng CNTT

   - NL giải quyết vấn đề

   - NL hợp tác, NL làm việc.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy, tranh.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III -  TIẾN TRÌNH BÀI DẠY
Đặt vấn đề: Định dạng nội dung của một (hoặc nhiều ô tính) em cần chọn ô tính (hoặc các ô tính) đó. Định dạng không làm thay đổi nội dung của các ô tính.
	HỌAT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	A. HOẠT ĐỘNG KHỞI ĐỘNG (5’)

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: HS quan sát và trả lời
d, Tổ chức thực hiện:

	Làm thế nào để có một bảng tính như hình? Chúng ta cùng tìm hiểu bài học hôm nay.
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	B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: Tìm hiểu cách định dạng phông chữ, cỡ chữ và kiểu chữ
a) Mục tiêu: 

-  Học sinh hiểu thế nào là định dạng một trang tính: Thay đổi phông chữ, cỡ chữ và kiểu chữ

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Học sinh hiểu thế nào là định dạng một trang tính: Thay đổi phông chữ, cỡ chữ và kiểu chữ
d, Tổ chức thực hiện

	Bước 1: Chuyển giao nhiệm vụ

GV : Thuyết trình và giải thích cho học sinh hiểu thế nào là định dạng trong trang tính.

GV: Giới thiệu các nút lệnh trên thanh công cụ dùng để dịnh dạng phông chữ, cỡ chữ và kiểu chữ.

GV: Sử dụng tranh vẽ trình bày các bước để thay đổi phông chữ trong Excel.

GV: Sử dụng tranh vẽ trình bày các bước để thay đổi cỡ chữ trong Excel.

GV: Sử dụng tranh vẽ trình bày các bước để thay đổi cỡ chữ trong Excel.

Bước 2: Thực hiện nhiệm vụ

HS: Chú ý lắng nghe.

HS: Quan sát và ghi chép.

Bước 3: Báo cáo, thảo luận

+ HS trả lời, nhận xét, bổ sung

Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.
	1. Định dạng phông chữ, cỡ chữ và kiểu chữ
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.Vntime: Chọn phông chữ.

12: Chọn cỡ cữ.

B: Chọn chữ đậm

I: chọn chữ nghiêng.

U: Chọn chữ gạch chân.

a) Thay đổi phông chữ

-  Bước 1: Chọn ô hoặc các ô cần định dạng.

-  Bước 2: Nháy mũi tên ở ô Font

-  Bước 3 : Chọn phông chữ thích hợp.

b) Thay đổi cỡ chữ

- Bước 1: Chọn ô hoặc các ô cần định dạng.

-  Bước 2: Nháy mũi tên ở ô Size.

-  Bước 3 : Chọn cỡ chữ thích hợp.

c) Thay đổi kiểu chữ

- Bước 1: Chọn ô hoặc các ô cần định dạng.

-  Bước 2: Nháy nút Bold để chọn chữ đậm, nút I để chọn chữ nghiêng, nút U để chọn chữ gạch chân.

* Chú ý : Có thể sử dụng đồng thời các nút để có các kiểu chữ thích hợp.

	Hoạt động 2: Tìm hiểu cách định dạng màu chữ, cách căn lề trong ô tính.
a) Mục tiêu: 

-  Học sinh hiểu thế nào là định dạng màu chữ, cách căn lề trong ô tính
b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: định dạng màu chữ, cách căn lề trong ô tính
d, Tổ chức thực hiện

	Bước 1: Chuyển giao nhiệm vụ

GV: Giới thiệu cách chọn màu phông.

GV: Giới thiệu cách căn lề trong ô tính.

Bước 2: Thực hiện nhiệm vụ

HS: Chú ý lắng nghe.

HS: Quan sát và ghi chép.

Bước 3: Báo cáo, thảo luận

+ HS trả lời, nhận xét, bổ sung

Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.
	2. Chọn màu phông

- Bước 1: Chọn ô hoặc các ô cần định dạng.

-  Bước 2: Nháy nút Font Color.

-  Bước 3 : Chọn màu chữ thích hợp.

3. Căn lề trong ô tính

- Bước 1: Chọn ô hoặc các ô cần định dạng.

-  Bước 2: Nháy nút Center để căn thẳng giữa ô tính, nút Right để căn lề phải, nút Left để căn lề trái cho ô tính.

	C.  HOẠT ĐỘNG LUYỆN TẬP (10')

a, Mục tiêu: Luyện tập củng cố nội dung bài học

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Học sinh vận dụng kiến thức đã học để trả lời được câu hỏi mà giáo viên đưa ra.
d, Tổ chức thực hiện: 

	GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 1: Để căn dữ liệu vào giữa nhiều ô tính ta sử dụng nút lệnh:
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Hiển thị đáp án
Để căn dữ liệu vào giữa nhiều ô tính ta sử dụng nút lệnh Center [image: image26.png]


 trong nhóm Alignment trên dải lệnh Home.

Đáp án: D

Câu 2: Giả sử ô A2 có nền màu xanh và chữ màu vàng. Ô B2 có nền màu trắng và chữ màu đen. Nếu sao chép ô A2 vào ô B2 thì ô B2 sẽ có:

A. Nền màu trắng và chữ màu đen

B. Nền màu xanh và chữ màu đen

C. Nền màu xanh và chữ màu vàng

D. Tất cả đều sai

Hiển thị đáp án
Giả sử ô A2 có nền màu xanh và chữ màu vàng. Ô B2 có nền màu trắng và chữ màu đen. Nếu sao chép ô A2 vào ô B2 thì ô B2 sẽ có nền màu xanh và chữ màu vàng.

Đáp án: C

Câu 3: Để giảm bớt một chữ số thập phân ta nháy vào nút lệnh:
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Hiển thị đáp án
Để giảm bớt một chữ số thập phân ta nháy vào nút lệnh Decrease Decimal [image: image28.png]0



 trong nhóm Number trên dải lệnh Home và chương trình bảng tính sẽ thực hiện qui tắc làm tròn số.

Đáp án: D

	D. HOẠT ĐỘNG VẬN DỤNG (8’)

a, Mục tiêu: Vận dụng làm bài tập 

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Kết quả BT của HS

d, Tổ chức thực hiện:

	GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  Trong văn bản, em có thể định dạng một phần văn bản khác với những phần văn bản còn lại. Với chương trình bảng tính em cũng có thể thực hiện định dạng tương tự với dữ liệu văn bản trong một ô tính.
 a) Hãy thực hiện các thao tác định dạng văn bản trong một ô tính có hai phần cỡ chữ và màu chữ khác nhau (hình 1.70).
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    b) Thực hiện các thao tác định dạng tương tự với dữ liệu số trong ô tính. Quan sát kết quả nhận được và ghi lại nhận xét của em.

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.


* Hướng dẫn về nhà:

-  Cách chọn màu cho phông chữ trong trang tính.

-  Các thao tác căn lề trong ô tính.

- Chuẩn bị bài tiếp theo

BÀI 6: ĐỊNH DẠNG TRANG TÍNH ( T2)
I -  MỤC TIÊU

1. Kiến thức

-  Học sinh hiểu được tầm  quan trọng của tính toán trong trang tính.

-  Tác dụng của việc trang trí phù hợp cho một trang tính.

2. Năng lực

   - NL sử dụng CNTT

   - NL giải quyết vấn đề

   - NL hợp tác, NL làm việc.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  T
HIẾT BỊ DẠY HỌC VÀ HỌC LIỆU
1. Giáo viên: Giáo trình, phòng máy.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY 

Kiểm tra bài cũ ( 5’ )

? Cách chọn màu cho phông chữ trong trang tính.

? Các thao tác căn lề trong ô tính.

TL: Chọn màu: Chọn trang tính ( chọn nút lện Font color trên  nút lệnh.

Căn lề: Chọn ô hoặc khối ô cần căn lề ( chọn 1 trong 3 nút căn lề trên thanh nút lệnh.
	HOẠT ĐỘNG CỦA GV – HS
	DỰ KIẾN SẢN PHẨM

	A. HOẠT ĐỘNG KHỞI ĐỘNG (5’)
a, Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b, Nội dung: Giáo viên đặt vấn đề, học sinh lắng nghe trả lời

c, Sản phẩm: Học sinh lắng nghe
d, Tổ chức thực hiện:

	GV: Giới thiệu với HS một số trường hợp cần sử dụng chữ số thập phân trong trang tính.

	B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: Tìm hiểu cách tăng hoặc giảm chữ số thập phân của dữ liệu số.
a, Mục tiêu: HS tìm hiểu cách tăng hoặc giảm chữ số thập phân của dữ liệu số.
b, Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c, Sản phẩm: Học sinh biết cách sử dụng một số công cụ có sẵn để thực hiện việc định dạng trang tính.
d, Tổ chức thực hiện:

	Bước 1: Chuyển giao nhiệm vụ

GV: Giới thiệu 2 nút lệnh để tăng và giảm số chữ số thập phân trong trang tính.

GV: Đưa ra các bước để tăng hoặc giảm số chữ số thập phân của dữ liệu số trong trang tính.

Bước 2: Thực hiện nhiệm vụ

HS: Chú ý lắng nghe.

HS: Quan sát và ghi chép.

Bước 3: Báo cáo, thảo luận

+ HS thực hiện báo cáo kết quả dữ liệu lọc

Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.
	4. Tăng hoặc giảm số chữ số thập phân của dữ liệu số

· Tăng thêm một chữ số thập phân.

· Giảm bớt một chữ số thập phân.

* Chú ý

Khi giảm bớt một chữ số thập phân, chương trình sẽ thực hiện quy tắc làm tròn số. 

-  Bước 1: Chọn ô (hoặc các ô) cần giảm hoặc tăng chữ số thập phân.

-  Bước 2: Nháy và nút [image: image30.png]


 để giảm số chữ số thập phân hoặc nút [image: image31.png]


 để tăng số chữ số thập phân.



	Hoạt động 2: Tìm hiểu cách tô màu nên và kẻ đường biên của các ô tính
a, Mục tiêu: HS tìm hiểu cách tô màu nên và kẻ đường biên của các ô tính
b, Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c, Sản phẩm: Học sinh biết cách sử dụng một số công cụ có sẵn để thực hiện việc định dạng trang tính.
d, Tổ chức thực hiện:

	Bước 1: Chuyển giao nhiệm vụ

GV: Treo một bức tranh có bảng tính Excel đã được trang trí màu nền và đường biên để học sinh quan sát và hỏi học sinh so sánh khi quan sát với một trang tính chưa được trang trí như vậy.

GV: Đưa ra các bước tô màu nền trong trang tính.

GV : Đưa ra các bước kẻ đường biên trong trang tính.

Bước 2: Thực hiện nhiệm vụ

HS: Chú ý lắng nghe.

HS: Quan sát và ghi chép.

Bước 3: Báo cáo, thảo luận

+ HS thực hiện báo cáo kết quả dữ liệu lọc

Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.
	5. Tô màu nền và kẻ đường biên của các ô tính

-  Màu nền của các ô tính giúp ta dễ dàng phân biệt và so sánh các miền dữ liệu khác nhau trên trang tính.

* Các bước tô màu nền

- Bước 1: Chọn ô hoặc các ô cần tô màu nền.

- Bước 2: Nháy vào nút Fill Colors để chon màu nền.

- Bước 3 : Nháy chọn màu nền.

* Các bước kẻ đường biên

- Bước 1: Chọn các ô cần kẻ đường biên.

- Bước 2: Nháy nút Border để chọn kiểu vẽ đường biên.

- Bước 3: Nháy chọn kiểu kẻ đường biên. 

	C.  HOẠT ĐỘNG LUYỆN TẬP (10')

a, Mục tiêu: Luyện tập củng cố nội dung bài học

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Kết quả bài tập của học sinh

d, Tổ chức thực hiện:

	GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 4: Trong ô B3 có chứa số 7.75, chọn ô B3 và nháy hai lần vào nút lệnh [image: image32.png]0



 thì kết quả trong ô B3 là:

A. 8

B. 7.7500

C. 7.8

D. 7.7

Hiển thị đáp án
Nút lệnh [image: image33.png]0



 là giảm đi chữ số thập phân tương ứng với lần nháy. Trong ô B3 có chứa số 7.75, chọn ô B3 và nháy hai lần vào nút lệnh [image: image34.png]0



 thì bỏ đi hai chữ số thập phân và kết quả trong ô B3 là 8 (theo quy tắc làm tròn số).

Đáp án: A

Câu 5: Để tăng thêm một chữ số thập phân ta nháy vào nút lệnh:

[image: image35.png]


Hiển thị đáp án
Để tăng thêm một chữ số thập phân ta nháy vào nút lệnh Decrease Decimal [image: image36.png]


 trong nhóm Number trên dải lệnh Home và chương trình bảng tính sẽ thực hiện qui tắc làm tròn số.

Đáp án: A
Câu 6: Câu nào sau đây sai. Khi nhập dữ liệu vào bảng tính thì:

A. Dữ liệu kiểu số sẽ mặc nhiên căn thẳng lề trái

B. Dữ liệu kiểu kí tự sẽ mặc nhiên căn thẳng lề trái

C. Dữ liệu kiểu thời gian sẽ mặc nhiên căn thẳng lề phải

D. Dữ liệu kiểu ngày tháng sẽ mặc nhiên căn thẳng lề phải

Hiển thị đáp án
Khi nhập dữ liệu vào bảng tính thì dữ liệu kiểu kí tự sẽ mặc nhiên căn thẳng lề trái, dữ liệu kiểu số sẽ mặc nhiên căn thẳng lề phải.

Đáp án: B

Câu 7: Trong ô B3 có chứa số 7.15, chọn ô B3 và nháy hai lần vào nút lệnh [image: image37.png]


 thì kết quả trong ô B3 là:

A. 8

B. 7.1500

C. 7.20

D. 7.200

Hiển thị đáp án
Nháy hai lần vào nút lệnh [image: image38.png]


 thì kết quả trong ô tăng thêm hai chữ số thập phân. Vậy trong ô B3 có chứa số 7.15, chọn ô B3 và nháy hai lần vào nút lệnh [image: image39.png]


 thì kết quả trong ô B3 là 7.1500.

Đáp án: B

Câu 8: Để kẻ đường biên cho các ô tính ta dùng:

A. Lệnh Borders trong nhóm Font trên dải Home.

B. Lệnh Fill Color trong nhóm Font trên dải Home.

C. Lệnh Borders trong nhóm Font trên dải Insert.

D. Tất cả đều sai

Hiển thị đáp án
Để kẻ đường biên cho các ô tính ta dùng lệnh Borders trong nhóm Font trên dải Home. Lệnh này có thể tùy chọn đường biên toàn bộ, hay chỉ có bên ngoài ô được chọn.

Đáp án: A

	D. HOẠT ĐỘNG VẬN DỤNG (8’)

a, Mục tiêu: Vận dụng làm bài tập 

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Kết quả BT của HS

d, Tổ chức thực hiện:

	GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  -Hướng dẫn học sinh định dạng bảng điểm lớp em trên Excel.

-Hướng dẫn học sinh về nhà luyện lập bảng điểm lớp em va định dạng theo mẫu

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.


*  Hướng dẫn về nhà:

- Chuẩn bị bài tiếp theo

Bài thực hành 6

ĐỊNH DẠNG TRANG TÍNH
I -  MỤC TIÊU

1. Kiến thức

-  Học sinh hiểu được tầm quan trọng của tính toán trong trang tính.

-  Tác dụng của việc trang trí phù hợp cho một trang tính.

2. Năng lực
   - NL sử dụng CNTT

   - NL giải quyết vấn đề

   - NL hợp tác, NL làm việc.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  T
HIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy.

2. Học sinh: Đọc trước bài ở nhà.

III -  PHƯƠNG PHÁP

Thực hành theo nhóm – GV giải đáp, hướng dẫn.

III - TIẾN TRÌNH BÀI DẠY

Kiểm tra bài cũ ( 5’ )

YÊU CẦU 1 HS THỰC HÀNH TRÊN MÁY:

?  Cách tăng, giảm số chữ số thập phân trong trang tính.

?  Cách tô màu nền và kẻ đường biên cho các ô tính trong trang tính.

GV quan sát HS thực hiện ( Nhận xét, uốn nắn và cho điểm.

	HOẠT ĐỘNG CỦA GV – HS
	DỰ KIẾN SẢN PHẨM

	A. HOẠT ĐỘNG KHỞI ĐỘNG

a, Mục tiêu: Tạo động cơ để học sinh biết cách sử dụng các công cụ của chương trình bảng tính Excel để định dạng nội dung trên trang tính.

b, Nội dung: Trong lớp học thực hiện trực tiếp trên file mẫu
c, Sản phẩm: Học sinh có nhu cầu mong muốn được biết cách sử dụng một số công cụ có sẵn để định dạng nội dung trang tính.
d, Tổ chức thực hiện: 
- GV: Cho học sinh nêu lại các bước định dạng phông chữ, kiểu chữ, cỡ chữ, màu chữ và căn lề dữ liệu nội dung trong ô tính.

- GV: Gọi hs lên bảng làm mẫu cho các hs khác xem

	B.  HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động: Thực hành bài 1, bài 2, bài 3

a, Mục tiêu: Nắm được các bước thực hành bài 1, bài 2
b, Nội dung: Sử dụng SGK, máy tính để thực hành dưới sự hướng dẫn của giáo viên

c, Sản phẩm: Kết quả thực hành bài 1, bài 2

d, Tổ chức thực hiện:

	Bài 1:

Bước 1: Chuyển giao nhiệm vụ

GV: Ra yêu cầu bài thực hành.

Bước 2: Thực hiện nhiệm vụ

HS: Nhận bài và làm trực tiếp trên máy tính.

Bước 3: Báo cáo, thảo luận
HS : Trả bài.

GV : Kiểm tra và lấy điểm.
	Tiết 1

Bài 1. Thực hành định dạng văn bản và số, căn chỉnh dữ liệu, tô màu văn bản, kẻ đường biên và tô màu nền.

- Mở bảng tính Bảng điểm lớp em đã được lưu trong bài thực hành 4. Thực hiện các điều chỉnh và định dạng thích hợp để có trang tính như hình dưới đây. Cuối cùng lưu bảng tính.
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Yêu cầu: Thực hịên định dạng với phông chữ, cỡ chữ, màu sắc khác nhau; dữ liệu số được căn giữa.

- Hàng 1 có các ô từ A1 đến G1 được gộp thành mô ô và nội dung được căn giữa bảng.

Các cột và các hàng được tô các màu nền và kẻ đường biên để dễ phân biệt.



	Bài 2:

Bước 1: Chuyển giao nhiệm vụ
GV: Ra yêu cầu bài thực hành.

Bước 2: Thực hiện nhiệm vụ

HS: Nhận bài và làm trực tiếp trên máy tính.

Bước 3: Báo cáo, thảo luận
HS : Trả bài.

Bước 4: Kết luận nhận định
GV : Kiểm tra và lấy điểm.


	Tiết 2

Bài 2

Thực hành lập trang tính, sử dụng công thức, định dạng, căn chỉnh dữ liệu ô và tô màu.

Khởi động chương trình bảng tính Excel.

a) Lập trang tính với  dữ liệu các nước trong khu vực Đông Nam  á như hình dưới đây (Tên các nước trong côt B được nhập theo thứ tự bảng chữ cái)
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b) Lập công thức để tính mật độ dân số (người/Km2) của Bru – nây trong ô E5. Sao chép công thức vào các ô tương ứng của cột E để tính mật độ dân số của các nước còn lại.

c) Chèn thêm các hàng trống cần thiết, điều chỉnh hàng, cột và thực hiện các thao tác định dạng văn bản, định dạng số để có trang tính tương tự như hình dưới đây.

	C + D. HOẠT ĐỘNG LUYỆN TẬP – VẬN DỤNG

a, Mục tiêu: Giúp học sinh củng cố cách sử dụng công cụ để định dạng trang tính
b, Nội dung: Trong lớp học, hoạt động cá nhân, nhóm
c, Sản phẩm: Học sinh vận dụng kiến thức đã học để trả lời được câu hỏi mà giáo viên đưa ra.
d, Tổ chức thực hiện:

-GV: hãy nêu các bước của việc tăng hoặc giảm số chữ số thập phân của dữ liệu số trong ô tính

- GV mở fie mẫu gọi hs lên thực hiện việc định dạng độ rộng của số thập phân và một số định dạng khác.


*  HƯỚNG DẪN VỀ NHÀ (1’)

- Thực hành lại trên máy nếu có điều kiện.

- Chuẩn bị đọc trước cho bài 7.

Tiết  
BÀI TẬP

I -  MỤC TIÊU

1. Kiến thức

-  Kiểm tra việc nắm bắnt kiến thức của học sinh và việc sử dụng các hàm để tính toán.

2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy, bảng phụ.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III. TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.
b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện: Thực hành theo nhóm – GV giải đáp, hướng dẫn.

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: HS thực hành trên máy tính 

a) Mục tiêu: HS thực hiện theo đúng  yêu cầu của giáo viên 
b) Nội dung: HS thực hành theo hướng dẫn của GV.

c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện: 

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN


		?



	a) Sử dụng các hàm để tính TĐ, ĐTB của các học sinh trên.

b) Sử dụng hàm Max, Min để tính TĐ, ĐTB lớn nhất, nhỏ nhất.

c) Điều chỉnh độ rộng của hàng và cột cho phù hợp.

d) Thêm cột Lý và cho điểm vào. Nhận xét gì về kết quả tổng điểm?
	


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện:

-  Nhắc lại các bước sử dụng công thức.

-  Nhận xét giờ thực hành của học sinh.

D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: Thực hành trên máy 
*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

Chuẩn bị cho bài kiểm tra thực hành.
Tiết 31 -32:
KIỂM TRA THỰC HÀNH

I -  MỤC TIÊU

1. Kiến thức

-  Kiểm tra chất lương các thao tác từ bài 1 đến bài 5

2.  Năng lực
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  CHUẨN BỊ

1. Giáo viên: Giáo trình, đề bài, phòng máy.

2. Học sinh: Học và chuẩn bị bài ở nhà.

III -  PHƯƠNG PHÁP

Kiểm tra thực hành trên máy.

IV -  TIẾN TRÌNH BÀI DẠY

1. Ổn định tổ chức (1’)

2. Kiểm tra bài cũ 

3. Bài mới (KIỂM TRA THỰC HÀNH )

Đề bài

Bài 1

     Khởi động chương trình bảng tính Excel. Nhập trang tính với nội dung như sau:

	
	A
	B
	C
	D
	E
	F

	1
	Stt
	Họ và tên
	Toán
	Lý
	Văn
	ĐTB

	2
	1
	Đinh Hoàng An
	8
	7
	8
	

	3
	2
	Lê Hoài An
	9
	10
	10
	

	4
	3
	Phạm Như Anh
	8
	6
	8
	

	5
	4
	Phạm Thanh Bình
	8
	8
	9
	

	6
	5
	Nguyễn Linh Chi
	7
	6
	8
	

	7
	6
	Vũ Xuân Cương
	10
	9
	9
	

	8
	7
	Trần Quốc Đạt
	8
	8
	9
	

	9
	8
	Nguyễn Anh Duy
	8
	9
	9
	

	
	9
	Nguyễn Trung Dũng
	8
	8
	7
	

	
	10
	Trần Hoàng Hà
	8
	7
	8
	


(H1)

a) Nhập điểm thi các môn như minh hoạ trong hình.

b) Tính điểm trung bình bằng công thức thích hợp vào cột ĐTB.

c) Lưu bảng tính với tên Bang diem cua em.

Bài 2 (Sử dụng hình của Bài 1)

a) Sử dụng các hàm thích hợp để tính lại các kết quả đã tính trong Bài 1 và so sánh với cách tính bằng công thức.

b) Sử dụng hàm Average tính điểm trung bình từng môn học của cả lớp trong dòng ĐTB.

c) Sử dụng hàm Max, Min xác định điểm trung bình cao nhất và điểm trung bình thấp nhất.

Bài 3

a) Chèn thêm một cột trống vào trước cột D (Lý) để nhập môn Tin như hình dưới.

b) Chèn các hàng trống và thực hiện các thao tác điều chỉnh độ rộng cột, độ cao hàng để có trang tính như hình H2.

	
	A
	B
	C
	D
	E
	F
	G

	1
	Stt
	Họ và tên
	Toán
	Tin
	Lý
	Văn
	ĐTB

	2
	1
	Đinh Hoàng An
	8
	8
	7
	8
	7.7

	3
	
	
	
	
	
	
	

	4
	2
	Lê Hoài An
	9
	10
	10
	10
	9.7

	5
	3
	Phạm Như Anh
	8
	8
	6
	8
	7.3

	6
	4
	Phạm Thanh Bình
	8
	9
	8
	9
	8.5

	7
	5
	Nguyễn Linh Chi
	7
	9
	6
	8
	7.5

	8
	6
	Vũ Xuân Cương
	10
	10
	9
	9
	9.5

	9
	7
	Trần Quốc Đạt
	8
	9
	8
	9
	8.5

	10
	
	
	
	
	
	
	

	11
	8
	Nguyễn Anh Duy
	8
	7
	9
	6
	7.5

	12
	9
	Nguyễn Trung Dũng
	8
	9
	8
	7
	7.7

	13
	10
	Trần Hoàng Hà
	8
	7
	7
	8
	7.5


(H2)

c) Di chuyển dữ liệu trong các cột thích hợp để có trang tính như hình H3.

	
	A
	B
	C
	D
	E
	F
	G

	1
	Stt
	Họ và tên
	Toán
	Tin
	Lý
	Văn
	ĐTB

	2
	1
	Đinh Hoàng An
	8
	7
	8
	8
	7.7

	3
	
	
	
	
	
	
	

	4
	2
	Lê Hoài An
	10
	10
	10
	9
	9.7

	5
	3
	Phạm Như Anh
	8
	6
	8
	8
	7.3

	6
	4
	Phạm Thanh Bình
	9
	8
	9
	8
	8.5

	7
	5
	Nguyễn Linh Chi
	8
	6
	9
	7
	7.5

	8
	6
	Vũ Xuân Cương
	9
	9
	10
	10
	9.5

	9
	7
	Trần Quốc Đạt
	9
	8
	9
	8
	8.5

	10
	
	
	
	
	
	
	

	11
	8
	Nguyễn Anh Duy
	6
	9
	7
	8
	7.5

	12
	9
	Nguyễn Trung Dũng
	7
	8
	9
	8
	7.7

	13
	10
	Trần Hoàng Hà
	8
	7
	7
	8
	7.5


*HƯỚNG DẪN VỀ NHÀ

- Ôn lại các kiến thức đã học, và thực hành trên máy nếu có điều kiện.

Tiết  
ÔN TẬP

I -  MỤC TIÊU

1. Kiến thức

-  Kiểm tra việc nắm bắt kiến thức của học sinh từ đầu năm học.

- Điều chỉnh việc học của học sinh cũng như việc dạy của giáo viên.

2. Năng lực 
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU 

1. Giáo viên: Giáo trình, phòng máy, bảng phụ.

2. Học sinh: Học và chuẩn bị bài ở nhà.

A. HOẠT ĐỘNG KHỞI ĐỘNG

a) Mục tiêu:  Ôn lại kiến thức của học sinh từ đầu năm học.
b) Nội dung: Ôn tập kiến thức đã học 
c) Sản phẩm: Hs quan sát và lắng nghe GV nói.
d) Tổ chức thực hiện: Quan sát, phân tích tổng hợp.
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: HS ôn lại toàn bộ lí thuyết và bài tập của các bài học 
a) Mục tiêu: HS thực hiện theo đúng  yêu cầu của giáo viên 
b) Nội dung: HS thực hành theo hướng dẫn của GV.

c) Sản phẩm: HS nắm được  kiến thức bài học 
d) Tổ chức thực hiện: 

	HĐ CỦA GV VÀ HỌC SINH
	SẢN PHẨM DỰ KIẾN


13

	165

	139721

	?



	57753

	?


	6

	GTTB

	?

	?

	?

	?


	7

	GTLN

				?


	8

	GTNN

				?



	- Lưu bảng với tên Gia tri san xuat.
	


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Giúp HS củng cố lại kiến thức để hoàn thành BT.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động nhóm.
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: 

-  Nhắc lại các bước sử dụng hàm để tính toán.

-  Nhận xét giáo án ôn tập của học sinh.

D. HOẠT ĐỘNG VẬN DỤNG

a) Mục tiêu: Giúp những học sinh vận dụng và mở rộng thêm kiến thức của mình.

b) Nội dung: Trao đổi, giải quyết vấn đề, thực hiện hoạt động cá nhân
c) Sản phẩm: Kết quả BT của HS

d) Tổ chức thực hiện: Thực hành trên máy
*HƯỚNG DẪN BÀI TẬP VỀ NHÀ 

Chuẩn bị tốt cho bài kiểm tra học kỳ I.
Tiết 
KIỂM TRA HỌC KÌ I 

PHẦN LÝ THUYẾT

I -  MỤC TIÊU

1. Kiến thức

-  Các thành phần trong trang tính.

-  Các khái niệm đơn giản ban đầu của trang tính. 

2. Năng lực
- Năng lực chung: tự học, tư duy, giao tiếp, học nhóm, sử dụng ngôn ngữ của môn học
- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.
3. Phẩm chất: 

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU
1. Giáo viên: Giáo trình, đề bài.

2. Học sinh: Học và chuẩn bị bài ở nhà.
III -  TIẾN TRÌNH BÀI DẠY

1. Ổn định tổ chức
B – GV phát đề kiểm tra cho học sinh
ĐỀ BÀI:
Đính kèm theo tệp
ĐỀ KIỂM TRA HỌC KÌ I- NĂM HỌC

Môn: Tin học 7

Thời gian: 45 phút  (không kể thời gian phát đề)

……..*………

A. PHẦN TRẮC NGHIỆM:  (3 điểm)

· Chọn câu trả lời đúng nhất:

Câu 1. Để khởi động chương trình bảng tính ta chọn. (0.25 điểm)

a. Nháy chuột vào biểu tượng trên màn hình

b. Tự Excel khởi động

c. Nháy đúp chuột trái vào biểu tượng của phần mềm Excel

d. Nháy vào biểu tượng W.

Câu 2: Lợi ích của chương trình bảng tính là? (0.25 điểm)

a. Tính toán tự động




b. Dễ dàng tạo ra các biểu đồ minh họa trực quan

c. Sắp xếp dữ liệu theo một trật tự nhất định

d. Tất cả đều đúng

Câu 3: Để chèn thêm cột (Columns) vào trang tính, ta thực hiện dãy lệnh: (0.25 điểm)

a. Format / cells / Insert / Columns 

b. Table / Insert / cells

c. Table / Insert / columns



d. Insert / Columns.

Câu 4. Giả sử cần tính tổng giá trị trong các ô C2 và D4, sau đó nhân với giá trị trong ô B2. Công thức nào trong số các công thức sau đây là đúng? (0.25 điểm)

 a. D4 +C2*B2
     




 b. =(D4 +C2)*B2 
              

 c. =(B2*(D4+C2)




d. =(D4+C2) B2

Câu 5. Giả sử trong các ô A1, A2 lần lượt chứa các số -8, 12. Em hãy cho biết kết quả của công thức: =AVERAGE(A1, A2, 11) (0.25 điểm)

a. -8
b. 12
c. 3
d. 5

Câu 6:
Hộp tên dùng để làm gì? (0.25 điểm)

a. Chứa tên







b. Hiển thị địa chỉ của ô được chọn

 c. Hiển thị công thức 




d. Hiển thị kết quả tính toán

Câu 7:
Trang tính có thể chứa dữ liệu thuộc kiểu nào sau đây? (0.25 điểm)

a. Kí tự







b.Số
c. Thời gian







d. Cả A, B và C

Câu 8: Thanh công thức dùng  để nhập công thức và hiểu thị. (0.25 điểm)

a. Dữ liệu và công thức trong ô tính


b. Hiển thị kết quả

c.   Không hiểu thị gì cả

d. Hiển thị tên cột và hàng

Câu 9: Điền vào chỗ trống cụm từ thích hợp (biểu đồ, ghi lại, phần mềm, bảng) để được khái niệm hoàn chỉnh về bảng tính. (1 điểm) 
Chương trình bảng tính là (………………) được thiết kế để giúp (……………….) và trình bày thông tin dưới dạng (………………..), thực hiện các tính tóan cũng như xây dựng các (…………….…) biểu diễn một cách trực quan các số liệu có trong bảng.

B. PHẦN TỰ LUẬN    (7 điểm)
Câu 1: (2 điểm)

          Hãy cho biết các thao tác để sao chép nội dung ô tính? 

Câu 2: (3 điểm)

          Hãy nêu cách nhập công thức trên trang tính?Lợi ích của việc sử dụng địa chỉ ô tính trong công thức?  
Câu 3: (2 điểm)

          Cho bảng điểm sau:     
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Em hãy quan sát hình trên và sử dụng địa chỉ ô, hoặc khối để:

- Viết công thức tính điểm trung bình môn Vật lí.

·  Viết công thức xác định điểm cao nhất cho môn Toán và môn Lịch sử.

----- HẾT -----

ĐÁP ÁN TIN HỌC 7 NĂM HỌC

…*….

A.  PHẦN TRẮC NGHIỆM:  (3 điểm)
                 Mỗi câu trả lời đúng là 0.25 điểm

	Câu
	1
	2
	3
	4
	5
	6
	7
	8

	Đáp án
	c
	d
	d
	b
	d
	b
	d
	a


Câu 9: Chương trình bảng tính là (phần mềm) được thiết kế để giúp (ghi lại) và trình bày thông tin dưới dạng (bảng), thực hiện các tính toán cũng như xây dựng các (biểu đồ) biểu diễn một cách trực quan các số liệu có trong bảng.   (1 điểm)
B. PHẦN TỰ LUẬN:  (7 điểm)
Câu 1: Các thao tác để sao chép nội dung ô tính: (2 điểm)
- Chọn ô có thông tin muốn sao chép.

- Nháy nút Copy trên thanh công cụ. 

- Chọn ô muốn đưa thông tin tới. 

- Nháy nút Paste trên thanh công cụ.

Câu 2:  Các bước nhập công thức trên trang tính (2 điểm)

- Chọn ô cần nhập công thức.


- Gõ dấu bằng.


- Nhập công thức.


- Nhấn phím Enter.

Lợi ích của việc sử dụng địa chỉ ô trong công thức: (1 điểm)

Khi nội dung các ô có địa chỉ trong công thức thay đổi thì kết quả của công thức được thay đổi một cách tự động.                                        

    Câu 3:  (2 điểm)
a. Môn Vật Lý:  =(C7+D7+E7*2+F7*3) / 7        (1 điểm)
b. Môn Toán:      =Max(C6:F6) -> 8                    (0.5 điểm)
    Môn Lịch sử:  =Max(C8:F8) -> 9                   (0.5 điểm)
BÀI 7: TRÌNH BÀY VÀ IN TRANG TÍNH

I -  MỤC TIÊU

1. Kiến thức

- Học sinh được học và sử dụng lệnh xem trước khi in trang tính, học các thao tác định dạng trang in, giấy in..

2. Năng lực

Năng lực chung 
- Năng lực tự học, năng lực giải quyết vấn đề, năng lực tư duy, năng lực hợp tác, năng lực sử dụng ngôn ngữ, năng lực phân tích, năng lực tổng hợp thông tin 
 Năng lực chuyên biệt
- Sử dụng và quản lý các phương tiện công nghệ thông tin và truyền thông.

- Sử dụng được phần mềm Excel để trình bày trang tính.

- Có khả năng làm việc nhóm tạo sự thay đổi cân đối, đẹp trên trang tính.

3. Phẩm chất: 

Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Chuẩn bị bài ở nhà. 

III - TIẾN TRÌNH BÀI DẠY

Kiểm tra bài cũ (5’)
Yêu cầu 1
 HS :

- Thực hành trên máy các yêu cầu sau:

- Định dạng phông chữ trong các ô tính.

- Tô màu nền cho các ô tính

- Kẻ đường biên của các ô tính.

GV: Quan sát – Nhận xét và cho điểm.

Đặt vấn đề: Trong quá trình thực hiện in ấn văn bản, trước khi thực hiện in chúng ta cần phải trình bày trang văn bản của mình bằng lệnh xem trước khi in.

A. KHỞI ĐỘNG

a, Mục tiêu:  Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.

b, Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Học sinh lắng nghe GV trình bày

d, Tổ chức thực hiện:

Chiếu cho HS quan sát bảng tổng kết kế hoạch nhỏ lớp 7A.Các em hãy quan sát bảng tổng kết kế hoạch nhỏ lớp 7A.

? Em có nhận xét gì về 2 trang in này?

-Để biết trang tính in ra đã hợp lí chưa em cần làm gì?

B. HÌNH THÀNH KIẾN THỨC 

Hoạt động 1: Tìm hiểu cách xem trước khi in
a) Mục tiêu: Học sinh được học và sử dụng lệnh xem trước khi in trang tính

b) Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c, Sản phẩm: HS nắm vững kiến thức về cách xem trước khi in

d, Tổ chức thực hiện:
	HỌAT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

GV: Thuyết trình và minh hoạ bằng tranh cho học sinh thấy hình ảnh xem trước khi in.

GV: Giới thiệu 1 vài nút lệnh chuyên dụng. (Next, Previous..)

GV: Chương trình bảng tự động phân trang tuỳ theo kích cỡ của trang tính.

Bước 2: Thực hiện nhiệm vụ:

HS : Nghe và quan sát.

Bước 3: Báo cáo, thảo luận

+ HS lắng nghe, ghi chép

Bước 4: Kết luận, nhận định

Chốt kiến thức lên bảng.
	1. Xem trước khi in

- Nháy vào nút Print Preview (xem trước khi in) trên thanh công cụ.
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Hoạt động 2: Tìm hiểu cách điều chỉnh ngắt trang
a) Mục tiêu: Học sinh học các thao tác định dạng trang in, giấy in..

b) Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c, Sản phẩm: HS nắm vững kiến thức về cách điều chỉnh ngắt trang

d, Tổ chức thực hiện:

	HỌAT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

GV: Để tự điều chỉnh cách ngắt trang theo ý mình ta làm như sau:

- Các đường viền xanh là các dấu ngắt trang. Chúng cho biết các trang in đượcphân chia như thế nào.
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GV: Thao tác trên máy chiếu cho học sinh quan sát.

Bước 2: Thực hiện nhiệm vụ

HS : Thực hiện trên máy tính cá nhân.

Bước 3: Báo cáo, thảo luận

+ HS trả lời, nhận xét, bổ sung

Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá 
	2. Điều chỉnh ngắt trang

- Để Điều chỉnh ngắt trang ta sử dụng lệnh Page Break Preview (xem ngắt trang) trong bảng chọn View.
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- Hiển thị trang tính trong  chế độ

Page Break Preview

- Đưa con trỏ vào đường kẻ xanh để phân chia.
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- kéo thả đường xanh đến vị trí tuỳ ý muốn.




C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Luyện tập củng cố nội dung bài học

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: Kết quả BT của HS
d, Tổ chức thực hiện:
GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 1: Để xem trước khi in một trang văn bản ta dùng chế độ hiển thị:

A. Page Layout

B. Page Break Preview

C. Normal

D. tất cả các đáp án trên

Hiển thị đáp án
Để xem trước khi in một trang văn bản ta dùng một trong ba chế độ hiển thị là Page Layout (chế độ hiển thị trình bày trang), Page Break Preview ( chế độ hiển thị ngắt trang), Normal (chế độ hiển thị bình thường).

Đáp án: D

Câu 2: Để xem trước khi in ta sử dụng các nhóm lệnh trong:

A. Nhóm WorkbookViews trên dải lệnh View.

B. Nhóm WorkbookViews trên dải lệnh Insert.

C. Nhóm WorkbookViews trên dải lệnh Page Layout.

D. Tất cả đều đúng.

Hiển thị đáp án
Để xem trước khi in ta sử dụng các nhóm lệnh trong nhóm WorkbookViews trên dải lệnh View. Trong đó thường dùng nhất là hai lệnh Page Layout và Page Break Preview.

Đáp án: A

Câu 3: Làm thế nào để điều chỉnh được các trang in sao cho hợp lí?

A. Xem trước khi in, ngắt trang hợp lí

B. Chọn hướng giấy in

C. Đặt lề cho giấy in

D. Cả 3 cách đều đúng

Hiển thị đáp án
Để điều chỉnh được các trang in sao cho hợp lí ta cần xem trước khi in, ngắt trang hợp lí, chọn hướng giấy in, đặt lề cho giấy in.

Đáp án: D

Câu 4: Lợi ích của việc xem trước khi in?

A. Cho phép kiểm tra trước những gì sẽ được in ra

B. Kiểm tra xem dấu ngắt trang đang nằm ở vị trí nào

C. Kiểm tra lỗi chính tả trước khi in

D. Cả 3 phương án trên đều sai

Hiển thị đáp án
Lợi ích của việc xem trước khi in là cho phép kiểm tra trước những gì sẽ được in ra, việc trình bày có hợp lí không và nếu in nhiều trang thì nội dung in trên từng trang có đúng như mong muốn không.

Đáp án: A

Câu 5: Để điều chỉnh ngắt trang như ý muốn, sử dụng lệnh:

A. Page Layout

B. Page Break Preview

C. Normal

D. Tất cả các đáp án đều sai

Hiển thị đáp án
Để điều chỉnh ngắt trang như ý muốn, sử dụng lệnh Page Break Preview trong nhóm WorkbookViews trên dải lệnh View.

Đáp án: B
D. HOẠT ĐỘNG VẬN DỤNG (8’)

a, Mục tiêu: Vận dụng làm bài tập 

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Kết quả bài tập của học sinh

d, Tổ chức thực hiện:
GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  Theo em, khi nào cần in trang tính theo hướng giấy đứng và khi nào theo hướng giấy ngang? Hãy tìm hiểu trên một số trang tính cụ thể và rút ra nhận xét của em.

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.

*  Hướng dẫn về nhà:

- Để thực hiện xem trang in ta làm như thế nào?

- Trả lời câu hỏi 1, 2 sgk

- Học và đọc theo nội dung SGK
TRÌNH BÀY VÀ IN TRANG TÍNH ( T2)
I - MỤC TIÊU

1. Kiến thức

- Học sinh được học và sử dụng lệnh xem trước khi in trang tính, học các thao tác định dạng trang in, giấy in..

2. Năng lực

Năng lực chung 
- Năng lực tự học, năng lực giải quyết vấn đề, năng lực tư duy, năng lực hợp tác, năng lực sử dụng ngôn ngữ, năng lực phân tích, năng lực tổng hợp thông tin 
 Năng lực chuyên biệt
- Sử dụng và quản lý các phương tiện công nghệ thông tin và truyền thông.

- Sử dụng được phần mềm Excel để trình bày trang tính.

- Có khả năng làm việc nhóm tạo sự thay đổi cân đối, đẹp trên trang tính.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Chuẩn bị bài ở nhà. 

III -  TIẾN TRÌNH BÀI DẠY

KIỂM TRA BÀI CŨ (5’)

? Nêu tác dụng của lệnh Print Preview? Thao tác trên máy tính?

TL: Nút lệnh Print Preview có tác dụng xem trước trang in

- HS thao tác trên máy ( GV quan sát và cho điểm.

A. KHỞI ĐỘNG (5’)

a, Mục tiêu:  Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: hs quan sát và lắng nghe GV nói.
d, Tổ chức thực hiện:

Để in trang tính đẹp, hợp thẩm mĩ các em phải làm thế nào? Tiết hôm nay thầy sẽ giới thiệu với các em về cách đặt lề trang, chọn hướng giấy in và lệnh in.

B. HÌNH THÀNH KIẾN THỨC 

a, Mục tiêu: - Học sinh được học và sử dụng lệnh xem trước khi in trang tính, học các thao tác định dạng trang in, giấy in..

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Học sinh sử dụng lệnh xem trước khi in trang tính, học các thao tác định dạng trang in, giấy in..
d, Tổ chức thực hiện:
	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

GV: Thông thường các trang in được đặt kích thước lề mặc định và hướng giấy in là hướng đứng.

[image: image41.png]€ ¢ Rl o,




GV: Ta có thể thực hiện việc thay đổi các lề và hướng giấy in cho phù hợp với yêu cầu của mình.

GV: Hướng dẫn học sinh cách để in một trang tính ra giấy. Làm mẫu trực tiếp trên máy.
Bước 2: Thực hiện nhiệm vụ

HS: Quan sát trên máy tính theo chỉ dẫn của giáo viên.

HS: Thực hiện trên máy tính cá nhân.

Bước 3: Báo cáo, thảo luận

+ HS báo cáo kết quả thực hành

Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.

	3. Đặt lề và hướng giấy in

- nháy chuột tại bảng chọn File -> Page Setup (hình vẽ)
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- Nháy chuột để mở trang Margins. Các lề hiện tại được liệt kê trong các ô Top, Bottom. Right, Left.

- Thay đổi các thông sô trong các ô Top, Bottom. Right, Left  để thiết đặt lề.

* Để thay đổi hướng giấy:

- Nháy chuột mở trang Page 

[image: image75.png]T e



- Chọn Potrait cho hướng giấy đứng hoặc Landscape cho hướng giấy nằm.

4. In trang tính

- Nháy chuột vào nút Print  trên thanh công cụ để in trang tính. (hoặc sử dụng bảng chọn)


C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Luyện tập củng cố nội dung bài học

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: Kết quả BT của HS
d, Tổ chức thực hiện:

GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 6: Chọn đáp án sai

A. Các trang in luôn được đặt kích thước lề ngầm định.

B. Hướng giấy luôn mặc định là hướng ngang.

C. Xem trước khi in với mục đích kiểm tra dữ liệu được in ra.

D. Chương trình trang tính luôn tự động phân chia trang tính ra thành các trang nhỏ.

Hiển thị đáp án
Các trang in được đặt kích thước lề ngầm định với hướng giấy in đứng.

Đáp án : B

Câu 7: Trong các thao tác sau, đâu là thao tác đặt hướng giấy in thẳng đứng?

A. View / Page Break Preview

B. Page Layout / Page setup / Page / Poitrait

C. File / Page setup / Margins

D. File / Print / Page

Hiển thị đáp án
Thao tác đặt hướng giấy thẳng đứng ta chọn dải lệnh Page Layout mở hội thoại Page Setup rồi nháy chuột để mở trang Page và chọn Landscape (hướng ngang) và Portrait (hướng đứng).

Đáp án: B

Câu 8: Trong các thao tác sau, đâu là thao tác để đặt lề giấy in?

A. View / Page Break Preview

B. File / Page Setup / Page

C. Page Layout/ Page Setup / Margins

D. File / Print

Hiển thị đáp án
Để đặt lề giấy in ta thực hiện dùng các lệnh trong nhóm Page Setup trên dải lệnh Page Layout để diều chỉnh.

- B1: mở dải lệnh Page Layout

- B2: ở hộp thoại Page Setup chọn margins

- B3: chọn Custom margins để tùy chỉnh lề.

- Các kích thước lề được hiển thị trong các ô Top, Bottom, Right, Left

- B4: thay đổi số trong các ô trên để thiết đặt lề.

Đáp án : C

Câu 9: Trong các thao tác sau, đâu là thao tác mở hộp thoại để In trang tính?

A. View / Page Break Preview

B. File / Page setup / Page

C. File / Page setup / Margins

D. File / Print/ nháy chuột vào biểu tượng Print

Hiển thị đáp án
Để In trang tính chọn lệnh Print trên bảng chọn File, sau đó nháy chuột vào nút Print.

Đáp án : D

Câu 10: Trong các thao tác sau, đâu là thao tác đặt hướng giấy nằm ngang?

A. View / Page Break Preview

B. Page Layout / Page setup / Page / Landscape

C. File / Page setup / Margins

D. File / Print / Margins

Hiển thị đáp án
Thao tác đặt hướng giấy nằm ngang ta chọn dải lệnh Page Layout mở hội thoại Page Setup rồi nháy chuột để mở trang Page và chọn Landscape (hướng ngang) và Portrait (hướng đứng).

Đáp án : B
D. HOẠT ĐỘNG VẬN DỤNG (8’)

a, Mục tiêu: Vận dụng làm bài tập 

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Kết quả bài tập của học sinh

d, Tổ chức thực hiện:

GV chia lớp thành nhiều nhóm 

(mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

- Trả lời câu1 hỏi 3, 4 sgk

- HS trả lời.
- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
* Hướng dẫn về nhà:

     - Học lại bài cũ và chuẩn bị trước bài thực hành 7: “Danh sách lớp em”

Bài thực hành 7:

DANH SÁCH LỚP EM
I - MỤC TIÊU

1. Kiến thức

- Học sinh biết vận dụng lệnh xem trước khi in trang tính, các thao tác định dạng trang in, giấy in..

2. Năng lực
- Năng lực chung: năng lực chuyên môn, năng lực hợp tác, năng lực giao tiếp, năng lực gợi nhớ, năng lực sử dụng ngôn ngữ.

- Năng lực chuyên biệt: Năng lực CNTT, tư duy.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Chuẩn bị bài ở nhà. 

III -  TIẾN TRÌNH BÀI DẠY

KIỂM TRA BÀI CŨ (5’)

HS1: Làm cách nào để có thể điều chỉnh trang in hợp lý?

HS2. Làm thế nào để có thể thay đổi hướng của giấy in?

TL: Để điều chỉnh trang in hợp lý ta dùng bảng chọn File ( Print prewiew

Để thay đổi hướng giấy in ta vào bảng chọn File ( Page Setup.

A. KHỞI ĐỘNG (5’)
a, Mục tiêu: Tạo động cơ để học sinh biết cách sử dụng các thao tác để kiểm tra trang tính trước khi in, đặt lề và hướng giấy cho trang in, điều chỉnh các dấu ngắt trang cho phù hợp với yêu cầu in.

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Học sinh có nhu cầu mong muốn được biết cách sử dụng một số lệnh để kiểm tra trang tính trước khi in, đặt lề và hướng giấy cho trang in, điều chỉnh các dấu ngắt trang cho phù hợp với yêu cầu in.

d, Tổ chức thực hiện:
- GV: Cho học sinh quan sát kết quả in trang tính trên giấy

- GV: Kết quả in ra có hợp lí không?

- GV: Cần phải kiểm tra trang tính trước khi in, đặt lề và hướng giấy in như thế nào để có các trang in hợp lí hơn?

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

a, Mục tiêu: Nắm được các bước thực hành bài 1, bài 2, bài 3
b, Nội dung: Sử dụng SGK, máy tính để thực hành dưới sự hướng dẫn của giáo viên

c, Sản phẩm: Kết quả thực hành bài 1, bài 2, bài 3

d, Tổ chức thực hiện:
	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

GV: Yêu cầu HS mở bảng tính Bảng điểm lớp em (đã lưu trong bài thực hành 6).

Ngoài nút lệnh Next  và Previous trên thanh công cụ Print Preview còn có các nút lệnh khác vói những chức năng để phóng to/Thu nhỏ trang in, mở hộp thoại Page Setup để thiết đặt trang in, xem chi tiết các lề của trang in, chuyển sang chế độ xem trang in với các dấu ngắt trang và đóng chế độ xem trước khi in, trở về chế độ bình thường.

Bước 2: Thực hiện nhiệm vụ

HS: Quan sát trên màn chiếu và thực hiện theo các yêu cầu của giáo viên

Bước 3: Báo cáo, thảo luận
HS: Thực hành trên máy cá nhân.

Bước 4: Kết luận, nhận định
+ GV nhận xét, đánh giá

	Bài tập 1. Kiểm tra trang tính trước khi in

a) Sử dụng công cụ Print Preview để xem trang tính trước khi in.

Quan sát sự thay đổi của màn hình và các đối tượng trên màn hình. Sử dụng các nút lệnh thay đổi của màn hình và các đối tượng trên màn hình. Sử dụng các nút lệnh Next và Previous trên thanh công cụ để xem các trang in.

b) Tìm hiểu chức năng của các nút lệnh khác trên thanh công cụ Print Preview
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c) Sử dụng nút lệnh để xem các dấu ngắt trang.

d) Ghi nhận các khiếm khuyết về ngắt trang trên các trang in; liệt kê những hướng khắc phục khuyết điểm đó.
Bài tập 2. Thiết đặt lề trang in, hướng giấy và điều chỉnh các dấu ngắt trang.
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	Bước 1: Chuyển giao nhiệm vụ

GV: Yêu cầu HS tiếp tục sử dụng bảng tính Bảng điểm lớp em.

a) Mở hộp thoại Page Setup. Trên trang Margins của hộp thoại, quan sát và ghi nhận các thông số ngầm định trong các ô Top, Bottom, Left  và Right,  sau đó thay đổi các thông số này. Nháy OK sau mỗi lần thay đổi thông số để thấy tác dụng trên trang in. Cuối cùng đặt các thông số này tương ứng là 2; 1.5; 1.5 và 2.

b) trên trang Page của hộp thoại  Page Setup , quan sát và ghi nhận các thiết đặt ngầm định Portrait ( đứng ). Đánh dấu chọn trong ô  Landscape và quan sát tác dụng. Cuối cùng đặt lại hướng giấy đứng.

c) Trở lại với các thiết đặt trang đứng và không có tỷ lệ, kiểm tra các trang bằng chế độ hiển thị Page Break Preview. Kéo thả chuột để điều chỉnh lại sao cho các cột được in hết trên một trang, mỗi trang in khoảng 25 hàng (hình)

- Yêu cầu: Dữ liệu trong hàng tiêu đề ( hàng 3) được căn giữa với kiểu chữ đậm và cỡ chữ to hơn.

- Dữ liệu trong các cột Stt, chiều cao, cân nặng được căn giữa; trong các cột Họ và tên, Địa chỉ, Điện thoại – căn tráI; trong cột  Ngày sinh – căn phải.

- Dữ liệu trong cột chiêu cao được định dạng với hai chữ số thập phân.

- Các hàng được tô màu nền phân biệt để dễ tra cứu.

Bước 2: Thực hiện nhiệm vụ

HS: Sử dụng bảng tính Bảng điểm lớp em và thực hành theo yêu cầu cỷa giáo viên.

HS: Quan sát trên màn hình giáo viên và thực hiện theo các yêu cầu của giáo viên.

Bước 3: Báo cáo, thảo luận
HS: Thực hành trên máy cá nhân.

Bước 4: Kết luận, nhận định
+ GV nhận xét, đánh giá
	Bài tập 3: Định dạng và trình bày trang tính.

a) Thực hiện các định dạng cần thiết để có trang tính tương tự hình 81 (sgk).

b) Xem trước trang in, kiểm tra các dấu ngắt trang và thiết đặt hướng trang nằm ngang để in hết các cột trên một trang, thiết đặt lề thích hợp và lựa chọn để in nội dung giữa trang giấy theo chiều ngang.

c) Lưu bảng tính và thực hiện lệnh in.




C + D. HOẠT ĐỘNG LUYỆN TẬP – VẬN DỤNG (10')

a, Mục tiêu: Giúp học sinh củng cố cách sử dụng các lệnh  để  kiểm tra trang tính trước khi in, đặt lề, hướng giấy và in trang tính.
b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Học sinh vận dụng kiến thức đã học để trả lời được câu hỏi mà giáo viên đưa ra.
d, Tổ chức thực hiện:

-GV: Để kiểm tra trang tính trước khi in, thiết đặt lề và hướng giấy cho trang in ta thực hiện những lệnh nào?

- HS: Trả lời.

- GV: Gọi hs lên máy thực hiện lại việc xem trang tính trước khi in, thiết đặt lề và hướng giấy in cho cả lớp xem và nhận xét.
* Hướng dẫn về nhà:

- Xem lại các nội dung trong tiết vừa thực hành

- Xem lại các nội dung thực hành trong SGK.

- Thực hành lại ở nhà nếu có điều kiện
BÀI 8: SẮP XẾP VÀ LỌC DỮ LIỆU
I -  MỤC TIÊU

1. Kiến thức

- Học sinh được trang bị kiến thức về sắp xếp và lọc dữ liệu trang tính..

2. Năng lực

Năng lực chung 
- Năng lực tự học, năng lực giải quyết vấn đề, năng lực tư duy, năng lực hợp tác, năng lực sử dụng ngôn ngữ, năng lực tổng hợp thông tin .
Năng lực chuyên biệt
- Sử dụng và quản lý các phương tiện công nghệ thông tin và truyền thông.

- Sử dụng được phần mềm Excel để sắp xếp và lọc dữ liệu.

- Có khả năng làm việc nhóm thực hiện được các thao tác sắp xếp và lọc dữ liệu.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy, tranh vẽ.

2. Học sinh: Chuẩn bị bài ở nhà. 

III -  TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a, Mục tiêu:  Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.

b, Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: hs quan sát và lắng nghe GV nói.
d, Tổ chức thực hiện:

- GV đặt vấn đề: Các em đã biết về một số lệnh cần thiết để điều chỉnh trang in, tiết hôm nay các em hãy vận dụng các kiến thức đã biết vào thực tế trong bài tập và tự tìm hiểu, khám phá thêm về các lệnh trình bày và in trang tính.

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động 1: Sắp xếp dữ liệu

a, Mục tiêu: - Học sinh được trang bị kiến thức về sắp xếp và lọc dữ liệu trang tính..

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Học sinh hiểu được, làm được về sắp xếp và lọc dữ liệu trang tính

d, Tổ chức thực hiện
	HOẠT ĐỘNG CỦA GV – HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

GV: Sắp xếp dữ liệu là hoán đổi vị trí các hàng để giá trị dữ liệu trong một hay nhiều cột được sắp xếp theo thứ tự tăng dần hoặc giảm

GV: Đưa ví dụ vẽ bằng tranh và cho HS quan sát.

GV: Để sắp xếp thứ hạng của HS theo điểm Trung bình ta thực hiện như sau:

1. Nháy chuột chọn một ô trong cột điểm trung bình
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2. Nháy nút      trên thanh công cụ

Ta sẽ nhận được kết quả tương tự như hình minh hoạ.

Bước 2: Thực hiện nhiệm vụ

HS: Quan sát trên tranh vẽ và thực hiện trên máy tính cá nhân.

Bước 3: Báo cáo, thảo luận

+ HS trả lời, nhận xét, bổ sung

Bước 4: Kết luận, nhận định

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.
	1. Sắp xếp dữ liệu

- Nháy chuột chọn một ô trong cột cần sắp xếp dữ liệu
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- Nháy nút      hay       trên thanh công cụ để sắp xếp theo thứ tự tăng dần hoặc giảm dần.
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Ví dụ: Trang tính dưới đây là kết quả học tập của  một số HS lớp 7a.
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Sau khi sắp xếp được kết quả:




C. HOẠT ĐỘNG LUYỆN TẬP

a) Mục tiêu: Luyện tập củng cố nội dung bài học

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: Kết quả BT của HS
d, Tổ chức thực hiện:

- GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 1: Để sắp xếp dữ liệu trong bảng tính theo thứ tự tăng dần em sử dụng nút lệnh nào dưới đây:
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Câu 2: Sau khi lọc theo yêu cầu thì dữ liệu trong cột được lọc đó sẽ thay đổi thế nào?

A. Sẽ được sắp xếp tăng dần

B. Sẽ được sắp xếp giảm dần

C. Dữ liệu được giữ nguyên theo vị trí ban đầu

D. Cả 3 đáp án trên đều sai

Câu 3: Để lọc dữ liệu em thực hiện:

A. Mở dải lệnh Data → chọn lệnh Filter

B. Mở dải lệnh Data → chọn lệnh AutoFilter

C. Mở dải lệnh Data → chọn lệnh Sort

D. Tất cả đều sai

Câu 4: Các bước lọc các hàng có giá trị lớn nhất( hay nhỏ nhất):

1: Nháy đúp chuột vào cột cần lọc

2: Click vào dấu [image: image43.png]


 hiển thị trên cột đang chọn.

3: Chọn nhóm lệnh Sort & Filter sau đó chọn Filter

4: Cửa sổ tùy chỉnh hiện lên, ta chọn Top để chọn các giá trị lớn nhất hoặc Bottom để chọn các giá trị nhỏ nhất, cuối cùng ta chỉnh số lượng các hàng muốn hiển thị.

5: chọn Number Filter sau đó chọn

6: nhấn OK để hiển thị kết quả.

Câu trả lời đúng là:

A. 1- 3 – 2 - 5 – 4 – 6

B. 2 – 1 – 3 – 5 – 6 – 4

C. 6 – 1 -2 – 3 – 4 – 5

D. tất cả đều sai

- HS tiếp nhận, trả lời câu hỏi:

	1- A
	2-D
	3-A
	4-A


- GV nhận xét, đánh giá, chuẩn kiến thức bài học.
D. HOẠT ĐỘNG VẬN DỤNG (8’)

a, Mục tiêu: Vận dụng làm bài tập 

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Kết quả bài tập của học sinh

d, Tổ chức thực hiện:
- GV yêu cầu HS trả lời câu hỏi:

  Khởi động chương trình bảng tính Excel, nhập dữ liệu và thực hiện các thao tác định dạng để có trang tính lưu kết quả thi đấu của đoàn vận động viên các nước tham gia SEAGAMES 28 như hình 1.89a. Hãy
a) Sắp xếp các nước theo tên nước với thứ tự tăng dần, giảm dần theo vần chữ cái.

b) Sắp xếp các nước theo tổng số huy chương đạt được với thứ tự giảm dần.

c) Sắp xếp các nước theo tổng số huy chương vàng đạt được theo thứ tự giảm dần.

- HS tiếp nhận, trả lời câu hỏi

- GV nhận xét, đánh giá, chuẩn kiến thức bài học.
* Hướng dẫn về nhà:

- Xem lại các thao tác để sắp xếp dữ liệu trong bảng tính.

- Thực hành nếu có điều kiện.

BÀI 8: SẮP XẾP VÀ LỌC DỮ LIỆU (Tiếp theo)
I - MỤC TIÊU

1. Kiến thức

- Học sinh được trang bị kiến thức về sắp xếp và lọc dữ liệu trang tính..

2. Năng lực

Năng lực chung 
- Năng lực tự học, năng lực giải quyết vấn đề, năng lực tư duy, năng lực hợp tác, năng lực sử dụng ngôn ngữ, năng lực tổng hợp thông tin .
Năng lực chuyên biệt
- Sử dụng và quản lý các phương tiện công nghệ thông tin và truyền thông.

- Sử dụng được phần mềm Excel để sắp xếp và lọc dữ liệu.

- Có khả năng làm việc nhóm thực hiện được các thao tác sắp xếp và lọc dữ liệu.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Chuẩn bị bài ở nhà. 

III -  TIẾN TRÌNH BÀI DẠY

     KIỂM TRA BÀI CŨ ( 5’ )

? Mở bảng tính Bảng điểm lớp em. Thực hiện thao tác sắp xếp dữ liệu tăng dần theo Điểm trung bình.


GV quan sát học sinh thực hiện trên máy ( nhận xét và cho điểm.

A. KHỞI ĐỘNG (5’)

a, Mục tiêu:   Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: hs quan sát và lắng nghe GV nói.
d, Tổ chức thực hiện:
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Để có dữ liệu được sắp xếp như bảng, chúng ta làm như nào? Cùng tìm hiểu qua bài học hôm nay

B. HÌNH THÀNH KIẾN THỨC 

a, Mục tiêu: - Học sinh được trang bị kiến thức về sắp xếp và lọc dữ liệu trang tính..

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Học sinh hiểu được dữ liệu trang tính là gì, và biết cách sắp xếp và lọc dữ liệu trang tính
d, Tổ chức thực hiện
	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

GV: Lọc dữ liệu là chọn và chỉ hiện thị các hàng thoả mãn các tiêu chuẩn nhất định nào đó.

-  Ví dụ: Lọc ra các học sinh có điểm trung bình tà 8.8 trở lên (hình minh hoạ)


GV: Hướng dẫn học sinh thao tác trên máy tính.

GV: Hướng dẫn học sinh cách lọc hàng có giá trị lớn nhất hay nhỏ nhất.

Bước 2: Thực hiện nhiệm vụ

HS: Quan sát trên màn chiếu và thực hiện trên máy tính cá nhân.

Bước 3: Báo cáo kết quả hoạt động và thảo luận

+ HS thực hiện báo cáo kết quả dữ liệu lọc

Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.

	2. Lọc dữ liệu

Thực hiện các thao tác sau:

Bước 1. Chuẩn bị:

- Nháy chuột chọn 1 một ô trong vùng có dữ liệu cần lọc.

- Mở bảng chọn Data -> Filter( AutoFilter.

sẽ xuất hiện các mũi tên như bảng sau:
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Bước 2. Lọc:

- Chọn tiêu đề để lọc
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 trên hàng tiêu đề cột. (hình vẽ).

- Kết thúc lọc: Chọn Data ( Filter 

( Show All (Hiển thị tất cả).

3. Lọc các hàng có giá trị lớn nhất hay nhỏ nhất

- Khi nháy chuột ở mũi tên trên tiêu đề cột có các lựa chọn sau:

+ Top 10: Lọc các hàng có giá trị dữ liệu thuộc mộ số giá trị.

VD: Chọn 3 học sinh có ĐTB lớn nhất: Chọn Top 10 ( Chọn ô thứ 2 có giá trị là 3 ( OK.


C.  HOẠT ĐỘNG LUYỆN TẬP (10')

a, Mục tiêu: Luyện tập củng cố nội dung bài học

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Kết quả bài tập của học sinh

d, Tổ chức thực hiện:
- GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 8: Theo em lọc dữ liệu để làm gì?

A. Để danh sách dữ liệu đẹp hơn

B. Để danh sách dữ liệu có thứ tự

C. Để chọn và chỉ hiển thị các hàng thỏa mãn các tiêu chuẩn nhất định nào đó

D. Không để làm gì cả.

Hiển thị đáp án
Lọc dữ liệu để chọn và chỉ hiển thị các hàng thỏa mãn điều kiện do chúng ta quy định.

Đáp án : C

Câu 9: Để hiển thị tất cả các dòng dữ liệu sau khi lọc, em chọn lệnh gì?

A. Show All

B. Advanced Filter

C. AutoFilter

D. Sellect All

Hiển thị đáp án
Để hiển thị tất cả các dòng dữ liệu sau khi lọc, em chọn lệnh Sellect All khi đó sẽ hiện thị toàn bộ danh sách dữ liệu mà vẫn làm việc trong chế độ lọc.

Đáp án : D

Câu 10: Chọn câu đúng:

A. Lọc dữ liệu là chọn và chỉ hiển thị các hàng thoả mãn các tiêu chuẩn nào đó

B. Kết quả lọc dữ liệu sắp xếp lại dữ liệu

C. Để lọc dữ liệu em chọn lệnh Filter

D. Tất cả câu trên đúng

Hiển thị đáp án
Lọc dữ liệu là chọn và chỉ hiển thị các hàng thoả mãn các tiêu chuẩn nào đó, để lọc dữ liệu em chọn lệnh Filter và kết quả lọc dữ liệu sắp xếp lại dữ liệu.

Đáp án : D
D. HOẠT ĐỘNG VẬN DỤNG (8’)

a, Mục tiêu: Vận dụng làm bài tập 

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Kết quả BT của HS

d, Tổ chức thực hiện:
- GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  Bài 3 (trang 83 sgk Tin học lớp 7):Với bảng tính SeaGames khi lọc ra ba nước có tổng số huy chương nhiều nhất, em nhận được kết quả nhiều hơn ba nước. Giải thích tại sao
- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
* Hướng dẫn về nhà:

- Xem lại các thao tác để sắp xếp dữ liệu và lọc dữ liệu trong bảng tính

- Thực hành nếu có điều kiện

Bài thực hành 8: AI LÀ NGƯỜI HỌC GIỎI

I - MỤC TIÊU

1. Kiến thức

-  Biết được các thao tác sắp xếp dữ liệu.

-  Biết khái niệm lọc dữ liệu.

2. Năng lực

- Năng lực chung: Tự học, giải quyết vấn đề, tư duy, tự quản lý.

- Năng lực chuyên biệt:
+ Năng lực sử dụng CNTT hỗ trợ học tập  và công việc của bản thân.

+ Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  T
HIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

     1. Giáo viên: Giáo trình, Phòng máy.

      2. Học sinh: Chuẩn bị bài ở nhà. 

III - TIẾN TRÌNH BÀI DẠY

KIỂM TRA BÀI CŨ

(Kết hợp trong quá trình thực hành)

C. HOẠT ĐỘNG KHỞI ĐỘNG

a, Mục tiêu: Biết được các thao tác sắp xếp dữ liệu, lọc dữ liệu
b, Nội dung: Giáo viên đặt vấn đề, học sinh lắng nghe trả lời

c, Sản phẩm: Học sinh nắm vững kiến thức bài thực hành

d, Tổ chức thực hiện:

GV: Bài trước các em đã tìm hiều bài 8: sắp xếp và lọc dữ liệu. Hôm nay để củng cố lại kiến thức chúng ta cùng đến với thực hành 8: Ai là người học giỏi

D. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động: Thực hành bài 1, bài 2, bài 3

a, Mục tiêu: Nắm được các bước thực hành bài 1, bài 2, bài 3
b, Nội dung: Sử dụng SGK, máy tính để thực hành dưới sự hướng dẫn của giáo viên

c, Sản phẩm: Kết quả thực hành bài 1, bài 2, bài 3

d, Tổ chức thực hiện:

	HOẠT ĐỘNG CỦA GV – HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

GV : Yêu cầu học sinh khởi động chương trình bảng tính Excel, mở bài Bang diem lop em và thực hành theo yêu cầu.

GV : Hướng dẫn sơ bộ học sinh cách thực hiện bài.

GV : Giới thiệu bài tập 2 trang 77 SGK và ra yêu cầu của bài.

GV : Hướng dẫn học sinh cách làm bài.

GV: Nhắc lại kiến thức về sắp xếp như đã thực hành ở tiết trước và ra tiếp bài yêu cầu học sinh thực hành với công cụ là lọc dữ liệu. 

GV: Hướng dẫn học sinh quan sát bài tập 3 – SGK trang 78.

- Đưa ra một số chỉ dẫn để các em hiểu và có khả năng thực hành được bài 

* Chú ý: Trong quá trình học sinh làm bài giáo viên đi lại quan sát và có thể gợi ý khi các em gặp vướng mắc.

Bước 2: Thực hiện nhiệm vụ

HS: Nhận yêu cầu bài tập của giáo viên và thực hành. 

HS: Nghe chỉ dẫn và làm bài.

HS: Nhận đề bài, nghe hướng dẫn và làm bài thực hành.

HS: Nghe chỉ dẫn của giáo viên, nhận đề bài và thực hành. 

HS: Xem SGK và chú ý nghe hướng dẫn của giáo viên và thực hiện làm bài.

HS: Thực hiện làm bài và trả bài khi xong.
Bước 3: Báo cáo kết quả hoạt động và thảo luận

+ HS trả lời, nhận xét, bổ sung

Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.
	Tiết 1

1. Bài 1

a) Thực hiện các thao tác sắp xếp theo điểm các môn học và diẻm trung bình.

b) Thực hiện các thao tác lọc dữ liệu để chọn các bạn có điểm 10 môn Tin học.

c) Lọc ra các bạn có điểm trung bình cả năm là hai điểm thấp nhất.

2. Bài 2

a) Mở bảng tình Cac nuoc DNA đã có trong Bài thuc hanh 6.

b) Hãy sắp xếp các nước theo.

- Diện tích tăng dần hoặc giảm dần.

- Dân số tăng dần hặc giảm dần.

- Mật độ dân số tăng dần hặc giảm dần.

- Tỉ lệ dân số thành thị tăng dần hặc giảm dần. 

Tiết 2

1. Bài 2 (tiếp)

c) Sử dụng công cụ để lọc

- Lọc ra các nước có diện tích là năm diện tích lớn nhất.

- Lọc ra các nước có số dân là ba số dân ít nhất.

- Lọc ra các nước có mật độ dân số là ba mật độ dân số cao nhất.

2. Bài 3

Tìm hiểu thêm về sắp xếp và lọc dữ liệu

(SGK trang 78)


* CỦNG CỐ

- Các thao tác cơ bản với sắp xếp và lọc dữ liệu trên trang tính.

- Ôn lại các kiến thức đã học.

KIỂM TRA MỘT TIẾT

I - MỤC TIÊU

1. Kiến thức 

    - Kiểm tra việc nắm bắt kiến thức của học sinh về định dạng, trình bày, in ấn... để có phương pháp điều chỉnh về việc học của học sinh cũng như việc dạy của giáo viên.

2. Năng lực
- Năng lực chung: Tự học, giải quyết vấn đề, tư duy, tự quản lý.

- Năng lực chuyên biệt: Giúp hs đánh giá kết quả và thái độ học tập của mình trong thời gian vừa qua.

3. Phẩm chất: 

Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU
1. Giáo viên: Giáo trình, đề bài.

2. Học sinh: Chuẩn bị kiến thức các bài 6, 7, 8.

III - TIẾN TRÌNH BÀI DẠY

Đề bài

Phần I (4 điểm): Trắc nghiệm

1. Để mở bảng tính đã có trong máy ta sử dụng lệnh nào?

A. New

B. Save

C. Open

D. Close

2. Các nút lệnh B I U nằm trên thanh nào?


A. Thanh tiêu đề



B. Thanh công thức


C. Thanh bảng chọn


D. Thanh công cụ

3. Để ngắt trang tính ta sử dụng lệnh nào?


A. Page Break Preview


B. Print Preview


C. Print




D. Cả A, B, C đều sai

4. Nút lệnh nào dùng để sắp xếp theo thứ tự giảm dần?


A. 
[image: image47.png]







B.     [image: image48.png]




C. 
[image: image49.png]







D. Cả A, B, C đều sai

5. Để lọc dữ liệu ta sử dụng lệnh nào?


A. Data -> Sort



B. Data -> Filter -> Auto Filter


C. Cả A, B đều đúng


D. Cả A, B đều sai

6. Muốn tính tổng của dữ liệu số ta dùng hàm nào?


A. sum

B. Average

C. max

D. min

7. Để gộp các ô và căn chỉnh nội dung vào chính giữa ô gộp đó ta sử dụng nút lệnh:


A. 
[image: image50.png]




B.
[image: image51.png]




C. [image: image52.png]





D.  [image: image53.png]



8. Để tăng chữ số thập phân ta sử dụng lệnh:


A.  [image: image54.png]




B. [image: image55.png]




C.  [image: image56.png]



D. Cả A, B, C đều sai

Phần II (6 điểm): Tự luận

Câu 1 (2 điểm): Giả sử ô A1 có nền màu vàng và chữ màu đỏ. Ô A3 có nền màu trắng, chữ màu đen. Em hãy nêu cách sao chép nội dung ở ô A1 vào ô A3 và thử dự đoán sau khi sao chép ô A3 có nền và phông chữ màu gì?

Câu 2 (4 điểm): Cho bảng điểm học sinh

BẢNG ĐIỂM LỚP 7A

	STT
	Họ và tên
	Toán
	Văn
	Tin
	ĐTB

	1
	Nguyễn Hoà An
	8
	7
	8
	7.7

	2
	Lê Thái Anh
	8
	5
	7
	6.7

	3
	Trần Quốc Bình
	8
	9
	9
	8.7

	4
	Phạm Ngọc Mai
	9
	9
	10
	9.3

	5
	Bùi Thu Hà
	7
	6
	8
	7.0


a) Nêu cách sắp xếp cột ĐTB theo thứ tự tăng dần.

b) Nêu cách lọc học sinh có ĐTB là 9.3.

c) Sau khi lọc, để hiển thị tất cả bảng điểm ta làm thế nào?

d) Để thoát khỏi chế độ lọc ta làm thế nào?

Đáp án + Biểu điểm

	Câu
	Đáp án
	Biểu điểm

	Phần I.  1
	C
	0.5

	2
	D
	0.5

	3
	A
	0.5

	4
	B
	0.5

	5
	B
	0.5

	6
	A
	0.5

	7
	C
	0.5

	8
	A
	0.5

	Phần II. 1 
	- Nhấp chuột ô A1, nháy nút lệnh Copy.

- Nhấp chuột ô A3, nháy nút Paste.

- Nền vàng, chữ đỏ.
	0.5

0.5

1

	2
	a) Nháy chuột  ô trong cột ĐTB, nháy nút lệnh sắp xếp tăng dần.
	1

	
	b)  Data -> Filter -> AutoFilter -> ......
	1

	
	c) Data -> Filter -> AutoFilter -> Show All.
	1

	
	d) Data -> Filter -> AutoFilter. 
	1


Bài 9: TRÌNH BÀY DỮ LIỆU BẰNG BIỂU ĐỒ

I -  MỤC TIÊU

1. Kiến thức

- Biết mục đích của việc sử dụng biểu đồ.

- Một số dạng biểu đồ thông thường.

- Các bước cần thiết để tạo một biểu đồ từ bảng dữ liệu.

- Thay đổi dạng biểu đồ đã tạo, xoá, sao chép biểu đồ vào văn bản Word.

2. Năng lực:

Năng lực chung:
Năng lực tự học, năng lực giải quyết vấn đề, năng lực tư duy, năng lực hợp tác, năng lực sử dụng ngôn ngữ, năng lực phân tích, năng lực tổng hợp thông tin.

Năng lực chuyên biệt:
- Sử dụng và quản lý các phương tiện công nghệ thông tin và truyền thông.

- Có khả năng làm việc nhóm

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

III -  TIẾN TRÌNH BÀI GIẢNG

A. KHỞI ĐỘNG

a, Mục tiêu:   Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Học sinh lắng nghe GV trình bày

d, Tổ chức thực hiện:

-GV dẫn vào bài học: Tiết trước các em đã thực hành về sắp xếp và lọc dữ liệu, hôm nay các em sẽ tiếp tục tìm hiểu về trình bày dữ liệu bằng biểu đồ 
B. HÌNH THÀNH KIẾN THỨC 

Hoạt động: Minh họa số liệu bằng biểu đồ, một số dạng biểu đồ, tạo biểu đồ, chỉnh sửa biểu đồ 

a, Mục tiêu: 

- Biết mục đích của việc sử dụng biểu đồ.

- Một số dạng biểu đồ thông thường.

- Các bước cần thiết để tạo một biểu đồ từ bảng dữ liệu.

- Thay đổi dạng biểu đồ đã tạo, xoá, sao chép biểu đồ vào văn bản Word.

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c, Sản phẩm: HS nắm vững kiến thức về trình bày dữ liệu bằng biểu đồ

d, Tổ chức thực hiện:

	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

GV: Theo em tại sao một số loại dữ liệu lại được biểu diễn dưới dạng biểu đồ?

? Trong chương trình phổ thông em đã được học các loại biểu đồ nào? Em có biết tác dụng riêng của mỗi loại biểu đồ ấy không?

GV: Giới thiệu cách tạo biểu đồ trên chương trình bảng tính Excel.

GV: Hướng dẫn HS cách chọn biểu đồ phù hợp với nội dung dữ liệu.

- Hướng dẫn HS cách kiển tra miền dữ liệu.

GV: Giải thích cho HS các thông tin trong biểu đồ khi tạo.

GV: Khi tạo biểu đồ các em cần biết vị trí nơi đặt của biểu đồ.

GV: Hướng dẫn HS các cách chỉnh sửa biểu đồ:

-  Thay đổi vị trí.

-  Thay đổi dạng biểu đồ.

-  Xoá biểu đồ.

- Sao chép biểu đồ vào văn bản Word.

Bước 2: Thực hiện nhiệm vụ:

HS: Suy nghĩ trả lời.

HS: Nhớ lại và trả lời.

HS: Quan sát và ghi chép.

- Chú ý quan sát.

- Quan sát và thực hiện.

HS: Chú ý lắng nghe và ghi chép.

HS: Quan sát và ghi chép nội dung cần thiết.

-  Thưc hành lại các thao tác dưới sự hướng dẫn của GV.
Bước 3: Báo cáo kết quả hoạt động và thảo luận

+ HS trả lời, nhận xét, bổ sung

Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.

	1. Minh hoạ số liệu bằng biểu đồ

-  Mục đích của việc sử dụng biểu đồ:

Biểu diễn dữ liệu trực quan, dễ hiểu, dễ so sánh, dự đoán xu thế tăng-giảm của dữ liệu.

2. Một số dạng biểu đồ

- Biểu đồ cột: So sánh dữ liệu có trong nhiều cột.

-  Biểu đồ đường gấp khúc: So sánh dữ liệu và dự đoán xu thế tăng-giảm của dữ liệu.

-  Biểu đồ hình tròn: Mô tả tỉ lệ của gí trị dữ liệu so với tổng thể.

3. Tạo biểu đồ

- Nháy nút lệnh Chart Wizard. XHHT Chart Wizard. 

- Nháy nút Next trên các hộp thoại và nháy nút Finish để kết thúc.

a) Chọn dạng biểu đồ

-  Chart Types: Chọn nhóm biểu đồ.

-  Chart Sub-types: Chọn dạng biểu đồ trong nhóm.

-  Nháy Next để sang bước 2.

b) Xác định miền dữ liệu 

-  Data Range: Kiểm tra miền dữ liệu và sửa đổi nếu cần.

- Series in: Chọn dãy dữ liệu cần minh hoạ theo hàng hay cột.

-  Nháy Next để chuyển sang bước 3.

c) Các thông tin giải thích biểu đồ

-  Chart title: Tiêu đề.

- Ctegory (X) axis: Chú giải trục ngang.

-  Value (Y) axis: Chú giải trục đứng.

-  Nháy Next để sang bước 4.

d. Vị trí đặt biểu đồ

- As a new sheet: Trên trang tính mới.

-  As object in: Trên trang chứa DL.

-  Nháy Finish để kết thúc.

4. Chỉnh sửa biểu đồ

a) Thay đổi vị trí của biểu đồ

-  Thực hiện thao tác kéo thả chuột.

b) Thay đổi dạng biểu đồ

-  Nháy mũi tên để ở bảng chọn BĐ.

-  Chọn kiểu biểu đồ thích hợp.

c) Xoá biểu đồ

-  Nháy chuột trên biểu đồ và nhấn phím Delete.

d) Sao chép biểu đồ vào văn bản 

- Nháy chọn biểu đồ và nháy nút lệnh Copy.

- Mở văn bản Word và nháy chuột nút lệnh Paste.


C. HOẠT ĐỘNG LUYỆN TẬP (10')

a, Mục tiêu: Luyện tập củng cố nội dung bài học

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Kết quả BT cùa HS
d, Tổ chức thực hiện:
- GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 1: Để xóa biểu đồ đã tạo, ta thực hiện:

A. Nhấn phím Delete

B. Nháy chuột trên biểu đồ và nhấn phím Delete

C. Nháy chuột trên biểu đồ và nhấn phím Insert

D. Tất cả đều sai

Hiển thị đáp án
Để xóa biểu đồ đã tạo, ta thực hiện nháy chuột trên biểu đồ và nhấn phím Delete.

Đáp án: B

Câu 2: Muốn thay đổi kiểu biểu đồ đã được tạo ra, em có thể:

A. Phải xóa biểu đồ cũ và thực hiện lại các thao tác tạo biểu đồ

B. Nháy nút (Change Chart Type) trong nhóm Type trên dải lệnh Design và chọn kiểu thích hợp

C. Nháy nút (Chart Winzard) trên thanh công cụ biểu đồ và chọn kiểu thích hợp

D. Đáp án khác

Hiển thị đáp án
Muốn thay đổi kiểu biểu đồ đã được tạo ra, ta có thể nháy chuột trên biểu đồ để chọn. Sau đó nháy nút (Change Chart Type) trong nhóm Type trên dải lệnh Design và chọn kiểu thích hợp.

Đáp án: C

Câu 3: Khi vẽ biểu đồ, chương trình bảng tính ngầm định miền dữ liệu để tạo biểu đồ là gì?

A. Hàng đầu tiên của bảng số liệu

B. Cột đầu tiên của bảng số liệu

C. Toàn bộ dữ liệu

D. Phải chọn trước miền dữ liệu, không có ngầm định

Hiển thị đáp án
Khi vẽ biểu đồ, chương trình bảng tính ngầm định miền dữ liệu để tạo biểu đồ là tất cả dữ liệu trong khối có ô tính được chọn.

Đáp án: C

Câu 4: Mục đích của việc sử dụng biểu đồ là gì?

A. Minh họa dữ liệu trực quan

B. Dễ so sánh số liệu

C. Dễ dự đoán xu thế tăng hay giảm của các số liệu

D. Tất cả các ý trên

Hiển thị đáp án
Biểu đồ cho phép biểu diễn tóm tắt nhiều dữ liệu chi tiết trên trang tính, giúp hiểu rõ hơn dữ liệu, dễ so sánh dữ liệu, đặc biệt dễ dự đoán xu thế tăng hay giảm của các số liệu trong tương lai.

Đáp án: D

Câu 5: Để mô tả tỉ lệ của giá trị dữ liệu so với tổng thể người ta thường dùng dạng biểu đồ nào?

A. Biểu đồ cột

B. Biểu đồ đường gấp khúc

C. Biểu đồ hình tròn

D. Biểu đồ miền

Hiển thị đáp án
Biểu đồ hình tròn dùng để mô tả tỉ lệ của giá trị dữ liệu so với tổng thể. Ngoài ra còn có một số biểu đồ hình cột, đường gấp khúc và biểu đồ miền.

Đáp án: C

D. HOẠT ĐỘNG VẬN DỤNG (8’)

a, Mục tiêu: Vận dụng làm bài tập 

b, Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c, Sản phẩm: Kết quả BT của HS

d, Tổ chức thực hiện:
- GV chia lớp thành nhiều nhóm:

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

Một ô ngoài vùng dữ liệu trên trang tính đang được em chọn. Em hãy thực hiện các bước tạo biểu đồ để minh họa dữ liệu. Biểu đồ có được tạo không?  

- HS trả lời, nộp vở bài tập

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
* Hướng dẫn về nhà:

- Hướng dẫn HS về ôn bài, đọc trước bài thực hành số 9.

Bài thực hành 9

TẠO BIỂU ĐỒ ĐỂ MINH HOẠ
I -  MỤC TIÊU

1. Kiến thức

- Ôn lại cách nhập các công thức và hàm vào ô tính.

- Thực hiện được các thao tác tạo biểu đồ đơn giản.

2. Năng lực
- Năng lực chung: năng lực chuyên môn, năng lực hợp tác, năng lực giao tiếp, năng lực gợi nhớ, năng lực sử dụng ngôn ngữ.

- Năng lực chuyên biệt: Năng lực CNTT, tư duy.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU
1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

III -  TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a, Mục tiêu: Ôn lại cách nhập các công thức và hàm vào ô tính, thực hiện được các thao tác tạo biểu đồ đơn giản.

b, Nội dung: Giáo viên đặt vấn đề, học sinh lắng nghe trả lời

c, Sản phẩm: Học sinh nắm vững kiến thức bài thực hành

d, Tổ chức thực hiện:

- GV: Bài trước các em đã tìm hiều bài trình bày dữ liệu bằng biểu đồ. Hôm nay để củng cố lại kiến thức chúng ta cùng đến với thực hành 9: Tạo biểu đồ để minh họa

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động: Thực hành bài 1, bài 2, bài 3

a, Mục tiêu: Nắm được các bước thực hành bài 1, bài 2, bài 3
b, Nội dung: Sử dụng SGK, máy tính để thực hành dưới sự hướng dẫn của giáo viên

c, Sản phẩm: Kết quả thực hành bài 1, bài 2, bài 3

d, Tổ chức thực hiện:

	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

GV: Yêu cầu HS mở máy, khởi động chương trình bảng tính Excel, nhập dữ liệu vào trang tính như hình 113.

? Tính cột Tổng cộng ta làm ntn? 

GV: Yêu cầu HS thực hiện tạo biểu đồ với khối dữ liệu A4:D9.

? Để có được dữ liệu như hình 114 ta làm ntn?

GV: Yêu cầu HS xoá cột Nam trong bảng dữ liệu.

- Yêu cầu từng HS tạo biểu đồ với dữ liệukhối A4:A9 với các thông tin giải thích trên biểu đồ.

- Yêu cầu HS tạo mới biểu đồ đường gấp khúc với khối dữ liệu A4:C9.

- Yêu cầu HS đổi biểu đồ  mục d của BT1 thành biểu đồ đường gấp khúc.

- Yêu cầu HS so sánh kết quả nhận được ở mục a.

? Để thay đổi dạng biểu đồ ta làm ntn?

- Yêu cầu HS thay đổi dạg biểu đồ như hình 116.

? Để xoá cột ta làm ntn?

- Yêu cầu HS thực hiện thao tác xoá cột để có trang tính như hình 117.

GV : Yêu cầu HS tạo biểu đồ hình tròn trên cơ sở dữ liệu của khối A4:B9.

- Yêu cầu HS đổi biểu đồ nhận được thành biểu đ đường gấp khúc và biểu đồ cột.

? Để lưu bảng tính ta làm ntn?

GV: Yêu cầu HS mở bảng tính “Bảng điểm lớp em” đã lưu trong bài thực hành 7.

GV: Yêu cầu HS tính điểm trung bình theo từng môn.

- Yêu cầu HS tạo biẻu đồ cột để minh hoạ ĐTB của các môn học.

? Để sao chép biểu đồ trên trang tính vào Word ta làm ntn?

- Yêu cầu HS thực hiện thao tác sao chép sang Word.

Bước 2: Thực hiện nhiệm vụ

HS: Mở máy tính, khởi động Excel và nhập dữ liệu vào trang tính.

=SUM(B5,C5)

HS: Thực hiện thao tác xoá cột.

HS: Tạo mới biểu đồ đường gấp khúc

- Đổi biểu đồ mục d bài tập 1 thành biểu đồ đường gấp khúc.

HS: Quan sát so sánh và nhận xét.

HS: Thực hiện thao tác đổi biểu đồ.

HS: Thực hành theo yêu cầu của GV.

Bước 3: Báo cáo kết quả hoạt động và thảo luận

+ HS trả lời, HS khác nhận xét, bổ sung

Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.
	1. Bài tập 1

a) Nhập dữ liệ

=SUM(B5,C5)

b) Tạo biểu đồ với dữ liệu khối A:D9

c) Thực hiện các thao tác để có trang tính như hình 114

d) Tạo biểu đồ với dữ liệu khối A4:C9

2. Bài tập 2

a) Tạo biểu đồ đường gấp khúc với dữ liệu khối A 4:C9

b) Thay đổi dạng biểu đồ

c) Thay đổi dạng biểu đồ

d) Xoá cột

e) Tạo biểu đồ hình tròn

g) Lưu bảng tính

3. Bài tập 3

a) Tính ĐTB theo từng môn học của cả lớp vào hàng dưới cùng của danh sách dữ liệu

b) Tạo biểu đồ hình cột

c) Sao chép biểu đồ được tạo trên trang tính vào văn bản Word
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- GV: kiểm tra việc làm bài của từng máy, sửa lỗi và nhận xét ý thức thực hành, kết quả của mỗi máy.

- Hướng dẫn HS về ôn bài, đọc trước bài học vẽ hình học động với Geogebra.

Bài thực hành số 10

BÀI THỰC HÀNH TỔNG HỢP

I -  MỤC TIÊU

1. Kiến thức

- Củng cố lại cho HS cách lập trang tính, định dạng, sử dụng công thức, các hàm và trình bày trang in.

- Sử dụng nút lệnh Print Preview để xem trước khi in.

2. Năng lực: 
- Năng lực chung: năng lực chuyên môn, năng lực hợp tác, năng lực giao tiếp, năng lực gợi nhớ, năng lực sử dụng ngôn ngữ.

- Năng lực chuyên biệt: Năng lực CNTT, tư duy.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

III -  TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a, Mục tiêu: Củng cố lại cho HS cách lập trang tính, định dạng, sử dụng công thức, các hàm và trình bày trang in.

b, Nội dung: Giáo viên đặt vấn đề, học sinh lắng nghe trả lời

c, Sản phẩm: Học sinh nắm vững kiến thức bài thực hành

d, Tổ chức thực hiện:

- GV: Bài trước các em đã tìm hiều bài thực hành số 9: Tạo biểu đồ để minh họa. Hôm nay để củng cố lại kiến thức chúng ta cùng đến với thực hành 10: Bài thực hành tổng hợp

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC:

Hoạt động: Thực hành bài 1, bài 2

a, Mục tiêu: Nắm được các bước thực hành bài 1, bài 2
b, Nội dung: Sử dụng SGK, máy tính để thực hành dưới sự hướng dẫn của giáo viên

c, Sản phẩm: Kết quả thực hành bài 1, bài 2

d, Tổ chức thực hiện:
	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

GV: Yêu cầu HS khởi động Excel và nhập dữ liệu vào trang tính như hình 119.

? Để điều chỉnh độ rộng cột, độ cao hàng ta làm ntn?

? Để căn chỉnh tiêu đề ta làm ntn?

? Nêu các thao tác để kẻ khong cho ô tính?

? Nhắc lại các thao tác sao chép và chỉnh sửa dữ liệu trong ô tính.

? Để tạo màu nền cho ô tính ta làm ntn?

? Để tạo màu chữ cho ô tính ta làm ntn?

GV: Yêu cầu HS mở bảng tính Bài tập 1 đã lưu.

? Để tính cột tổng cộng ta làm ntn?

? Tại sao cần xem trang tính trước khi in?

? Để xem trước khi in ta làm ntn? 

- GV: Yêu cầu HS nhập dữ liệu vào trang tính.

? Để tính cột tổng cộng ta làm ntn?

? Để tính thu nhập trung bình theo từng ngành ta làm ntn?

GV: Yêu cầu HS lưu lại bảng tính với tên Baitap2.

- GV: Giám sát việc thực hành của HS, hướng dẫn HS khi cần.

Bước 2: Thực hiện nhiệm vụ

HS: Mở máy, khởi động Excel và nhập dữ liệu.

HS: Thực hiện theo yêu cầu của GV và trả lời câu hỏi.

HS: Thực hiện thao tác lưu lại trang tính theo yêu cầu GV.

Bước 3: Báo cáo kết quả hoạt động và thảo luận

+ HS trình bày kết quả bài tập

Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV nhận xét, đánh giá 

	1. Bài tập 1

a) Khởi động chương trình bảng tính Excel và nhập dữ liệu vào trang tính

b) Điều chỉnh hàng, cột và định dạng

- Điều chỉnh hàng, cột: 

+ Đưa con trỏ vào vạch phân cách giữa hàng hay cột và thực hiện thao tác kéo thả chuột để tăng hay giảm độ rộng cột, độ cao hàng.

- Căn chỉnh tiêu đề

+ Chọn các ô cần căn chỉnh, nháy nút Merge and Center.

- Kẻ khung

+ Chọn các ô cần kẻ khung.

+ Nháy nút Border chọn kiểu vẽ đường biên.

c) Sao chép và chỉnh sửa dữ liệu

-  Sao chép

+ Chọn ô cần sao chép.

+ Nháy nút lệnh Copy.

+ Trỏ tới vị trí mới.

+ Nháy nút lệnh Paste.

- Tạo màu nền và màu chữ

Màu nền

+ Chọn ô hoặc các ô cần tạo màu nền.

+ Nháy nút Fill Colors.

Màu chữ

+ Chọn ô hoặc các ô cần tạo màu chữ.

+ Nháy nút Font Color.

d) Lập công thức để rính tổgn số hiện vật

- Dùng công thức:

=D5+D14

-  Dùng hàm:

=SUM(D5,D14)

2. Bài tập 2

Xem trước trang in

a) Khởi động Excel và nhập dữ liệu vào trang tính

b) Sử dụng các hàm để tính toán

-  Tính trung bình cộng.

-  Tổng thu nhập trung bình của vùng.
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- Giáo viên đến từng máy kiểm tra kết quả thực hành của HS.

- Hướng dẫn HS về nhà ôn tập và đọc trước các phần tiếp theo.
Bài thực hành số 10

BÀI THỰC HÀNH TỔNG HỢP (tiếp)

I -  MỤC TIÊU

1. Kiến thức

- Củng cố lại cho HS cách chỉnh sửa, chén thêm hàng, định dạng văn bản, sắp xếp và lọc dữ liệu.

- Củng cố cách tạo biểu đồ, trình bày trang in, sao chép vùng dữ liệu và di chuyển biểu đồ.

2. Năng lực
- Năng lực chung: năng lực chuyên môn, năng lực hợp tác, năng lực giao tiếp, năng lực gợi nhớ, năng lực sử dụng ngôn ngữ.

- Năng lực chuyên biệt: Năng lực CNTT, tư duy.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh: Nghiên cứu trước bài học ở nhà. 

III -  TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a, Mục tiêu: Củng cố lại cho HS cách chỉnh sửa, chén thêm hàng, định dạng văn bản, sắp xếp và lọc dữ liệu.

Củng cố cách tạo biểu đồ, trình bày trang in, sao chép vùng dữ liệu và di chuyển biểu đồ.

b, Nội dung: Giáo viên đặt vấn đề, học sinh lắng nghe trả lời

c, Sản phẩm: Học sinh nắm vững kiến thức bài thực hành

d, Tổ chức thực hiện:

- GV: Bài trước các em đã tìm hiều bài thực hành số 10: bài thực hành tổng hợp. Hôm nay để củng cố lại kiến thức chúng ta cùng đến với thực hành 10: Bài thực hành tổng hợp (tiếp theo)

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC:

Hoạt động: Thực hành bài 2, bài 3

a, Mục tiêu: Nắm được các bước thực hành bài 2, bài 3
b, Nội dung: Sử dụng SGK, máy tính để thực hành dưới sự hướng dẫn của giáo viên

c, Sản phẩm: Kết quả thực hành bài 2, bài 3

d, Tổ chức thực hiện:

	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

- GV: Yêu cầu HS mở máy tính, khởi động Excel và mở bảng tính Baitap2.

? Để cho tiêu đề của bảng “Thu nhập bình quân theo đầu người” ra giữa ta làm ntn?

? Để chọn màu cho chữ ta làm ntn?

? Nêu thao tác chèn thêm 1 hàng.

GV: Yêu cầu HS trình bày giống mẫu hình 123.

? Để sắp xếp tên xã với thứ tự a, b, c ta làm ntn?

? Để sắp xếp thu nhập bình quân về nông nghiệp với thứ tự giảm dần ta làm ntn?

? Để lọc dữ liệu trong trang tính ta làm ntn?

? Em hãy thực hiện thao tác lọc dữ liệu lấy 3 xã thu nhập bình quân về nông nghiệp cao nhất.

? Để thoát khỏi chế độ lọc ta làm ntn?

- GV : Yêu cầu HS lưu lại trang tính với tên Thongke.

- GV: Yêu cầu HS mở Baitap2 đã lưu trong máy.

? Để sao chép cột B và cột D sang vùng khác ta làm ntn?

? Để vẽ biểu đồ ta sử dụng nút lệnh nào ?

? Em hãy thực hiện thao tác sao chép hàng dữ liệu sang vùng khác.

-GV: yêu cầu HS vẽ biểu đồ như mẫu hình 125.

? Để di chuyển biểu đồ ta làm ntn?

- GV : Yêu cầu HS di chuyển biểu đồ.

? Để xem trước khi in ta làm ntn ?

Bước 2: Thực hiện nhiệm vụ

HS: Mở máy,  khởi động Excel và mở bảng tính Baitap2. 

HS: Nhớ lại kiếm thức lý thuyết và trả lời các câu hỏi của giáo viên.

HS: Thực hành theo yêu cầu của GV.

GV: Giám sát việc thực hành của HS, hướng dẫn các em khi cần thiết.

Bước 3: Báo cáo kết quả hoạt động và thảo luận

+ HS trình bày kết quả

Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.
	c) Chỉnh sửa và chèn thêm hàng

-   Chỉnh sửa

-  Chèn hàng

d) Sắp xếp các xã 

- Theo tên xã với thứ tự a, b, c.

- Sắp xếp giảm dần.

e) Lọc dữ liệu

Data -> Filter -> AutoFilter -> Chọn Top 10. XHHT, chọn Top 3 -> OK.

3. Bài tập 3

Tạo biểu đồ và trình bày trang in.

a) Sao chép cột và vẽ biểu đồ

b) Sao chép hàng và vẽ biểu đồ

c) Di chuyển biểu đồ và trình bày trang in

d) Xem trước khi in
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- GV đến từng máy kiểm tra kết quả thực hành của HS.

- GV hướng dẫn HS về nhà ôn tập chuẩn bị cho bài kiểm tra thực hành.

ÔN TẬP

I -  MỤC TIÊU

1. Kiến thức

- Tổng hợp kiến thức về định dạng trang tính, trình bày và in trang tính.

- Củng cố cách sắp xếp và lọc dữ liệu, cách tạo biểu đồ minh hoạ dữ liệu.

2. Năng lực
- Năng lực chung: năng lực chuyên môn, năng lực hợp tác, năng lực giao tiếp, năng lực gợi nhớ, năng lực sử dụng ngôn ngữ.

- Năng lực chuyên biệt: Năng lực CNTT, tư duy.

3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh. Các kiến thức đã học.

III -  TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a, Mục tiêu: Tổng hợp kiến thức về định dạng trang tính
b, Nội dung: Giáo viên đặt vấn đề, học sinh lắng nghe trả lời

c, Sản phẩm: Học sinh nắm vững kiến thức bài thực hành

d, Tổ chức thực hiện:

GV: Bài trước các em đã tìm hiều bài thực hành 10: bài thực hành tổng hợp. Hôm nay để củng cố lại kiến thức chúng ta cùng đến với bài ôn tập

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động: Định dạng trang tính, trình bày in trang tính, sắp xếp và lọc dữ liệu, trình bày dữ liệu bằng biểu đồ

a, Mục tiêu: Nắm được các bước thực hành về trang tính và trình bày dữ liệu bằng biểu đồ
b, Nội dung: Sử dụng SGK, máy tính để thực hành dưới sự hướng dẫn của giáo viên

c, Sản phẩm: Kết quả thực hành về trang tính và trình bày dữ liệu bằng biểu đồ.

d, Tổ chức thực hiện:

	HOẠT ĐỘNG CỦA GV - HS
	DỰ KIẾN SẢN PHẨM

	Bước 1: Chuyển giao nhiệm vụ

- GV yêu cầu HS trả lời các câu hỏi

? Để thay đổi phông chữ ta làm ntn?

? Để thay đổi cỡ chữ ta làm ntn?

? Để thay đổi kiêu chữ ta làm ntn?

? Nêu cách chọn màu cho phông?

? Cách căn lề trong ô tính?

? Để tăng, giảm số chữ số thập phân ta làm ntn?

? Trình bày cách tô màu nền và ket đường biên trong trang tính.

? Trình bày cách đặt lề hướng giấy in.

? Để in trang tính ta làm ntn?

? Trình bày cách sắp xếp dữ liệu trong trang tính?

? Để lọc dữ liệu trong trang tính ta làm ntn?

? Sau khi lọc để hiển thị lại dữ liệu ta làm ntn?

? Nêu cách thoát khỏi chế đọ lọc?

? Em hãy trình bày cách vẽ biểu đồ biểu diễn dữ liệu trên trang tính ?

- GV: Cho HS thực hành lại tất cả các thao tác đã học. 

Bước 2: Thực hiện nhiệm vụ

- HS tiếp nhận câu hỏi của GV suy nghĩ và thảo luận

- HS thực hành các thao tác đã học theo sự hướng dẫn của GV
Bước 3: Báo cáo kết quả hoạt động và thảo luận

+ HS trả lời, nhận xét, bổ sung

Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.
	1. Định dạng trang tính
a) Thay đổi phông chữ

-  Đánh dấu ô.

-  Nháy mũi tên ở ô Font và chọn phông thích hợp.

b) Thay đổi cỡ chữ

-  Đánh dấu ô.

-  Nháy mũi tên ở ô cỡ chữ và chọn cỡ thích hợp.

c) Thay đổi kiểu chữ

-  Đánh dấu ô.

-   Nháy vào B, I, U

d) Chọn màu phông

-  Đánh dấu ô.

-  Nháy mũi tên ở nút chữ A

e) Căn lề trong ô tính

- Đánh dấu ô.

- Nháy chọn các nút lệnh căn lề.

f) Tăng, giảm số chữ số thập phân

- Nháy chọn ô.

- Sử dụng hai nút lệnh tăng, giảm chữ số thập phân.

g) Tô màu nền và kẻ đường biên

 Tô màu nền

- Nháy chọn ô.

- Sử dụng nút lệnh Fill Color.

Kẻ đường biên

- Chọn ô.

- Sử dụng nút Border.

2. Trình bày và in trang tính

- Đặt lề hướng giấy in

File -> Page Setup. XHHT, lựa chọn hướng giấy và lề giấy -> Ok.

-  In trang tính

File -> Print.

3. Sắp xếp và lọc dữ liệu

a) Sắp xếp dữ liệu

-  Chọn ô trong cột cần sắp xếp.

-  Nháy nút lệnh sắp xếp tăng (hoặc giảm).

b) Lọc dữ liệu

- Chọn ô trong vùng cần lọc.

- Data -> Filter -> AutoFilter

Hiển thị lại dữ liệu

-  Data -> Filter -> Show All

Thoát khỏi chế độ lọc

-  Data -> Filter -> AutoFilter.

4. Trình bày dữ liệu bằng biểu đồ

-  Chọn ô trong vùng dữ liệu

-  Nháy nút Chart Wizard.

-  Nháy Next liên tiếp.

-  Nháy Finish khi Next mờ đi.

5. Luyện tập

(Ôn tập các thao tác đã học)


    * CỦNG CỐ (3’)

- GV nhắc lại tất cả các thao tác đã học và yêu cầu HS về nhà ôn tập thực hành lại
LUYỆN GÕ BÀN PHÍM BẰNG TYPING TEST
I - MỤC TIÊU

1. Kiến thức 

- Học sinh hiểu công dụng và ý nghĩa của phần mềm.

- Tự khởi động, mở được các bài và chơi trò chơi.

- Thao tác thoát khỏi phần mềm.

- Ôn lại những kiến thức đã học từ đầu năm để làm bài kiểm tra 15’.

2. Năng lực

- Năng lực chung: Tự học, giải quyết vấn đề, tư duy, tự quản lý.

- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.
3. Phẩm chất 

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy, phần mềm.

2. Học sinh: Kiến thức, sách giáo khoa.

III. TIẾN TRÌNH BÀI GIẢNG

1. Ổn định tổ chức ( 1’ )

B - KIỂM TRA 15’:


Câu 1: Chương trình bảng tính là gì?


Câu 2: Trong chương trình bảng tính thường sử dụng những kiểu dữ liệu nào? Dữ liệu được căn lề như thế nào trong các ô tính.

3. Bài mới ( 25’)

HOẠT ĐỘNG 1: Khởi động (5’)

a) Mục tiêu:  Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: HS lắng nghe GV
d) Tổ chức thực hiện:

? Có những phần mềm luyện gõ phím nhanh nào em biết?
Tl: Một số phần mềm luyện gõ phím nhanh như Rapid Typing hoặc Typing Test
Giới thiệu các nội dung của bài học: 1. Giới thiệu phần mềm, 2. Khởi động phần mềm, 3. Bài luyện Bubbles (bong bóng), 4. Bài luyện ABC (bảng chữ cái), 5. Bài luyện Clouds (Đám mây), 6. Bài luyện Wordtris (gõ từ nhanh), 7. Kết thúc phần mềm.

HOẠT ĐỘNG 2: Hình thành kiến thức 

a) Mục tiêu: 

- Học sinh hiểu công dụng và ý nghĩa của phần mềm.

- Tự khởi động, mở được các bài và chơi trò chơi.

- Thao tác thoát khỏi phần mềm.

- Ôn lại những kiến thức đã học từ đầu năm để làm bài kiểm tra 15’.

b) Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: HS nêu được công dụng và ý nghĩa của phần mềm, thao tác với phần mềm
d) Tổ chức thực hiện:
	Họat động của GV - HS
	Sản phẩm dự kiến 

	Bước 1: GV chuyển giao nhiệm vụ học tập

GV: Em hãy nhắc lại lợi ích của việc gõ bàn phím bằng 10 ngón?

? Nêu những thuận lợi và khó khăn trong việc học gõ 10 ngón với phần mềm?

GV: Giải đáp và chỉ cho học sinh thấy thế nào là chơi mà học.

GV: Tương tự như các phần mềm khác, em hãy nêu cách khởi động của phần mềm Typing Test.

-  Giới thiệu 2 cách.

GV: Hướng dẫn các thao tác khi vào chơi.

-  Giới thiệu 4 trò chơi: Đám mây, Bong bóng, Gõ từ nhanh và Bảng chữ cái.

? Để bắt đầu chơi một trò chơi em làm như thế nào?

Giới thiệu cách vào trò chơi Bubbles.

GV: Giải thích các từ Tiếng Anh trong trò chơi.

GV: Giới thiệu cách vào trò chơi ABC.

-  Hướng dẫn các thao tác chơi.
Bước 2: HS thực hiện nhiệm vụ học tập

HS: Trả lời, tự do nêu ý kiến của mình.

HS: Trả lời theo ý hiểu.

Bước 3: Báo cáo kết quả hoạt động và thảo luận

+ HS trả lời, nhận xét, bổ sung
HS : Quan sát, Ghi chép.

Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV nhận xét, đánh giá
	1. Giới thiệu phần mềm

- Là phần mềm dùng để luyện gõ 10 ngón thông qua một số trò chơi đơn giản nhưng rất hấp dẫn.

2. Khởi động

C1: Nháy đúp chuột vào biểu tượng của Typing Test trên màn hình nền.

C2: Start -> Prorgam -> Fre Typing Test.

-  Gõ tên vào ô Enter your neme -> Next.

-  Warm up games để vào cửa sổ các trò chơi.

-  Để bắt đầu chơi một trò chơi ta chọn chò trơi đó và nháy chuột vào nút >

3. Trò chơi Bubbles

-  Gõ chính xác các chữ cái có trong bong bóng bọt khí nổi từ dưới lên.

-  Bọt khí chuyển động dần lên trên, gõ đúng thì mới được điểm.

-  Score: Điểm số của em, Missed: số chữ đã bỏ qua (không gõ kịp).

4. Trò chơi ABC

-  Cách vào trò chới tương tự tương tự trò Bubbles.

-  Gõ các kí tự xuất hiện trong vòng cung, bắt đầu từ kí tự có màu sáng.


HOẠT ĐỘNG 3:  Hoạt động luyện tập (10')

a) Mục tiêu: Luyện tập củng cố nội dung bài học

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: Bài làm của HS
d) Tổ chức thực hiện

GV giao nhiệm vụ cho học sinh làm bài tập trắc nghiệm:

Câu 1: Typing Master là phần mềm dùng để:

A. luyện gõ phím nhanh bằng mười ngón.

B. luyện gõ phím nhanh.

C. luyện gõ mười ngón.

D. luyện gõ bàn phím.

Hiển thị đáp án
Typing Master là phần mềm dùng để luyện gõ phím nhanh thông qua các bài học, bài kiểm tra và các trò chơi hấp dẫn.

Đáp án: A

Câu 2: Phần mềm Typing Master, gồm các bài học, bài kiểm tra và

A. các biểu đồ.

B. các hình ảnh.

C. các trò chơi.

D. các bài nhạc.

Hiển thị đáp án
Typing Master là phần mềm dùng để luyện gõ phím nhanh thông qua các bài học, bài kiểm tra và các trò chơi hấp dẫn.

Đáp án: C

Câu 3: Sau khi khởi động phần mềm Typing Master, trong hộp “Enter your name” ta gõ

A. tên trò chơi.

B. tên lớp học.

C. tên Thầy/Cô hướng dẫn.

D. tên của em.

Hiển thị đáp án
Sau khi khởi động phần mềm Typing Master, trong hộp “Enter your name” ta gõ tên của em và sau đó nháy chuột vào nút Enter để vào phần mềm.

Đáp án: D

Câu 4: Để khởi động phần mềm Typing Master, ta thực hiện:

A. nháy đúp chuột lên biểu tượng Typing Master.

B. nháy chuột phải lên biểu tượng Typing Master.

C. nháy chuột lên biểu tượng Typing Master.

D. nháy đúp chuột phải lên biểu tượng Typing Master.

Hiển thị đáp án
Để khởi động phần mềm Typing Master, ta thực hiện nháy đúp chuột lên biểu tượng Typing Master hoặc nháy đúp chuột phải lên biểu tượng Typing Master và chọn Open.

Đáp án: A

Câu 5: Trong màn hình Typing Master, để chọn các bài học luyện gõ phím

A. ta nháy chuột chọn Typing test.

B. ta nháy chuột chọn Studying.

C. ta nháy chuột chọn Games.

D. ta nháy chuột chọn Settings.

Hiển thị đáp án
Trong màn hình Typing Master, để chọn các bài học luyện gõ phím ta nháy chuột chọn Studying.

Đáp án: B
HOẠT ĐỘNG 4: Hoạt động vận dụng (8’)

a) Mục tiêu: Vận dụng làm bài tập 

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: Bài làm của HS
d) Tổ chức thực hiện
GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

            - Nhắc lại các thao tác, cách vào và cách chơi hai trò chơi.

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
* Hướng dẫn về nhà:


Xem lại bài cũ
LUYỆN GÕ BÀN PHÍM BẰNG TYPING TEST (Tiếp)
I - MỤC TIÊU
 1. Kiến thức 

-  Biết cách khởi động chương trình Typing Test.

-  Biết được ý nghĩa, công dụng của các trò chơi Clouds và Wordtris.

2. Năng lực

- Năng lực chung: Tự học, giải quyết vấn đề, tư duy, tự quản lý.

- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.
3. Phẩm chất: 

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy, phần mềm.

2. Học sinh: Kiến thức.

III. TIẾN TRÌNH BÀI GIẢNG

1. Ổn định tổ chức ( 1’ )

2. Kiểm tra bài cũ (5’)

? Cách khởi động Free Typing Test.

? Cách lựa chọn trò chơi ABC.

TL: - Cách khỏi động: Nháy đúp chuột vào biẻu tượng có trên màn hình hoặc vào từ Start ( Program( Typing Test.

- Cách lựa chọn: Gõ tên người dùng ( CHọn Warm up games ( Chọn trò chơi thích hợp.

3. Bài mới ( 35’ )

HOẠT ĐỘNG 1: Khởi động (5’)

a) Mục tiêu:  Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: HS quan sát lắng nghe
d) Tổ chức thực hiện:
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Giới thiệu trò chơi Clouds.
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Và Trò chơi Wordtris (gõ từ nhanh)

HOẠT ĐỘNG 2: Hình thành kiến thức 

Mục tiêu: 

-  Biết cách khởi động chương trình Typing Test.

-  Biết được ý nghĩa, công dụng của các trò chơi Clouds và Wordtris.

b) Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: HS khởi động được chương trình Typing Test, nêu ý nghĩa công dụng của các trò chơi Clouds và Wordtris.

d) Tổ chức thực hiện
	Họat động của GV - HS
	Sản phẩm dự kiến

	Bước 1: GV chuyển giao nhiệm vụ học tập

GV : Giới thiệu trò chơi Clouds.

-  Hướng dẫn hoạt động của trò chơi và các thao tác chơi.

? Theo em muốn quay lại đám mây đã qua ta sử dụng phím nào?

GV: Giới thiệu các chữ TA có trong trò chơi.

GV: Giới thiệu cách vào trò chơi.

-  Chỉ dẫn cách chơi.
Bước 2: HS thực hiện nhiệm vụ học tập

HS: Quan sát và ghi chép. 
HS : Trả lời.

Bước 3: Báo cáo kết quả hoạt động và thảo luận

+ HS: Tiến hành thực hiện các chò trơi

Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV quan sát hỗ trợ thêm cho HS
	1. Trò chơi Clouds (đám mây)

-  Trên màn hình xuất hiện các đám mây, chúng chuyển động từ phải sang trái. Có 1 đám mây đóng khung, đó là vị trí làm việc hiện thời.

-  Khi có chữ xuất hiện tại vị trí đám mây đóng khung, ta gõ chữ, nếu gõ chữ đúng thì đám mây biến mất và ta được điểm.

-  Khi gõ sai chữ trong đám mây, muốn quai lại đám mây ta dùng phím Backspace.

-  Score: Điểm của trò chơi, Missed: Số từ bị bỏ qua.

2. Trò chơi Wordtris (gõ từ nhanh)

-  Gõ đúng từ xuất hiện trên thanh gỗ, gõ xong ấn phím Space.

-  Nếu gõ đúng thanh gỗ biết mất, nếu gõ sai hoặc chậm thanh gỗ rơi xuống.


HOẠT ĐỘNG 3:  Hoạt động luyện tập (10')

a) Mục tiêu: Luyện tập củng cố nội dung bài học

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: Bài làm của HS

d) Tổ chức thực hiện:
Câu 6: Trong màn hình Typing Master, để chọn trò chơi luyện gõ phím

A. ta nháy chuột chọn Typing test.

B. ta nháy chuột chọn Studying.

C. ta nháy chuột chọn Settings

D. ta nháy chuột chọn Games.

Hiển thị đáp án
Trong màn hình Typing Master, để chọn trò chơi luyện gõ phím ta nháy chuột chọn Games.

Đáp án: D

Câu 7: Trong phần mềm Typing Master, sau khi nháy chọn Games thì có

A. 4 trò chơi.

B. 3 trò chơi.

C. 5 trò chơi.

D. 6 trò chơi.

Hiển thị đáp án
Trong phần mềm Typing Master, sau khi nháy chọn Games thì có 4 trò chơi là trò chơi  bong bóng (Bubbles) , đám mây (Clouds), bảng chữ cái (ABC), gõ từ nhanh (Wordtris).
Đáp án: A

Câu 8: Trong phần mềm Typing Master, trò chơi bong bóng là:

A. Clouds.

B. Bubbles.

C. ABC.

D. Wordtris.

Hiển thị đáp án
Trong phần mềm Typing Master, sau khi nháy chọn Games thì có 4 trò chơi là trò chơi bong bóng (Bubbles) , đám mây (Clouds), bảng chữ cái (ABC), gõ từ nhanh (Wordtris).

Đáp án: B

Câu 9: Trong phần mềm Typing Master, trờ chơi gõ từ nhanh là:

A. Bubbles.

B. Clouds.

C. ABC

D. Wordtris.

Hiển thị đáp án
Trong phần mềm Typing Master, trong phần Games thì có 4 trò chơi là trò chơi bong bóng (Bubbles) , đám mây (Clouds), bảng chữ cái (ABC), gõ từ nhanh (Wordtris).

Đáp án: D
HOẠT ĐỘNG 4: Hoạt động vận dụng (8’)

a) Mục tiêu: Vận dụng làm bài tập 

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: Bài làm của HS

d) Tổ chức thực hiện:
GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  - Nhắc lại các thao tác, cách vào và cách chơi hai trò chơi.

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
* Hướng dẫn về nhà:

- Nhắc lại các thao tác, cách vào và cách chơi hai trò chơi.

LUYỆN GÕ BÀN PHÍM BẰNG TYPING TEST (tt)
I - MỤC TIÊU

   1. Kiến thức 

-  Biết cách khởi động và ra khỏi phần mềm Free Typing Test.

-  Biết được ý nghĩa, công dụng của các trò chơi trong Fre Typing Test.

2. Năng lực

- Năng lực chung: Tự học, giải quyết vấn đề, tư duy, tự quản lý.

- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.
3. Phẩm chất: 

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II. THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, phòng máy, phần mềm.

2. Học sinh: Kiến thức.

III- TIẾN TRÌNH BÀI GIẢNG

1. Ổn định tổ chức (1’)

2. Kiểm tra bài cũ (3’)

? Các cách khởi động và thoát khỏi Free Typing Test.

TL: Khởi động: Nháy đúp chuột vào biểu tượng trên màn hình.

- Thoát: ( nội dung như Sgk.)

3. Bài mới (37’)

HOẠT ĐỘNG 1: Khởi động (5’)

a) Mục tiêu: Định hướng cho học sinh nội dung cần hướng tới của bài học, tạo tâm thế cho học sinh đi vào tìm hiểu bài mới.

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: HS quan sát, lắng nghe
d) Tổ chức thực hiện:
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Giới thiệu trò chơi Bubbles
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Và bài luyện ABC

HOẠT ĐỘNG 2: Hình thành kiến thức 

a) Mục tiêu: 

-  Biết cách khởi động và ra khỏi phần mềm Fre Typing Test.

-  Biết được ý nghĩa, công dụng của các trò chơi trong Fre Typing Test.

b) Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan
c) Sản phẩm: Nêu ý nghĩa, công dụng của các trò chơi trong Fre Typing Test.
d) Tổ chức thực hiện:
	HỌAT ĐỘNG CỦA GV - HS
	SẢN PHẨM DỰ KIẾN

	Bước 1: GV chuyển giao nhiệm vụ học tập

GV: Yêu cầu học sinh bật máy tính sau đó khởi động phần mềm Free Typing Test bằng 2 chách.

-  Khi xuất hiện màn hình đăng nhập hướng dẫn học sinh nhập tên của mình vào và các thao tác tiếp theo.

-  GV: Gọi học sinh nhắc lại cách chơi trò chơi.

GV: Lưu ý cho học sinh.

GV: yêu cầu học sinh vào trò chơi và nhắc lại cách chơi.

GV: Hướng dẫn một số thao tác cần thiết khi cho các em chơi.

GV: Hướng dẫn học sinh cách chọn kiểu hiện dãy ký tự trong mục With Keys.

GV: Cho hs thực hành. Bước 2: HS thực hiện nhiệm vụ học tập

HS: Thực hiện theo yêu cầu của giáo viên.
HS: Nhập tên đăng nhập.
Bước 3: Báo cáo kết quả hoạt động và thảo luận

HS : Trả lời.
- Ghi chép.
HS : Thực hiện thao tác và trả lời.
Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV đánh giá, nhận xét.
	1. Trò chơi Bubbles

-  Nhập tên của mình vào ô I am a new user (tên không có dấu).

-  Nháy Next, chọn Warm up Games chọn trò chơi Bubbles.

* Chú ý: 
Cố gắng gõ hết những bong bóng có màu sắc chuyển động nhanh. Nếu bỏ qua 6 bong bóng thì trò chơi kết thúc và xem kết quả.

2. Trò chơi bảng chữ cái ABC

-  Gõ các kí tự xuất hiện trong vòng cung, bắt đầu từ kí tự có màu sáng.

*  Chú ý: Phân biệt chữ hoa và chữ thường.

-  Chơi sau 5 phút trò chơi kết thúc và xem diểm tại mục Score.


HOẠT ĐỘNG 3:  Hoạt động luyện tập (10')

a) Mục tiêu: Luyện tập củng cố nội dung bài học

b) Nội dung:  Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: Bài luyện tập của HS
d) Tổ chức thực hiện
HS luyện tập trên lớp
HOẠT ĐỘNG 4: Hoạt động vận dụng (8’)

a) Mục tiêu: Vận dụng làm bài tập 

b) Nội dung: Dạy học nhóm; dạy học nêu và giải quyết vấn đề; phương pháp thuyết trình; sử dụng đồ dung trực quan

c) Sản phẩm: Bài làm của HS
d) Tổ chức thực hiện:
GV chia lớp thành nhiều nhóm 

( mỗi nhóm gồm các HS trong 1 bàn) và giao các nhiệm vụ: thảo luận trả lời các câu hỏi sau và ghi chép lại câu trả lời vào vở bài tập 

  - Nhắc lại cách chơi 2 trò chơi.

- HS trả lời.

- HS nộp vở bài tập.

- HS tự ghi nhớ nội dung trả lời đã hoàn thiện.
4. Hướng dẫn về nhà:

- Chuẩn bị bài sau

KIỂM TRA THỰC HÀNH

I -  MỤC TIÊU

1. Kiến thức

- Kiểm tra việc nắm bắt kiến thức thực hành của học sinh về trình bày, định dạng, sử dụng công thức tính toán, vẽ biểu dồ, sắp xếp và lọc dữ liệu.

2. Năng lực
- Năng lực chung: Tự học, giải quyết vấn đề, tư duy, tự quản lý.

- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.
3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Đề bài kiểm tra, Phòng máy.

2. Học sinh: Kiến thức đã học. 

III - TIẾN TRÌNH BÀI DẠY

Cho bảng tính

	Stt
	A
	B
	C
	D
	E
	F

	1
	Lớp
	Gỏi
	Khá
	T.bình
	Yếu
	Kém

	2
	6A
	5
	15
	9
	0
	?

	3
	6B
	4
	11
	5
	0
	?

	4
	6C
	6
	16
	5
	0
	?

	5
	6D
	9
	20
	4
	0
	?

	6
	6E
	5
	16
	8
	0
	?

	7
	7A
	4
	19
	8
	3
	?

	8
	7B
	2
	18
	10
	5
	?

	9
	7C
	1
	14
	15
	1
	?

	10
	7D
	10
	20
	4
	0
	?

	11
	7E
	15
	21
	6
	0
	?


Yêu cầu:

1. Khởi động Excel, nhập dữ liệu và trình bày theo mẫu trên.

2. Sử dụng hàm để tính cột Tổng cộng.

3. Tạo biểu đồ cột trên cơ sở dữ liệu của khối A2:E12.

4. Lọc ra lớp có số học sinh giỏi nhiều nhất.

Đáp án + Biểu điểm

	Câu
	Đáp án
	Biểu điểm

	1
	Khởi động Excel, nhập dữ liệu và trình bày theo mẫu 
	2

	2
	Trong cột F nhập công thức
	5

	
	=SUM(B2:E2)
	0.5

	
	=SUM(B3:E3)
	0.5

	
	=SUM(B4:E4)
	0.5

	
	=SUM(B5:E5)
	0.5

	
	=SUM(B6:E6)
	0.5

	
	=SUM(B7:E7)
	0.5

	
	=SUM(B8:E8)
	0.5

	
	=SUM(B9:E9)
	0.5

	
	=SUM(B10:E10)
	0.5

	
	=SUM(B11:E11)
	0.5

	3
	Tạo biểu đồ đúng (Có giải thích trục đứng, trục ngang)
	1

	4
	- Lọc được lớp có số học sinh giỏi nhiều nhất
	1

	
	- Trình bày đẹp, chính xác, nhanh
	1


ÔN TẬP

I -  MỤC TIÊU

1. Kiến thức

- Tổng hợp kiến thức về định dạng trang tính, trình bày và in trang tính.

- Củng cố cách sắp xếp và lọc dữ liệu, cách tạo biểu đồ minh hoạ dữ liệu.

2. Năng lực:
- Năng lực chung: Tự học, giải quyết vấn đề, tư duy, tự quản lý.

- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.
3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU

1. Giáo viên: Giáo trình, Phòng máy.

2. Học sinh. Các kiến thức đã học.

III - TIẾN TRÌNH BÀI DẠY

A. HOẠT ĐỘNG KHỞI ĐỘNG

a, Mục tiêu: Tổng hợp kiến thức về định dạng trang tính
b, Nội dung: Giáo viên đặt vấn đề, học sinh lắng nghe trả lời

c, Sản phẩm: Học sinh nắm vững kiến thức bài thực hành

d, Tổ chức thực hiện:

- GV: Bài trước các em đã tìm hiều bài thực hành 10: bài thực hành tổng hợp. Hôm nay để củng cố lại kiến thức chúng ta cùng đến với bài ôn tập

B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

Hoạt động: Định dạng trang tính, trình bày in trang tính, sắp xếp và lọc dữ liệu, trình bày dữ liệu bằng biểu đồ

a, Mục tiêu: Nắm được các bước thực hành về trang tính và trình bày dữ liệu bằng biểu đồ
b, Nội dung: Sử dụng SGK, máy tính để thực hành dưới sự hướng dẫn của giáo viên

c, Sản phẩm: Kết quả thực hành về trang tính và trình bày dữ liệu bằng biểu đồ.

d, Tổ chức thực hiện:
	HOẠT ĐỘNG CỦA GV - HS
	Dự kiến sản phẩm

	Bước 1: Chuyển giao nhiệm vụ

- GV yêu cầu HS thảo luận trả lời các câu hỏi

? Để thay đổi phông chữ ta làm ntn?

? Để thay đổi cỡ chữ ta làm ntn?

? Để thay đổi kiêu chữ ta làm ntn?

? Nêu cách chọn màu cho phông?

? Cách căn lề trong ô tính?

? Để tăng, giảm số chữ số thập phân ta làm ntn?

? Trình bày cách tô màu nền và ket đường biên trong trang tính.

? Trình bày cách đặt lề hướng giấy in.

? Để in trang tính ta làm ntn?

? Trình bày cách sắp xếp dữ liệu trong trang tính?

? Để lọc dữ liệu trong trang tính ta làm ntn?

? Sau khi lọc để hiển thị lại dữ liệu ta làm ntn?

? Nêu cách thoát khỏi chế đọ lọc?

? Em hãy trình bày cách vẽ biểu đồ biểu diễn dữ liệu trên trang tính ?

- GV : Hướng dẫn HS thực hành lại tất cả các thao tác đã học. 

Bước 2: Thực hành nhiệm vụ

- HS tiếp nhận câu hỏi của GV suy nghĩ và thảo luận

- HS thực hành các thao tác đã học theo sự hướng dẫn của GV
Bước 3: Báo cáo kết quả hoạt động và thảo luận

+ HS trả lời, trình bày kết quả, HS khác nhận xét, bổ sung

Bước 4: Đánh giá kết quả thực hiện nhiệm vụ học tập

+ GV nhận xét, đánh giá -> Chốt kiến thức lên bảng.
	1. Định dạng trang tính

a) Thay đổi phông chữ

-  Đánh dấu ô.

-  Nháy mũi tên ở ô Font và chọn phông thích hợp.

b) Thay đổi cỡ chữ

-  Đánh dấu ô.

-  Nháy mũi tên ở ô cỡ chữ và chọn cỡ thích hợp.

c) Thay đổi kiểu chữ

-  Đánh dấu ô.

-   Nháy vào B, I, U

d) Chọn màu phông

-  Đánh dấu ô.

-  Nháy mũi tên ở nút chữ A

e) Căn lề trong ô tính

- Đánh dấu ô.

- Nháy chọn các nút lệnh căn lề.

f) Tăng, giảm số chữ số thập phân

- Nháy chọn ô.

- Sử dụng hai nút lệnh tăng, giảm chữ số thập phân.

g) Tô màu nền và kẻ đường biên

 Tô màu nền

- Nháy chọn ô.

- Sử dụng nút lệnh Fill Color.

Kẻ đường biên

- Chọn ô.

- Sử dụng nút Border.

2. Trình bày và in trang tính

- Đặt lề hướng giấy in

File -> Page Setup. XHHT, lựa chọn hướng giấy và lề giấy -> Ok.

-  In trang tính

File -> Print.

3. Sắp xếp và lọc dữ liệu

a) Sắp xếp dữ liệu

-  Chọn ô trong cột cần sắp xếp.

-  Nháy nút lệnh sắp xếp tăng (hoặc giảm).

b) Lọc dữ liệu

- Chọn ô trong vùng cần lọc.

- Data -> Filter -> AutoFilter

Hiển thị lại dữ liệu

-  Data -> Filter -> Show All

Thoát khỏi chế độ lọc

-  Data -> Filter -> AutoFilter.

4. Trình bày dữ liệu bằng biểu đồ

-  Chọn ô trong vùng dữ liệu

-  Nháy nút Chart Wizard.

-  Nháy Next liên tiếp.

-  Nháy Finish khi Next mờ đi.

5. Luyện tập

(Ôn tập các thao tác đã học)


    * CỦNG CỐ (3’)

- GV nhắc lại tất cả các thao tác đã học và yêu cầu HS về nhà ôn tập thực hành lại
KIỂM TRA HỌC KỲ II - PHẦN THỰC HÀNH

I -  MỤC TIÊU

1. Kiến thức

  - Kiến thức thực hành của HS về định dạng trang tính, trình bày trang in, sắp xếp và lọc dữ liệu, vẽ biểu đồ.

2. Năng lực
- Năng lực chung: Tự học, giải quyết vấn đề, tư duy, tự quản lý.

- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.
3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU
1. Giáo viên: Đề bài, Phòng máy.

2. Học sinh. Các kiến thức đã học.

III -  TIẾN TRÌNH BÀI DẠY

Đề bài

Cho bảng điểm học sinh:

BẢNG ĐIỂM LỚP 7A

	STT
	Họ và tên
	Toán
	Ngữ Văn
	Tin Học
	Vật Lí
	ĐTB

	1
	Nguyễn Hoà An
	8
	7
	8
	7
	?

	2
	Lê Thái Anh
	8
	5
	7
	8
	?

	3
	Trần Quốc Bình
	8
	9
	9
	8
	?

	4
	Phạm Ngọc Mai
	9
	9
	10
	8
	?

	5
	Bùi Thu Hà
	7
	6
	8
	5
	?

	6
	Chu Thị Hương
	8
	8
	6
	8
	?

	7
	Bùi Mỹ Linh
	8
	9
	8
	7
	?

	8
	Vũ Thị Mai
	7
	5
	5
	7
	?

	9
	Lê Văn Quang
	3
	4
	6
	5
	?

	10
	Trần Thu Phương
	5
	6
	7
	7
	?

	11
	Hà Thanh Thư
	8
	7
	6
	8
	?

	12
	Phạm Hải Yến
	10
	8
	10
	9
	?


e) Khởi động chương trình bảng tính Excel và  Vietkey rồi nhập đúng nội dung bảng trên.            (1 điểm)

f) Tính các ô trong cột ĐTB bằng điểm trung bình của các môn học.     (2 điểm)

g) Sắp xếp lại cột ĐTB theo thứ tự điểm tăng  dần.    (1 điểm)

h) Dùng hàm Max tìm ra học sinh có ĐTB cao nhất.     (2 điểm)

i) Lọc ra học sinh có ĐTB là 8.0.                         (2 điểm)

j) Nhập lại bảng hệ thống dưới và vẽ đồ thị thích hợp để mô tả tỉ lệ lực học của từng loại học sinh so với tổng thể.                                (2 điểm)

	LỰC HỌC
	TỔNG CỘNG

	Giỏi
	4

	Khá
	5

	Trung bình
	2

	Yếu
	1


Đáp án + Biểu điểm

	Câu
	Đáp án
	Biểu điểm

	a
	Khởi động Excel và Vietkey, nhập đúng dữ liệu
	2

	b
	Tính các ô trong cột ĐTB
	

	
	G2 = AVERAGE(C2:F2)
	0.25

	
	G3 = AVERAGE(C3:F3)
	0.25

	
	G4 = AVERAGE(C4:F4)
	0.25

	
	G5 = AVERAGE(C5:F5)
	0.25

	
	G6 = AVERAGE(C6:F6)
	0.25

	
	G7 = AVERAGE(C7:F7)
	0.25

	
	G8 = AVERAGE(C8:F8)
	0.25

	
	G9 = AVERAGE(C9:F9)
	0.25

	
	G10 = AVERAGE(C10:F10)
	0.25

	
	G11 = AVERAGE(C11:F11)
	0.25

	
	G12 = AVERAGE(C12:F12)
	0.25

	
	G13 = AVERAGE(C13:F13)
	0.25

	c
	Nháy 1 ô trong cột ĐTB và nháy nút sắp xếp tăng dần
	1

	d
	=MAX(G2:G13)
	1

	e
	Chọn ô, Data -> Filter -> AutoFilter. Chọn 8.0
	1

	f
	Vẽ đúng biểu đồ thích hợp
	1


KIỂM TRA HỌC KỲ II - PHẦN LÝ THUYẾT

I -  MỤC TIÊU

1. Kiến thức

 - Kiểm ta việc nắm bắt kiến thức lý thuyết của HS về tất cả các phần đã học của học kỳ II.

2. Năng lực
- Năng lực chung: Tự học, giải quyết vấn đề, tư duy, tự quản lý.

- Năng lực chuyên biệt:
+ Năng lực nhận biết, thao tác với phần mềm, thiết bị CNTT.

+Năng lực về đạo đức hành vi phù hợp khi sử dụng CNTT.
3. Phẩm chất

- Giúp học sinh rèn luyện bản thân phát triển các phẩm chất tốt đẹp: yêu nước, nhân ái, chăm chỉ, trung thực, trách nhiệm.
II -  THIẾT BỊ DẠY HỌC VÀ HỌC LIỆU
1. Giáo viên: Đề bài.

2. Học sinh. Các kiến thức đã học.

III - TIẾN TRÌNH BÀI DẠY

ĐỀ BÀI
Đính kèm theo tệp

ĐỀ KIỂM TRA HỌC KÌ II- NĂM HỌC

Môn: Tin học 7

Thời gian: 45 phút  (không kể thời gian phát đề)

Đề 1:

1. Nêu trình tự các bước thực hiện sắp xếp dữ liệu? Cho 5 ví dụ. (2,5đ)

2. Nêu cú pháp hàm tính tổng, hàm xác định GTLN: áp dụng làm bài tập (2,5đ) 

	1
	A
	B
	C
	D
	E

	2
	Họ và Tên
	Lý 
	Hóa 
	Văn
	Tổng

	3
	Nguyễn A
	6
	7
	8
	

	4
	Nguyễn B
	7
	5
	8
	

	5
	Nguyễn C
	5
	9
	6
	


- Tính tổng cột  E3

- Xác định GTLN  E4

3. Nêu các bước thực hiện trò chơi bong bóng, và trò chơi  đám mây. (2,5 đ)

4. Nêu cú pháp tính các biểu thức đơn giản, và rút gọn  các đa thức: áp dụng làm bài tập. (2,5 đ)

- Tính các biểu thức sau: 

 (13, 6  + 3, 1 +  4, 9  +  5, 6) : 7/5

  (2: 3,  4) - (5: 3, 2). (5, 3 + 3, 2)

 - Rút gọn  các đa thức 

 (15. x^7. y^4). (3. x^3. 15. y^5)

 (4. z^5. 3. d^2). (5. z^2. 5. d^3)

Đề 2:

1. Minh họa số liệu bằng biểu đồ là gì và kể tên các dạng biểu đồ thường gặp? Cho 5 ví dụ? (2,5đ)

2. Nêu cú pháp hàm tính TBC, hàm xác định GTNN: áp dụng làm bài tập (2,5 đ)

	1
	A
	B
	C
	D
	E

	2
	Họ và Tên
	Lý 
	Hóa 
	Văn
	TBC

	3
	Nguyễn A
	6
	7
	8
	

	4
	Nguyễn B
	7
	5
	8
	

	5
	Nguyễn C
	5
	9
	6
	


- Tính TBC cột  E3

- Xác định GTNN  E4

3. Nêu các bước thực hiện trò chơi Bảng chữ cái ABC, và trò chơi gõ từ nhanh. (2,5 đ)

4. Nêu cú pháp vẽ đồ thị, và giải phương trình đại số: áp dụng làm bài tập (2,5đ)

-  Vẽ các đồ thị sau:           y = 4x + 1;
     y = 3 – 5x;
y = 7x  -  3
-  Giải phương trình đại số các đa thức sau:

            (2/3). y - 4   ;    (12/4). z + 4   ;   5. x + 1

Đáp án:

Đề 1:

Câu 2: sum  E3 = 21

Max E4 = 8

Câu 4: 

Tính các biểu thức: simplify (13.6 + 3.1 + 4.9 +5.6)/7/5

                                Simplify (2/3.4) – 5/3.2)*(5.3 + 3.2)

Rút gọn: expand (15 * x^7*y^4) * (3 * x^3 * 15* y^5)

Expand  (4.* z^5 * 3 * d^2) * (5 * z^2 * 5 * d^3)

Đề 2:

Câu 2: E3 = 7

E4 = 5

Câu 4

Plot y = 4*x+1    

plot y = 3 -5*x    

plot y = 7*x-3

solve   (2/3) * y - 4    = 0 y

solve   (12/4) * z + 4  = 0 z   

solve  5 * x + 1 = 0 x
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